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Introduction
What is Sage Accpac Intelligence?
Organizations are increasingly suffering from information frustration,
having to manage large volumes of data, and needing to report from
several databases, using inflexible reporting tools. Information delivery
and user empowerment is increasingly taking centre stage in all
enterprises with a resultant growth in the end user query and reporting
(EUQR) category of the business intelligence market. Sage Accpac
Intelligence is an innovative software reporting solution that offers users
in organizations of all sizes a powerful and intuitive reporting tool to take
control of their own reports. It introduces a revolutionary approach to
leveraging the reporting power of Microsoft Excel and protects and
extends organizations existing IT skills and investment.
What are the benefits of using Sage Accpac Intelligence?
Work with a standard windows look and feel
Reduces the need for IT department intervention
Reduces the need for expensive consultants and specialist software
training
Consistent format (MS Excel) for reporting across multiple data sources
Business intelligence can become a standard desktop tool
Avoids inefficiencies in the report development life cycle thereby
improving productivity
Empowers the user thereby improving overall productivity
Optimizes your return on investment by leveraging your existing IT
infrastructure
Extends MS Excel skills rather than requiring learning of a new set of
software skills
Sage Accpac Intelligence is a cost effective, high value reporting tool that
allows people to spend more time doing things that directly translate into

business value. It offers flexible access to business intelligence and
empowers the user to create and customise operational and analytical
reports on a real time basis. Sage Accpac Intelligence allows an
organization to track information more effectively and delivers a rapid
return on investment at a moderate total cost of ownership.
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System Requirements
Recommended System Requirements
Operating System : Windows XP SP3, Windows Vista, Windows 7,
Windows Server 2003, Windows Server 2008, Windows Terminal
Server
Microsoft .Net Framework 3.5 SP1
Microsoft Excel 2003 and higher. Note : to run Report Designer reports,
you need to have Excel 2007 or higher.
Hardware: CPU > 1.3 GHz
Memory: 1GB RAM
Hard Drive Space: 350MB

Database Connectivity Supported
Sage Accpac Intelligence uses ODBC and OLEDB technology to gain
access to Open Database Systems. Sage Accpac Intelligence includes
direct support for most popular database systems and Connection Types
for these are included within the Connector. For systems where a
Connection Type does not exist but where the system has an ODBC
driver these can be accessed via the System DSN connection types
within the Connector.
Some of the more common Database types supported are:
Microsoft SQL Server
Pervasive
Oracle
Sybase
Microsoft Access
Microsoft Visual Foxpro
Dbase
MySQL
Sage50
Paradox
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How it Works
Sage Accpac Intelligence uses an ODBC connection to access data and
offers the system administrator and user, separate interfaces to manage
the report creation process. Sage Accpac Intelligence is then integrated
with Microsoft Excel which is used as a powerful and familiar desktop
reporting platform.
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End User License Agreement
SAGE END USER LICENSE AGREEMENT
IMPORTANT - SCROLL THROUGH AND READ ALL OF THE
FOLLOWING TERMS AND CONDITIONS
1. Grant of License.
Sage hereby grants to You a limited, perpetual, non-exclusive, nontransferable (except as set forth in Section 4(b) below) license to
Use the Software on the terms and conditions set forth in this End
User License Agreement (“Agreement”).
2. Introduction.
(a) Sage (“Sage” and other capitalized terms are defined below) is
willing to grant to You a license of the scope described herein to Use
the Software (comprised of the Program and the Documentation)
only upon the conditions that You or someone acting on Your behalf
and at Your direction, such as Your Distributor has:
(1) placed an order with Sage for either an initial license or an
upgrade (such as for more users, additional modules, etc.), or a
service plan for future maintenance releases (“Maintenance
Software”) and/or for customer support, and Sage has accepted
such order and Enabled Use of the Software; and
(2) accepted all of the terms and conditions of this Agreement
either before or during installation of the Program.
(b) You will indicate your acceptance of this agreement and all of its
terms and conditions by doing one or more of the following or
allowing or authorizing a third party to do it for you:
(1) clicking “i agree“ or a similar affirmation, as applicable, that
appears during installation of the program, or
(2) using the program.
(c) If you do not agree to be legally bound by this agreement (in its

entirety and without change to or addition to its terms and
conditions), then you do not have a license to use the software.
3. Definitions.
As used herein, the following terms have the following meanings:
(a) “Affiliate” means any entity that controls You, that You control or
that is under common control with You where “control” means the
ownership, directly or indirectly, of equity securities or other
ownership interests which represent more than 50% of the voting
power of such affiliate.
(b) “Distributor” means the reseller that You have chosen to be Your
reseller of record.
(c) “Documentation” means the Program specifications that are set
forth in the help files of the Program and any release-related notes,
guides or manuals Sage publishes specific to the current version of
the Program.
(d) “Enabled Use” means Sage’s having fulfilled the applicable
software delivery process (whether by shipping tangible goods
including recorded media containing the Software, enabling
downloading of the Software, delivering activation codes for the
Software, or otherwise), thereby enabling Use of the Software.
(e) “Maintenance Software” means Software that Sage delivers
because You have purchased a subscription to a service plan;
(f) “Program” means the computer program, a part of which includes
the install routine that when executed causes this Agreement to be
displayed.
(g) “Sage” means the Sage company that publishes the Software.
(h) “Software” means collectively, the Program and the

Documentation, and any part thereof.
(i) ”Supplemental License Terms” means the additional terms and
restrictions that are specific to the Program licensed by You under
this Agreement and posted by Sage at www.sagesoftware.com/ eula.
(j) “Use” means to install and execute the Program, provided that:
(1) You install the Program only on a computer system that You
own or only on a computer system not owned by You if You will
be the only party with access to the installed Program; and
(2) You execute the Program (i) for its intended purpose solely
in connection with the management of the business that You
and Your Affiliates conduct, and (ii) solely to the extent of any
and all applicable limitations (whether as to specific modules or
other parts of the Program, or number of production or backup
server computers) set forth in this Agreement and the
Supplemental License Terms; and
(3) You may make only a reasonable number of backup copies
of the Program solely for the purpose of reinstalling the
Program, if reinstallation becomes necessary; and
(4) You may make one copy of the Program for Use in a testing
environment solely for testing purposes; and,
(5) You may make and install one copy of the Program at a
disaster recovery site for Your Use only for so long as a disaster
or other emergency prevents You from Using the Program at
Your original installation site.
(k) “You” or “Your” means or refers to the company or person that
Sage has registered as the licensee for the Software.
4. Limits of License.
The license contained in this Agreement does not include the right to
perform, and You agree to refrain from performing, any of the following:
(a) Except as expressly set forth in section 3(j) above, making any

copy of the Software, except as an essential step in Your licensed
Use thereof.
(b) Distributing any copy of the Software (whether by renting,
leasing, lending, sublicensing, time-sharing, or otherwise), except
that, if Sage consents in writing, which consent will not be
unreasonably denied, You may transfer the Software to a purchasing
party after the close of a sale of either Your entire business, or all, or
substantially all, of the assets of Your business, provided that the
purchasing party reads and accepts (in writing to Sage) the terms
and conditions of this Agreement, the purchasing party agrees to
other reasonable transfer requirements, and You do not retain a
copy of the Software.
(c) Using the Software for personal, family, household, or other nonbusiness purposes;
(d) Altering, modifying, translating, decompiling, disassembling or
reverse-engineering the Software or creating any derivative work
based upon the Software;
(e) Removing or obscuring any copyright or trademark notices from
the Software.
(f) Using the Software in excess of (i) the limitations set forth in this
Agreement and Supplemental License Terms, and (ii) the number
and types of users, seats or licenses You purchase or rightfully
acquire.
5. Additional Restrictions.
(a) Any report-writing software contained within the Program may be
subject to a restriction such that its use may be limited to accessing
only the data that is created by, or used by, the Program;

(b) You may not Use, export, re-export or otherwise transfer the
Software in violation of any domestic or foreign laws or regulations in
effect from time to time in the jurisdiction in which You are a resident
or in which the Software is Used. You represent and warrant that You
are not located in, under the control of, a national or resident of, any
restricted country or of any entity or person designated as restricted.
6. U.S. Government Restricted Rights.
The Software is provided with restricted rights. Use, duplication or
disclosure by the U.S. Government is subject to restrictions as set
forth in paragraphs (a) – (d) of the Commercial Computer Software Restricted Rights clause at 48 CFR 52.227-19, or Section 227.7202
of the DFARS. The Manufacturer is Sage Software. Sage's address
in the United States is 56 Technology Drive, Irvine, California 92618;
Sage's address in Canada is 50 Burnhamthorpe Road West, Suite
700, Mississauga, Ontario L5B 3C2, Canada.
7. Limited Warranty and Disclaimers.
(a) Sage warrants that, during the one hundred and eighty (180) day
period (the “Warranty Period”) that commences on the date that
Sage Enabled Use of the Software (whether for an initial license, an
upgrade or a maintenance release under a service plan), the
Program, when properly Used, shall perform substantially in
accordance with the Documentation. Sage does not warrant or
represent that Your Use of the Program will be uninterrupted or errorfree. If You report to Sage in writing within the Warranty Period any
non-conformity between the Documentation and the Program, and if
Sage is able to replicate and verify that such non-conformity exists,
Sage shall make commercially reasonable efforts to correct such
non-conformity and, if successful, shall supply You with such
correction at no additional cost to You. If such efforts are
unsuccessful and the non-conformity is material:
(1) Except for Maintenance Software, You may terminate this
Agreement, discontinue Use of, and return all copies You have
of the Software, and Sage will ensure that You receive a refund

of the license fee You paid and credit for any license fee You
owe for the Software; and
(2) For Maintenance Software, You may terminate Your service
plan, discontinue Use of, and return all copies You have of the
Maintenance Software, and Sage will ensure that You receive a
refund of, or credit for, the service fee You incurred for the
purchase of your most recent service plan. The foregoing states
Your sole and exclusive remedy for any breach of this warranty.
(b) With respect to any media by which You may have received Your
installation copy of the Program, Sage warrants that the media is
free from defects in materials and workmanship under normal use for
the Warranty Period. Your sole and exclusive remedy under this
warranty is limited to replacement of defective media.
(c) Other than the express, limited warranties stated above in this
section, sage and its suppliers expressly disclaim to the fullest extent
permitted by law all other representations, warranties, conditions and
guarantees of any kind or nature whatsoever, whether express,
implied and statutory, including but not limited to, any warranties,
conditions or guarantees (i) of merchantability, (ii) of fitness for a
particular purpose, (iii) of non-infringement of proprietary or
intellectual property rights of any third party, and (iv) arising from
custom or trade usage or by any course of dealing or course of
performance. you understand and agree that: (1) the utility of a
business management computer program decreases as technology
evolves and the business environment changes, (2) you are free to
decide, and are responsible for deciding, when to upgrade your
software, and (3) sage disclaims any responsibility to deliver laterreleased software or otherwise render any customer support
services except as may be specified in a separate customer
maintenance and support agreement.
(d) Other Limitations. Sage will have no responsibility under these
limited warranties for any Software or media that has been modified,
lost, stolen or damaged by accident, abuse or misapplication. No

employee, agent or representative of Sage, nor any reseller
(including Your Distributor) or any other third party, is authorized to
make any warranty with respect to the Software, except those
expressly stated in this Agreement, and You may not rely on any
such unauthorized warranty. You acknowledge and agree that You
have chosen Your Distributor, and that such Distributor is an
independent party and not an agent of Sage.
8. Exclusions of and Limitation of Liability.
(a) You acknowledge Your understanding that software is inherently
complex and may not be free from errors, and that You have been
advised to verify the work produced by the Program. Neither Sage
nor its suppliers shall be liable for any special, indirect, incidental,
consequential or punitive damages resulting from any defect in the
Software or media, even if Sage has been advised of the possibility
of such damages. This means Sage is not responsible or liable for
damages or costs incurred as a result of loss of time, loss of data,
loss of anticipated profits, lost opportunity cost or loss of use of the
Software, nor for damages or costs incurred in connection with
obtaining substitute software, claims made against You by others or
similar costs. In no event shall sage’s liability to you arising out of or
in connection with the software or this agreement, whether in
contract, tort or otherwise, exceed the license fee actually paid by
you to purchase the license for the software. You acknowledge and
agree that this Agreement allocates risk between You and Sage as
authorized by applicable law, and that the pricing of Sage’s products
reflects this allocation of risk and the exclusions and limitations of
liability contained in this Agreement. If any remedy hereunder is
determined to have failed of its essential purpose, all limitations of
liability and exclusion of damages set forth in this Agreement shall
remain in full force and effect.
(b) You acknowledge that unless You and Sage agree in writing for
Sage to provide software implementation services to implement the
Program at your place of business, You are responsible for engaging

a qualified party to provide implementation services for You on terms
You negotiate. You also acknowledge that You are responsible for
independently investigating the skills and qualifications of such party
to ensure that they provide You with the level of skill and service
Your business requires. You agree that Sage shall have no liability
whatsoever for any failure associated with such implementation
services, even if the party You engage is an authorized or certified
Distributor, consultant, or installer of Sage products.
9. Jurisdictional Rights.
This Agreement gives You specific legal rights, and You may also
have other rights, which vary from jurisdiction to jurisdiction. Some
jurisdictions do not allow the exclusion or limitation of implied
warranties or of liability for incidental or consequential damages, so
some or all of those sections of the Agreement may not apply to You.
10. Term.
This Agreement is effective from the date You accept it and
continues in effect until terminated. You may terminate this
Agreement at any time, at which point Your license hereunder will
terminate. This Agreement and the license granted herein will
terminate automatically and without notice if You fail to comply with
any term or condition of this Agreement. You agree upon termination
to return the original Software to Sage and to destroy all other
Software copies in Your possession. Any provision in this Agreement
which when reasonably read is intended to survive the termination of
this Agreement shall survive, including without limitation, the
disclaimer of warranties and limitations of liability.
11. Entire Agreement and Severability.
This Agreement (including the Supplemental License Terms which
are incorporated by reference and made a part hereof) represents
the complete and exclusive understanding between You and Sage

regarding the Software, and supersedes any prior purchase order,
confirmation, advertising, representation, or other communication.
This Agreement may not be modified except by a written agreement
signed by an authorized Sage representative. If any provision of this
Agreement is found to be void, invalid, or unenforceable, it shall be
severed from and shall not affect the remainder of this Agreement,
which shall remain valid and enforceable. Any such severed
provision shall be replaced with a similar provision, which conforms
to applicable law and embodies as closely as possible the original
intent of the parties.
12. Dispute Resolution, Waiver of Collective or Class Action, Choice
of Law, Statute of Limitations and Language.
Any cause of action or claim arising out of or relating to this
Agreement or the breach thereof, including without limitation, the
validity, enforceability or scope of this Agreement, shall be settled by
binding arbitration pursuant to this section 12 and the applicable
rules of either J.A.M.S/En dispute or the National Arbitration Forum
in effect at the time the claim is filed. Judgment upon the award
rendered by the arbitrator may be entered in any court having
jurisdiction thereof. In addition, You agree that any cause of action or
claim will be arbitrated individually and that You will not consolidate
or seek class treatment for any claims, unless previously agreed to
in writing by You and Sage. This Agreement shall be governed by
the laws of (i) the State of California if primary Use of the Software
occurs in any jurisdiction other than Canada, or (ii) the Province of
British Columbia if primary Use of the Software occurs in Canada,
each without regard to the conflict of laws provisions thereof or to the
United Nations 1980 conventions on the International Sale of Goods.
The parties have expressly requested and required that this
Agreement and all other related documents be drawn up in the
English language. Les Parties conviennent et exigent expressément
que ce Contrat et tous les documents qui s’y rapportent soient
rédigés en anglais. any claim or cause of action, regardless of form,
must be brought no more than one (1) year after it arose, otherwise
the claim or cause of action shall be barred, except that the
foregoing limitation and the arbitration provision shall not apply to the

enforcement by sage of any of its intellectual property rights. this
provision shall survive termination of this agreement.
13. Indemnification.
(a) If You receive notice of any claim that Your use of any part of the
Software infringes any third party’s intellectual property right in a
patent, copyright, or trade secret, Sage shall defend, and shall
indemnify and hold You harmless by paying any resulting costs and
damages finally awarded by a court with respect to any such claim
provided that You:
(1) Notify Sage in writing promptly upon becoming aware of the
claim,
(2) At Sage’s request and expense, give Sage such information
and assistance as is reasonable under the circumstances, and
(3) Give Sage the right to settle the claim in Sage’s sole
discretion and at Sage’s expense.
(b) This indemnification does not extend to any claim based upon
any alleged infringement arising from the combination of the
Software with other elements not under Sage’s sole control, or
arising from any part of the Software that You or a third-party modify,
or that incorporates specifications, designs or formulas that You
provide. If You are prevented from Using the Software because of an
actual or claimed infringement, then at Sage’s option, Sage shall
promptly either obtain for You the right to continue Using the affected
part of the Software, replace or modify the affected part of the
Software so that it becomes non-infringing, or if none of the
foregoing alternatives are possible after Sage exercises
commercially reasonable efforts, You may terminate this Agreement
and any service plan, and Sage shall ensure that You receive a
refund of, or credit for:
(1) the service fee You incurred for the purchase of Your most
recent service plan; and
(2) a pro rata portion of the license fees You incurred for the
purchase of Your initial license and all upgrades, which pro rata

portion will be determined on the basis of the remaining period
of a useful life of (5) five years, where the five year useful life
begins on the date of Your purchase of Your initial license and
the remaining period begins on the date You so terminate.
(c) This section 13 sets out sage’s entire financial liability for any
intellectual property claims or actual infringements relating to the
software.
You hereby give Sage permission to send you information regarding
Sage’s products and services by various delivery methods, including via
facsimile. (#21677 / 011409)
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Workstation Licenses
*Please note that when the word ‘Workstation’ is used within this help file
section it refers to a physical computer and not an Accpac Workstation
installation.
Sage Accpac Intelligence uses a workstation Licensing model. After you
have serialised your Sage Accpac Intelligence installation, you will have
a (n) Workstation Licenses available (where n is the number of Licenses
you have purchased). The first (n) workstations to access Sage Accpac
Intelligence will be assigned these Licenses. When the (n) licenses have
been assigned you will need to purchase more licenses or you will need
to Un-Assign some existing Licenses.
Licenses will be tied to a User Name and Workstation so the licensing is
not “concurrent” licensing. The preferred method is to allow workstations
to claim licenses at first access, however you may manually add
workstation licenses.
The License Manager provides a snapshot of your Sage Accpac
Intelligence licenses and module configuration.

Allowing Workstations to Claim Licenses at first access
For each workstation, follow steps 1-7 of the Installation Guide
8. Click the browse button
and navigate to the shared network folder
where your Server Report Repository is located.
9. Click OK.
10. Enter your connection details and click OK.

11. Select the Correct License type for the workstation.
12. Click OK.

Manually Adding Workstation Licenses
1. When the License Manager is opened, the screen below will open,
listing the licenses.

2. Select the Add button to add a new license, the screen below will open.

3. Enter the User name to assign the license to.
4. Choose the license type you would like to add.
5. Click OK.
6. You will now see the license you added along with the license type.
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Upgrading from older versions of Sage Accpac
Intelligence
When performing an upgrade of new reports, current reports and settings
are not deleted. The intention of an upgrade is to import new reports into
the current metadata repository only and not modify current versions of
reports and settings that were created and saved prior to the upgrade.
1. Back up current BXDATA (Reports and Settings folder e.g.
C:\Program Files\Sage\Sage Accpac\BXData)
2. Uninstall current Sage Accpac Intelligence within current Accpac
installation.
3. Upgrade current version of Accpac to new version.
4. After activation, replace the new BXDATA with the older backed
up BXDATA in order to retain current reports and report manager
settings.
5. See Bulk Import section in order to successfully import the new
version reports.
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Login Properties
User Name – The name of the Login.
Your Sage Accpac Intelligence logon credentials will be
required
Password – Sage Accpac Intelligence password will be required.
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Standard Reports Available
Sage Accpac Intelligence comes with sample reports that you can use as
templates when creating your own reports.
Financial Reports

Financial Trend Analysis

Dashboard Analysis
The Dashboard Analysis report contains a one-page summary of key
business information. The report features Top 5 Reporting on customers,
items, expenses, and contains both text and graphics to help with daily
and long-term planning. In addition, comparative Profit and Loss figures
are displayed for both the current month and year-to-date figures from
the start of the current financial year.

Income Statements

Balance Sheets

General Ledger Transaction Details

Sales Master
This report highlights pertinent sales information including item sales
quantities, costs, and gross profits by customer and product.

Inventory Master
Displays item cost and quantity information over any given date range, as
well as relevant item location details.

Purchase Order Master
This report lists relevant purchase information by vendor and item
number for any given date range. The report can be filtered by vendor,
item number, or unit of measure.

If the Analysis Module is purchased, the following Cube
reports are also included:
Financial Analysis Cube
This report allows you to analyze G/L accounts by Account Group and
segment over multiple fiscal years.

Financial Analysis Cube Trend

Inventory Analysis Cube
This report allows you to analyze year-to-date stock-on-hand quantities,
purchase and sales order quantities, and actual stock values by inventory
group.

Inventory Analysis Cube Trend

Sales Analysis Cube
This report allows you to analyze sales quantities, gross profits, and
amounts by customer, product, and salesperson over multiple
fiscal/calendar years.

Sales Analysis Cube Trend
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Accessing the Sage Accpac Intelligence Reports
To access the reports:
1. In Windows, Click on All Programs, Sage Accpac, Sage Accpac
Intelligence.
2. Click on Report Manager or Report Viewer to access the reports
directly. This will launch the relevant interface.

Running a Report from the Report Manager
1. Select the report you want to run. For this example, choose Sales
Master under Sales
2. To run the report click on the green Run icon, You can also right-click
and select Run or press Ctrl+R

3. Enter Report Parameter. (Date/ Month)
4. Click OK
5. The progress Status is displayed on the right of your screen and
indicates the process of your report. Depending on the size of your
company data, running a report may take some time. You can
sometimes cancel the report.

6. Once the process has finished, the report opens in a new Microsoft
Excel Workbook
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Copying, Pasting and Renaming Reports
You can copy and paste a report, at any stage, in the report manager.
These functions are useful in Sage Accpac Intelligence because all the
Master reports are locked and you need to make a copy of these master
reports. Use the copy, paste, and renaming methods so you can create
new reports from an existing report and therefore not corrupt the master
report.
You may have a sales report that shows a customer analysis on sales;
however, you want to create another report that shows sales analyzed by
Reps. You can create a copy of the original report, and then rename the
copy to Sales by Rep, and then customize the new Sales by Rep report.
You have the benefit of re-using all the containers and expressions in the
original report without having to create them from scratch.

To create a new report from an existing report
1. Open the Report Manager.
2. Right-click on the report you want to make a copy of; e.g. Sales Master
3. Select Copy to copy that report to the Clipboard.

4. Now paste the copied report onto a folder.
5. Select a folder. You can choose the same folder that contains the
original report or a different folder.
6. Right-click on the selected folder and select Paste.

7. Rename the newly copied report. By default, the report’s name is Copy
of <report name>.
Note – You can use the short-cut keys of Ctrl+C to copy the
report, and Ctrl+V to paste instead of using the menus.

Right-click on the report and select Rename to give the report a
different name. You now have an exact duplicate of the original
report that will obtain its data from the same place, and deliver it
in the same format, until you make any changes to this new
report.
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Creating and Linking a Report
It is entirely possible to customize the look and layout of the Sage Accpac
Intelligence Standard Reports. Although these reports are designed to
encompass the needs of most business organizations, you may want to
change the appearance (colors, text style, etc.) to reflect your company
image, and perhaps change the order or inclusion of columns to suit your
company processes. These changes can be saved for the next time you
run the report.
Creating Excel templates enables the user to create a template from an
open Excel workbook and link it to an existing report so as to standardize
the output format of the chosen report for every run instance in future.
Note: If you are unsure of making changes to any of the Standard
Reports, you should create a copy of the report before you make any
changes.
Sage Accpac Intelligence users must make a copy of a report in order to
edit the standard reports.
To copy a report
1. Open the Sage Accpac Intelligence Report Manager.
2. Right-click the report you want to copy and select Copy.
3. Right-click on the report folder in which you want to paste the copy and
select Paste. The copy of the report is renamed as Copy of and the
original report name.
To create and link the Report
1. Open the Sage Accpac Intelligence Report Manager.
2. Select and run the report you want to customize.

3. Make the changes to the report; ensure that Sheet1 (where Sage Accpac
Intelligence puts the Raw Data) and Sheet2 (where Sage Accpac
Intelligence puts the report parameters) are unchanged.

4. After completing the changes, leave the workbook open and go back to
the Report Manager.

5. Right-click on the report for which the changes were made and select
Create and Link Template.

6. Select the workbook with the changes in the window that appears.
7. Click OK.

8. When prompted with the following message, click Yes to link the
workbook. Clicking No will not link the workbook.

9. When prompted to specify the template name, change the name of the
template. Doing so ensures that the original template is not overwritten
with the copy

10. Click OK.
Once the template has been successfully linked, a message is
displayed.
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Adding & Creating a New report
To create a new report from existing containers, you must first create a
new folder. Remember that folders contain all the reports related to a
particular topic. For example, all reports related to Sales. You cannot
create sub folders.

Creating a New Report from Existing Containers
This process consists of two steps:
Adding a folder
Adding a report
To add a folder
1. Open the Sage Accpac Intelligence Report Manager.
2. Select Home.
3. Right click and select Add Folder. The Enter a Name for the Folder
window opens

4. Enter a name for your folder; e.g., Sales Test.
5. Click OK.
To add a report
1. Select the Folder where you want to add the report; e.g., Sales Test.
2. Right-click and select Add Report.
3. Select the type of report to add when prompted. You will add a standard
report

4. Enter a new name for the report; e.g., Sales Report.

5. Click OK and the Select Data Container window opens.

6. Select the data container from which you want to source your data; e.g.,
Sales Details. The Choose Column fields window opens.

7. Select the columns you require in your report.
8. (Optional) Click Select All to select all of the Expressions.
9. Click OK. Your new report is now in your specified folder.
To Run the Report, in the object window select the report you have just
created and click on the Run icon
on the Report Manager Toolbar.
Sage Accpac Intelligence will launch the report and your data will be
rendered to Excel.
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Sage Accpac Intelligence Report Properties
The report type (Standard, Dataless, Sub query or Union) mainly
determines which standard tabs are available on the selected Properties
window. A typical Properties window of Standard report types has,
besides the Properties tab also a tab for each report output property,
namely Columns, Filters, Parameters, Sort Fields, and Aggregate Filters.

Report Properties Overview
We will look at the properties and columns of a standard report.
When selecting a report, tabs appear on the right of the screen. These
tabs allow you to modify the report’s display output.
Properties Tab
The Properties tab enables you to view and change general report details
such as the report name and description. To confirm any change select
the Apply button on the top right of the properties window

Columns Tab
The columns window lists the columns that make up the Excel report.

You are able to Add, Remove or change the order of the columns using
the buttons on the top right of the window.
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Adding Additional Columns
1. Select the Columns tab from the Properties window.
2. Click Add

3. Select the desired column.

4. Click OK.
The new column appears in the Columns window.
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Moving and Deleting Columns
Moving Columns
If you want the columns to appear in a certain order in Microsoft®
Excel®, you can change their order in the Properties window.
1. From the Properties window, select the Columns tab
2. Select the desired column/s
3. Click Move Up or Move Down

OR
4. Select the desired column/s

5. Drag to the appropriate position.

Deleting Columns
1. From the Properties window, right click on the desired column.
2. Click Delete.

or
1. From the Properties window, Click on the desired column.
2. Click Remove.
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Exporting Reports
Reports can be exported from one system and imported into another.
The export function creates a compressed file with an .al_ extension
which can be imported into other systems. The uncompressed version of
the file will create a file with the extension .alx
1. From the Object window, right click on the desired report and select
Export Report or click on Tools, Export Report.

2. Select the Export folder when prompted.
3. Click Save.
You will get a message to confirm your Export Succeeded.

4. Click OK.
To import a Report into Sage Accpac Intelligence from an export file see
Importing a Report.
Note: If you are running a Third Party Developer License of Sage
Accpac Intelligence then it is possible for you to protect your export files.
See Exporting Reports with Protection in the user's guide for more
details.

Home > Getting Started Guide > Importing Reports

Importing Reports
Reports can be exported from one system and imported into another.
The export function creates a compressed file with an .al_ extension
which can be imported into other systems. The uncompressed version of
the file will create a file with the extension .alx
Report export files (.alx files) and compressed export files (.al_ files version 3.5 and later) created using the Export Report facility can be
imported into Sage Accpac Intelligence. Using this facility, Reports can
be created in one Sage Accpac Intelligence system and distributed to
other Sage Accpac Intelligence systems.
1. Right-click on the Home object in the Object window and Select
Import Report or click on Tools, Import Report.

2. Select the report to be imported (with the _al extension) and click Open
3. In the Import Report window, select the Target Connection
(Connector)
4. Then select the Report Destination (the folder)

5. Click Import

6. Click OK.
7. Double-click on the Sales Reports folder to refresh
Below is a list of the information that is supplied to you for an import
and a description of each element:

Report Name

The original name of the Report in the Source Sage
Accpac Intelligence System

Created By
Company

The Company that created the Export File

Report Container
Source
Creation Time
Original Template
Name
Template File Size
Original
Connection Name
Export Library
Version
Import Library
Version
Target Connection
Target Connection
Type
Report
Destination

The Source Container for the Report in the Source
Sage Accpac Intelligence System
The Date and time that the Export File was created
The name of the Report Template in the Source Sage
Accpac Intelligence System
The size (in bytes) of the Report Template File
The name of the Source Data Connection in the Sage
Accpac Intelligence Source System
The Version of the Export Program Library used to
create the export file
The Version of the Import Program Library being used
to perform the import
The Connection that you have selected as the Source
for the new report that will be created by the import
The Source Connection Type of the Connection that
you have selected as the Source for the new report that
will be created by the import
The Report Manager Folder into which the new report
will be imported
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Security Manager Access
Method
1. Open your Security Manager.

2. In the Security Manager window, it is highly recommended that the
Security On checkbox be enabled. Click the button to enable it.

3. You will be prompted for a password. Type in a password and click
Set.

4. Confirm your password. This password will be required in future to
gain access to the security manager.

5. Click Ok. A confirmation box will appear.

6. Click Ok.

7. Proceed to Add Roles

Home > Getting Started Guide > Security Manager > Adding Roles

Adding Roles
1. From the Users tab, click the Add button under the Roles section to add
a new role.

2. Enter a Name for the Role

3. Your role will now be added. Repeat steps 1-4 for each additional role
you would like to add.
4. Select the users that should belong to each role.

5. Passwords for users are by default, blank. For each user, click Change
Password to set the password.
6. Proceed to Add Reports to Roles.

Home > Getting Started Guide > Security Manager > Adding Reports to Roles

Adding Reports to Roles
1. Click on the Reports tab to assign access to specific reports for each
role.

2. For each role, select the role in the left pane, and select the reports in
the right pane which that role must have access to.
Note that Union/sub reports are automatically added when the main
report is added.

The users now assigned to that role, have access to the reports that the
system administrator has assigned to the role.

Home > Getting Started Guide > Creating a Simple Pivot Table in Excel > Reasons for Organizing Data
into a Pivot Table

Reasons for Organizing Data into a Pivot Table
Four key reasons for organizing data into a Pivot Table are:
To summarize the data contained in a lengthy list into a compact
format
To find relationships within the data that are otherwise hard to see
because of the amount of detail
To organise the data into a format that’s easy to chart
View the same data in many different ways quickly and easily
Pivot Table reports use functions, allowing you to total, average and
count data. These functions also provide subtotals and grand totals
automatically, where you choose to show them.
Original Worksheet

Pivot Table

Pivot Chart

Home > Getting Started Guide > Creating a Simple Pivot Table in Excel > Pivot Tables Excel 2007 > Pivot
Table Concept and Layout 2007

Pivot Table Concept and Layout
Excel 2007 Concept and Layout
An important point to remember when working with Pivot Tables is that
you are working within a layout slightly different to a normal Microsoft
Excel worksheet. A Pivot Table has its own Ribbon and that alone
provides functionality specific to the Pivot Table and not to a normal
Microsoft Excel cell on the worksheet.
Although one can format a cell using the format tools on the Home tab of
the Ribbon, a Pivot Table provides its own format cells option on its
Ribbon as it is treated as a separate entity.
A Pivot Table has its own layout and is split up into 4 sections.

Each of the above sections is used to show fields from the Pivot Table
source data, each section having its own purpose.

Report
Filter

This section assists in providing a third dimension to
your data. It can also provide a more
summarised/filtered view of the rest of the fields
displayed in the other sections.
When placing a field in this section it therefore reduces
the number of items within a Pivot Table and in some
instances prevents the Pivot Tables number of items
limitation from being reached.

If you include a page field in your Pivot Table you can
choose to display the Pivot Table pages on separate
worksheets. Select the show pages button on the
drop down menu of the Pivot Table toolbar button.
Microsoft Excel will automatically replicate each
page’s data on a separate worksheet.
Column
Labels
Row
Labels

Values

One would place fields in this section when wanting to
group the data by a specific field e.g. by customer.
Your customers will appear in the columns going
across.
One would place fields in this section when wanting to
group the data by a specific field. E.g. by Customer.
Your customers will appear in the rows going down.
One would normally place fields in this section where
their values are numbers such as a qty or amount
field e.g. Customer Sales.
Calculations such as sum, average, min, max etc can
be used on such fields. This section has to contain at
least one field.

Home > Getting Started Guide > Creating a Simple Pivot Table in Excel > Pivot Tables Excel 2007 >
Create a Pivot Table Report

Create a Pivot Table Report
To create a Pivot Table you need to identify these two elements in your
data:
Have a list in Microsoft Excel with data fields (headings) and rows of
related data
Identify which fields are going to go where in your design
Method
1. Select any cell in the data list
2. From the Insert tab, in the Tables group, select Pivot Table

3. Make sure that Select a table or range is selected

4. Make sure your data is listed in the Table/Range box
5. Select where you want the Pivot Table to go, either in an Existing
Worksheet or New Worksheet
6. Select OK
7. A blank Pivot Table will now be displayed.

8. In the Field List either select the fields you want in the Row Labels or
drag them into the Row Labels area on the Field List box
9. Repeat for Report Filter, Columns Labels and Values.

Home > Getting Started Guide > Creating a Simple Pivot Table in Excel > Pivot Tables Excel 2007 > Pivot
Table Field List > Pivot Table Field List

Pivot Table Field List
The Pivot Table Field List contains the fields available for your Pivot
Table, based on the fields in the data range that the Pivot Table is based
on. In addition there are areas where you can add Report Filter (Page
Area fields), sections that list the row and column fields and a section for
the Data Area fields.

Turn the Field List On/Off
The Pivot Table Field List is only visible while you are within the Pivot

Table. If you are within the Pivot Table and it is still not visible, right click
and select Show Field List. You can also turn the field list on and off
from the Ribbon.
Method
1. Select any cell in the Pivot Table
2. From the Options tab, in the Show/Hide group, select Field List
OR
1. Select any cell in the Pivot Table
2. Right click and select Show Field List

Home > Getting Started Guide > Creating a Simple Pivot Table in Excel > Pivot Tables Excel 2007 > Pivot
Table Field List > Remove, add and move fields

Remove, add and move fields
When selecting a field from the data area to move or remove, you need
to select the field by placing the mouse pointer on the border of the field
and clicking when the pointer changes to the normal arrow pointer.
Fields that appear in the Pivot Table will have a tick in their check box on
the Field List. De-selecting this check box will remove the field from the
Pivot Table.
Remove a Field
Method
1. From the Field List select the check box next to the field you wish to
remove

OR
1. From the Field List, select the drop down arrow next to the field
2. Select Remove Field

Add a Field
Method
1. Select the check box next to the field in the Field List

OR
1. Select the Field in the Field List and drag it to the desired area e.g.
Report Filter

Move Fields within the Table
Method
1. From the Field List, drag the field to the desired area
OR
1. From the Field List, select the drop down arrow next to the field
2. Select Move Up, Move down etc.

Home > Getting Started Guide > Creating a Simple Pivot Table in Excel > Pivot Tables Excel 2003 > Pivot
Table Concept and Layout 2003

Pivot Table Concept and Layout 2003
Excel 2003 Concept and Layout
An important point to remember when working with Pivot Tables is that
you are working within a layout slightly different to a normal Excel
worksheet. A Pivot Table has its own toolbar and that alone provides
functionality specific to the Pivot Table and not to a normal Excel cell on
the worksheet.
Although one can format a cell using the format menu, a Pivot Table
provides its own format cells option on its toolbar as it is treated as a
separate entity.
A Pivot Table has its own layout and is split up into 4 sections. With
reference to the diagrams below you can see the layouts in two different
ways. The one on the left being the layout which is visible on the Excel
worksheet, the one on the right being the same layout but with its
appearance when working within the Pivot Table Wizard.
Layout as per a Pivot Table

displayed on a worksheet
wizard

Layout as per the

Pivot Table

Each of the above sections are used to show fields from the Pivot Table
source data, each section having its own purpose.

The Row
Area

The Data
Area
The
Column
Area

The Page
Area

One would place fields in this section when wanting to
group the data by a specific field. E.g. by Customer. Your
customers will appear in the rows going down.
One would normally place fields in this section where
their values are numbers such as a amount field e.g.
Customer Sales. Calculations such as sum, average,
min, max etc can be used on such fields. This section has
to contain at least one field.
One would place fields in this section when wanting to
group the data by a specific field e.g. by customer. Your
customers will appear in the columns going across
This section assists in providing a third dimension to your
data. It can also provide a more summarized/filtered view
of the rest of the fields displayed in the other sections.
When placing a field in this section it therefore reduces
the number of items within a Pivot Table and in some
instances prevents the Pivot Tables number of items
limitation from being reached.

Home > Getting Started Guide > Creating a Simple Pivot Table in Excel > Pivot Tables Excel 2003 >
Create a Pivot Table Report

Create a Pivot Table Report
To create a Pivot Table you need to identify these two elements in your
data:

Have a list in Excel with data fields (headings) and rows of related data
Identify which fields are going to go where in your design
Method
1. Select any cell in the data list
2. On the Menu bar select Data
3. Select Pivot Table and Pivot Chart Wizard.
4. Make sure that Microsoft Excel list or database is selected as the data to
analyze
5. Make sure the kind of report is selected as Pivot Table.

6. Select Next
7. Select the collapse icon in the range box

8. Select the data range on the worksheet that contains the source data
9. The selected range will appear in the range box

10. Select the collapse icon again to return to your active worksheet .
11. Select Next
12. On the next screen, select where you want to place the Pivot Table,
select New Worksheet
13. Choose another cell if you do not want the current cell as the position
on the worksheet

14. Select Layout
The Pivot Table and Pivot Chart Wizard – layout window appears

15. The column headings from the source data will now appear as fields on
the right
16. Drag the fields to the relevant positions on the layout

17. Select OK

18. Select Options
19. Select your required options
20. Select OK
21. Select Finish
The Pivot Table will be now be displayed

Home > Getting Started Guide > Creating a Simple Pivot Table in Excel > Pivot Tables Excel 2003 >
Remove, Add and Move fields

Remove, Add and Move fields
When selecting a field from the data area to move or remove, you need
to select the field by placing the mouse pointer on the border of the field
and clicking when the pointer changes to the normal arrow pointer.
Remove a Field
Method
1. Select a Field and drag it outside of the Pivot Table area and drop it
OR
1. Right click on a Field
2. Select Hide

Add a Field
Method
1. Select a Field from the Field List
2. Drag it into the Pivot Table area and drop it in the appropriate position
OR
1. On the Pivot Table toolbar select Pivot Table
2. Pivot Table Wizard, select the Layout button
3. Drag the fields to the appropriate position
OR
1. Select the Field in the Field List
2. From the drop down, select the Area you would like to add it to

Home > Tutorials > Welcome to the Sage Accpac Intelligence Software Tutorials

Welcome to the Sage Accpac Intelligence
Software Tutorials
Tutorial Overview
The object of these tutorials is to provide you with an interactive tour of
the Sage Accpac Intelligence software. To accomplish this you need an
overall understanding of the Source Sage Accpac Intelligence System
software package. The Sage Accpac Intelligence software package is
made up of two modules:
The Connector
The main purpose of the Connector is to create and maintain links to
your data sources, for example, an Access database or any other ODBC
compliant database.
The Report Manager
The main purpose of the Report Manager is to create and maintain Sage
Accpac Intelligence reports linked to Excel.
The following tutorials will take you through these processes in detail.
Use the next --> link below to start the first tutorial.
Next -->

Home > Tutorials > The Report Creation Overview

Report Process Overview
How are reports created in Sage Accpac Intelligence?
The process of creating a report requires that you use the Sage Accpac
Intelligence Connector to create a connection to a data source. The Sage
Accpac Intelligence Report Manager is then used to create the report and
link it to an Excel template. The following figure summarizes the entire
process of creating a report using the Connector and the Report Manager
module:

Report Creation Summary
The tutorials following will take you through these processes in detail.

Home > Tutorials > Connector Tutorial > Welcome to the Sage Accpac Intelligence Connector Tutorial

Welcome to the Sage Accpac Intelligence
Connector Tutorial
Tutorial Overview
This tutorial is designed to take you on an interactive tour of the
Connector . During this tour you will interact with and be exposed to all
the important functionality of our product. The tutorial uses the Sage
Accpac Intelligence sample database for the interactive exercises.

How do I use the tutorial?
This tutorial is divided into a number of interactive exercises. As you
complete one exercise use the next --> link at the bottom of the page to
advance to the next exercise. The sessions are linked together and
therefore must be done in order.
The tutorials are designed to be used in conjunction with the help system.
The purpose of completing the exercises using the help system is to
ensure that you will be able to use the help system effectively when using
the software.
To move between the tutorial, help file and the Sage Accpac Intelligence
software, use the keystroke Alt+Tab.

What do I need before I start?
You will need the following in order to run the tutorial successfully:
An installed and licensed version of Sage Accpac Intelligence .
Correctly installed version of Microsoft Excel 2003, 2007 or 2010.
Operating System : Windows XP SP3, Windows Vista, Windows
7, Windows Server 2003, Windows Server 2008, Windows
Terminal Server

What skills do I need to be able to do the tutorial?
Although you are able to complete the tutorial with only the most basic
computer skills, you will benefit most if you have the following skills:
Intermediate Windows navigation skills.
You should be familiar with using all the mouse functionality.
Familiar with database design methodology and database
terminology.
Next-->

Home > Tutorials > Connector Tutorial > Getting Started

Getting Started
To effectively complete the exercises you need a good grasp of the Sage
Accpac Intelligence interface and how to perform tasks in the software.

About the layout of the interface
The layout of the interface is uncomplicated. The software layout is
divided into two main areas:

1. Object Window: You are able to select objects using your mouse
from the object window in order to either view the objects
properties or perform a task with the object. For example, you are
able to select an object in the object window and rename the
object just as you would rename a file in Windows Explorer.
2. Property Window: You are able to view and update the
properties of a selected object using the property window. For
example, you are able to add your own custom description of the
object in object's property window.

About ways of performing tasks in Sage Accpac
Intelligence
There are three methods of performing tasks in Sage Accpac Intelligence
:
1. Menu bar: Use your mouse to select a task from the menu bar.
2. Toolbar: Use your mouse to select a task from the toolbar.

3. Short-cut menu: By right-clicking an object in the object window, you
are able to display a short-cut menu of tasks that can be performed on
the selected object. This menu is useful for completing tasks quickly.

Working with Objects
To view an object's associated elements, double-click on the object. This
action is called drilling-down. To hide an object's associated elements,
double-click an open object. This action is called drilling-up.
Next-->

Home > Tutorials > Connector Tutorial > Using the Help System

Using the Help System
In order to complete the task you need to open the Sage Accpac
Intelligence help system. Follow the steps below to open the help system.

Opening the help system
1. Open the Sage Accpac Intelligence Connector .
2. On the Help menu, click Help. The Sage Accpac Intelligence
help system is displayed. (Shortcut = F1)

Locating a specific help topic
To locate a specific help topic, do one of the following:
Use the Contents window: Navigate to the relevant topic using
the Contents window.
Use the Search window: Enter a search criterion in the Search
window and click the List Topics button. Double click on a
displayed topic in the Selected topic window.
Next-->
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The Data Connection Process
The main purpose of the Connector is to create and maintain data
connections. Creating a data connection is a three part process:

The following exercises take you through these processes.
Next-->
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Connecting to a Data Source

Overview
You have been requested to create a report based on the Document
Header table from your company database. Your first task is to create a
connection to the database. Complete the following exercises to achieve
this objective.

Exercise 1: Connecting to a Data Source
Connect to the data source using the details listed below. Use the help
topic Add a Data Connection to assist you with this task.
We run an Access database with the following details:
Data Connection Type: ODBC Driver for Access
Data Connection Name: RKL Trading Demo
Database Location: The position of the server folder depends on
where the Sage Accpac Intelligence software was installed. Ask
your network administrator for the exact location.
Database name: RKL Trading.mdb
User Name and Password: (blank)
Step-by-Step Solution:
Create the data connection by doing the following:
1. Open the Connector .
2. Double-click on the Enterprise icon in the Object window. All
connection types are displayed.
3. Right-click on the ODBC Driver for Access and select the Add
Connection from the displayed shortcut menu.
4. Use the details provided in the exercise to enter the Connection
Name in the Connection Name field.
5. Use the Browse button on the right of the Access Database
field to navigate to the database's location.
6. Select the RKL Trading.mdb database and click Open. The
Select Access database dialog box is closed.
7. Click Add in the Connection Info dialog box. The dialog box
closes and the data connection is displayed below the ODBC
Driver for Access connection type.

Exercise 2: Check the Connection to a Data Source
Check the connection is connected correctly to the data source. Use the
help topic Check/Test to guide you with this task.
Step-by-Step Solution:
Check the connection by doing the following:
1. Right-click on the connection: Exercises.
2. Select Check/Test. The Check/Test success dialog box is displayed as
shown in the figure below:

Next-->

Home > Tutorials > Connector Tutorial > Connecting to a Data Source > Using an Excel Workbook as a
Data Source

Using an Excel Workbook as a Data Source
In order to use an existing Excel Workbook as a data source for a report,
the data needs to be organised into named ranges.
1. To do this, open the workbook in Excel. The data should be stored with
accurate headings so that when expressions are added, the data remains
meaningful. Select the data required for report writing purposes by
highlighting.

2. Go to Formulas Tab.
3. Click Define Name.

4. Add a suitable Name and click OK.
5. This range will now be available for selection when you add new data
containers within the Connector module.
6. A new connection type has been added to the Connector for connecting
to Excel workbooks as source data via an ODBC connection. To add a
new data connection to an Excel workbook you will need to ensure that
you have a selected the applicable data in Excel and have named the
range prior to adding the connection within the Connector . Adding a
named range to an Excel workbook.

7. Click on the Add Icon
window.

which will display the Connection Info

8. Name the connection and specify the Excel workbook that you
will be accessing.
9. If the workbook has been protected you will need to add the
relevant user id and correct password. Click Add.
10. Test the connection by clicking the Check/Test button,
right clicking the mouse and selecting Check/Test.
Next-->

, or by

Home > Tutorials > Connector Tutorial > Connecting to a Data Source > Editing Data Connection
Properties

Editing Data Connection Properties

Overview
Once you have created a data connection, you are able to view the data
connection's details in the Property window. (The property window
displays the properties of any selected object).
You are also able to edit your connection properties in the property
window, by doing any of the following:
Change the connection properties
Rename a connection
Delete a connection
Move a connection
Complete the following editing exercises:

Exercise 1: Renaming a Connection
To make it easy for our report writers to recognize the data connection,
rename the connection to: Sage Accpac Intelligence Tutorial
Step by Step Solution:
1. Select the Data connection.
2. Edit the connection name in the Connection Name property field
and click Apply.

Exercise 2: Move a Connection
Move the Connection: Sage Accpac Intelligence Tutorial from
the ODBC driver for Access connection type to the ODBC
Driver for dBase connection type.
Check the connection. An error message is displayed as the
connection is located in the wrong ODBC driver.
Move it back to its original ODBC driver location.
Step-by-Step Solution:
1. Select the Data connection: Sage Accpac Intelligence Tutorial.
2. Right-click and select Move to.
3. Select the connection type: ODBC Driver for Dbase from the
displayed list and click OK.
4. Click OK. The data connection is moved to the ODBC Driver for
Dbase connection type.
5. Double-click on the ODBC Driver for Dbase to view the moved
data connection.
6. Right-click on the connection and select Check/Test. An error
message is displayed.
7. Select the Data connection: Sage Accpac Intelligence Tutorial.
8. Right-click and select move to.
9. Select the connection type: ODBC Driver for Access from the
displayed list and click OK.
Next-->
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Add a Data Container

Overview
In order to gain access to all the information in the DocumentHeader, we
need access to the DocumentHeader table. The following exercises take
you through this process.

What is a data container?
A data container is a published Table, View or Dataset (based on a join)
that can be used as the source of data for a report.

What type of data containers are there?
Database Table
A single database table
SQL Join
A join between two or more tables using SQL syntax
View or Query
A view or query that exists in the database
Graphical Join
A join between two or more tables using a graphical join tool

Exercise 1: Add a data container using a single table as the
source
Create a data container that adds the DocumentHeader table to
the Sage Accpac Intelligence Tutorial connection.
Sample this data container to ensure that it is returning the
correct data.
Use the help topics: Add Data Containers and Sample Data to assist
you with this task.
Step by Step Solution:
1. Right-click on the data connection Sage Accpac Intelligence
Tutorial.
2. Select Add data Containers.
3. Select Table and click OK.
4. Check DocumentHeader and click OK. The DocumentHeader
container is displayed under the data connection link.
5. Right-click on the DocumentHeader container and select Sample
Data. The sampled data from the DocumentHeader table is displayed
in a property window.
Tip: To view all data in the window, use the scrollbars to navigate.
6. Click the Close button in the Sample window. The Sample Data
window is closed.
Next-->
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Add a Graphical Join Data Container

Overview
From the sample data viewed in the previous exercise, you will notice
that the DocumentHeader table is unable to display the Customer name,
only the Custsupp ID. We need the customer name for the Excel report.
This exercise takes you through the process of creating a container that
joins two tables together. This enables you to access all the data in both
tables. We will use the Graphical Join tool to do this. Use the help topics:
Joining Tables to assist you with this task.

Exercise 1: Add a data container using the graphical join
tool
Create a new graphical join data container named Customer
Documents using the following details:
Data Connection: Sage Accpac Intelligence Tutorial
Container Name: Customer Documents
Tables: DocumentHeader and Customers
Join Key: CustSuppID(DocumentHeader)and the ID
(Customers)
Join Type: Inner Join
Check this data container is returning data by sampling the data.
Step by Step Solution:
1. Right-click on the Sage Accpac Intelligence Tutorial
Connection and select Add data containers. The Select the
Container Type dialog box is displayed.
2. Select the Graphical Join option then click OK.
3. Enter Customer Documents as the name of the container and
click OK.
4. Select the Customer Documents container.
5. In the property window click the Graphical Join button.
6. From the Choose Tables dialog box select the
DocumentHeader and Customers tables and click OK. The
tables appear in the in the Graphical Join Tool window.
7. Drag the CustSuppID field from the DocumentHeader table to
Customer table and drop it on the ID field. A graphical join line
appears as shown in the figure below.

8. Click the Apply button. The Graphical Join Tool window closes
and the SQL syntax appears in the Join SQL field.
Next-->

Home > Tutorials > Connector Tutorial > Add a Data Expression > Add Data Expressions to a Data
Container

Add Data Expressions to a Data Container

Overview
Adding data expressions to the data container is the final step in
completing the creation of a data connection. For our report we need
access to all the fields in the one table and only one in the other.

What is a data expression?
A data expression is the selection from a data container. A data
expression can be a:
Data Field
A single database field. For example, a field containing customer details
such as surname or initials.
SQL Expression
Returns data from a field or combination of fields based on a SQL
Expression.
Excel Formula
Returns data based on an Excel Function or formula.

Exercise One: Add data expressions to a container
Add all the fields available in the DocumentHeader table and only the
customer name from the Customers table. Sample the data to ensure
that the expressions are returning a result.
Use the help topics: Add Data Expression and Sample Data to assist
you with this task.
Step-by-Step Solution
1. Right-click on the data container Customer Documents.
2. Select Add Expressions. The Choose Publish Fields dialog
box is displayed.
3. Check all the expressions from the DocumentHeader and the
Name expression from the Customer Table.
4. Click OK. The data expressions are displayed below the data
container.
Next-->

Home > Tutorials > Connector Tutorial > Add a Data Expression > Editing Data Expression Properties

Editing Data Expression Properties

Overview
Like other elements in the object window, once a data expression is
selected it's properties are displayed on the right of the screen. Read
through the help topic: Data Expressions to familiarize yourself with the
nature of each data expression property.
You are also able to update and maintain your Data Expressions by
doing the following:
Rename an Expression
Copy an Expression
Delete an Expression

Exercise 1: Rename a data expression
Field names in databases are often difficult to interpret. Using userfriendly names enables you to understand the field's contents more
easily. For example we are unable to tell from the expression Name
whether the expression refers to a customer name or salesman name.
Changing the expression: Name to Customer Name makes the
expression less ambiguous.
Rename the following data expressions:
Current Name to New Name
Name to Customer Name
TotalTax to TotalVAT
CustSuppID to Customer Code
Step-by-Step Solution
1. Right-click on the data expression to be renamed.
2. Select Rename. The Rename dialog box is displayed.
3. Enter the new name and click OK. The new name is displayed.

Exercise 2: Copying and renaming data expressions
You are only able to create special expressions, for example, formulas
and SQL expressions from a copy of existing data expressions. An
existing expression is copied and changed to a special expression.
Copy the TotalVAT expression and paste it into the same data
container
Rename the new expression TotalVAT2
Step-by-Step Solution
1. Right-click the expression TotalVAT and select Copy.
2. Right-click on the data container: Customer Documents and
select Paste. The copy of the expression is pasted below the
container.
3. Right-click the expression and select Rename.
4. Enter the new name: TotalVAT2 in the Rename dialog box and
click OK.

Exercise 3: Deleting data expressions
Delete the following expressions:
ID
TotalVAT2
Step-by-Step Solution
1. Right-click on the expression.
2. Click Delete.
3. Click Yes to confirm the deletion.
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Creating a Custom Expression

Overview
There are times that a data field in the database does not provide the
data needed by the report writer. The Connector enables you to use
either SQL statements or Excel statements to create custom
expressions.
The current data expressions do not provide a combined sales and sales
tax value. For our report we require the combined totals of sales value
and sales tax. This can be achieved using an SQL expression. Complete
the exercise below to create this custom expression.
Exercise 1: Creating an SQL Expression
Follow the step-by-step guide to create a SQL expression that adds the
sales value and the sales tax value to create a combined total.
1. Ensure that the Customer Documents container is open.
2. Copy and paste the TotalExcl expression to the Customer
Documents container.
3. Rename the new expression TotalIncl.
4. In the Property window, select the Expression Type field and
change the expression type to SQL expression.
5. Click Apply. The SQL expression property window is displayed.
6. Highlight the contents of the Expression Source property and enter the
following expression: [DocumentHeader].[TotalExcl]+
[DocumentHeader].[TotalTax]
7. Click Apply.
8. Ensure the expression is correct by sampling the data. (Rightclick > Sample Data) The sample data screen displays the
combined total.
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Conclusion
Congratulations, you have successfully completed the Creating a Data
Connection process using the Connector . To see how your new data
connection is used in the Sage Accpac Intelligence Report Manager,
complete the Report Manager tutorial.

Home > Tutorials > Report Manager Tutorial > Welcome

Welcome to the Sage Accpac Intelligence Report
Manager Tutorial
Tutorial Overview
This tutorial is designed to take you on a interactive tour of the Report
Manager module. During this tour you will interact with and be exposed to
all the important functionality of our product. The tutorial uses the Sage
Accpac Intelligence sample database for the interactive exercises.

How do I use the tutorial?
This tutorial is divided into a number of interactive exercises. As you
complete one exercise use the next --> link at the bottom of the page to
advance to the next exercise. The sessions are linked together and
therefore must be done in order.
The tutorials are designed to be used in conjunction with the help system.
The purpose of completing the exercises using the help system is to
ensure that you will be able to use the help system effectively when using
the software.
To move between the tutorial, help file and the Sage Accpac Intelligence
software, use the keystroke Alt+Tab.

What do I need before I start?
You will need the following in order to run the tutorial successfully:
An installed and licensed version of Sage Accpac Intelligence .
Correctly installed version of Microsoft Excel 2003, 2007 or 2010.
Operating System: Windows XP, Windows Vista, Windows 7

What skills do I need to be able to do the tutorial?
Although you are able to complete the tutorial with only the most basic
computer skills, you will benefit most if you have the following skills:
Intermediate Windows navigation skills.
You should be familiar with using all the mouse functionality.
Familiar with database design methodology and database
terminology.
Next -->

Home > Tutorials > Report Manager Tutorial > Using the Help System

Using the Help System
In order to complete any task in the tutorial, you need to use the Sage
Accpac Intelligence help system. Follow the steps below to access the
help system.

Accessing the help system
1. Open the Sage Accpac Intelligence Connector .
2. On the Help menu, click Help. The Sage Accpac Intelligence
help system is displayed. (Shortcut = F1)

Locating a specific help topic
To locate a specific help topic, do one of the following:
Use the Contents window: Navigate to the relevant topic using
the Contents window.
Use the Search window: Enter a search criterion in the Search
window and click the List Topics button. Double click on a
displayed topic in the Selected topic window.
Next-->

Home > Tutorials > Report Manager Tutorial > Getting Started

Getting Started
To effectively complete the exercises you need a good grasp of the Sage
Accpac Intelligence interface and ways of performing tasks in the
software.

About the layout of the interface
The layout of the interface is uncomplicated. The software layout is
divided into two main areas:

1. Object Window: You are able to select objects using your mouse
from the object window in order to either view the objects
properties or perform a task with the object. For example, you are
able to select an object in the object window and rename the
object just as you would rename a file in Windows Explorer.
2. Property window: You are able to view and update the properties
of a selected object using the property window. For example, you
are able to add your own custom description of the object in
object's property window.

About ways of performing tasks in Sage Accpac
Intelligence
There are three methods of performing tasks in Sage Accpac Intelligence
:
1. Menu bar: Use your mouse to select a task from the menu bar
2. Toolbar: Use your mouse to select a task from the toolbar

3. Short-cut menu: By right-clicking an object in the object window, you
are able to display a short-cut menu of tasks that can be performed on
the selected object. This menu is useful for completing tasks quickly.

Working with Objects
To view an object's associated elements, double-click on the object. This
action is called drilling-down. To hide an object's associated elements,
double-click an open object. This action is called drilling-up.
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The Report Creation Process
The main purpose of the Report Manager is to create and maintain Sage
Accpac Intelligence reports linked to Excel. Creating a report is a five part
process:

Report Creation Process
1. Add a Folder
Folders contain all the reports related to a particular topic. For example,
all reports related to a particular financial year or reports related to the
stock of a company. You cannot create subfolders.
2. Add a Report
The report process is wizard driven and you are required to select a
container to create the report from.
Note: The data container is created in the Connector .
3. Set Output Properties
Output properties govern the type and manner in which your data is
displayed in Excel. For example, you are able to apply filters to restrict
the amount of data displayed or apply aggregate functions to summarize
the data.
4. Run the Report
The first time a report is created it is necessary to run the report and
then link it back to Sage Accpac Intelligence as an Excel template.
Subsequent report runs of the report will automatically use the allocated
template.
5. Link Excel
Once a report’s data has been exported to Excel it is necessary to link it
to Sage Accpac Intelligence as an Excel template. This process enables
you to create complex templates that will always have access to the
latest data at the reports run time.
The following exercises take you through these processes.
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Exercise 1 Creating and Linking a Basic Report
Overview
The following exercises will enable you to create a basic report and link
the subsequent Excel workbook back to Sage Accpac Intelligence as an
Excel template. As the company report writer for R.K.L Trading, you
have been requested to create a report that displays all the transactions
from the Customer Documents container created in the Connector
tutorial.
In this exercise you will complete the following tasks:
Add a folder
Add a report to a folder
Run the report
Link the report back to Sage Accpac Intelligence

Step 1: Add a folder
Read the help topic: Creating a Folder and then create a new folder
called Training.
Step-by-Step Solution:
Create the folder by doing the following:
1. Open the Report Manager.
2. Do one of the following:
Right-click on the Home object and select Add folder.
Click the Add folder icon on the toolbar
3. From the Add folder dialog box, enter the name of the folder.
4. Click OK. The folder is displayed below the Sage Accpac
Intelligence Home icon.

Step 2: Add a Report
Use the help topic Creating a Report to assist with the task. Add a new
report named Document History with the following details:
Container: Customer Documents
Parent Connection: Sage Accpac Intelligence Tutorial
Columns:
CustomerName
CustomerCode
Date
TotalExcl
TotalVat
TotalCost
DocNo
DocType
Description: This report provides all customer documents for the
RKL Trading.
Step-by-Step Solution:
Add a report, by doing the following:
1. Do one of the following:
Right-click on the new folder and select Add Report.
Click the Add Report icon.
2. From the Add Report dialog box, enter the name of the report.
3. Click OK. The Select Data Container dialog box is displayed.
4. Select the data container to be used as the source of the report
and click OK.

5. In the Choose Column Fields dialog box, check the columns to
be displayed and click OK. The report is displayed under the
specified folder.

Step 3: Run a Report
Run the Document History report located under the Training folder. Use
the help topic: Running a Report to assist with task. Read the help topic:
How Excel Renders Data to gain an understanding of the processes
that are performed when data is rendered to Excel.
Step-by-Step Solution: Run a report
To run the report, do the following:
1. Select the Document History report in the object window.
2. Click the Run button. The report creation process commences
and the progress and process monitors are displayed. The report
results are displayed in Excel.

Step 4: Link a Report
Link the Excel workbook generated from the Document History report to
Sage Accpac Intelligence . Leave the name of the template as
Document History.xlt. Read the help topic Create and Link Excel
Templates to assist you with this task.
Step-by-Step Solution: Linking the report
To link the Excel workbook to the report in the Sage Accpac Intelligence
Report Manager do the following:
1. Leave the workbook open in Excel and activate the Sage Accpac
Intelligence Report Manager.
2. In the Report Manager, ensure that the Document History report
is selected.
3. Click the Create and Link template icon on the toolbar. The
Select a workbook to convert to a Template dialog box is
displayed.
4. Select the workbook and click OK.
5. In the Specify Template Name dialog box enter the name of the
template and click OK. The template is saved to the template
folder.
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Editing Report Properties
Overview
Once you have created a report, you are able to view the report's details
in the Property window. You are also able to edit your report's properties
in the Property window, by doing any of the following:
Edit the report name
Edit the report description
Add/remove columns from the report
Change the position of the columns

Exercise 1: Edit the report name
Use the help topic Edit Report Properties to assist with the task:
Change the name of the Document History report to Customer
Document History report.
Step by Step Solution:
1. Select the Document History report.
2. In the property window, highlight the current report name.
3. Enter the new name and click Apply. You are prompted to select
an option for the template.
4. Leave the selected choice unchanged and click OK. The new
report name is saved.

Exercise 2: Edit the report description
Update the report description to reflect the following: Customer
Document totals for current and previous year.
Step by Step Solution:
1. Select the report name.
2. In the property window, enter the description in the Description
field and click Apply.

Exercise 3: Edit the columns in the report
Use the help topic Add or Remove Columns and Change order of
Columns to assist with the task.
1. Remove the following column: TotalCost
2. Add the following column to the report: TotalIncl
3. Arrange the columns as follows:
CustomerCode
CustomerName
DocType
DocNo
Date
TotalExcl
TotalVAT
TotalIncl
Step-by-Step Solution: Edit the report:
Remove a column:
1. Select the report in the Object window. The reports properties
are displayed.
2. Click the Column tab.
3. Select the column to be deleted.
Note: To select multiple columns use the Ctrl key.
4. Click the Remove button. The selected columns are deleted.
Add Columns to a report:
1. Select the report in the Object window. The report’s properties
are displayed.

2. Click the Column tab.
3. Click the Add button.
4. Check the columns to be added in the Choose Column Fields
dialog box.
5. Click Ok. The columns are added to the report.
Rearrange the order of the columns:
1. Select the report in the Object window. The report’s properties
are displayed.
2. Click the Column tab.
3. Select the column you want to rearrange and use the Move Up
and Move Down buttons to move the field to the new location.

This concludes the section on editing report properties. The next section
will deal with advanced report settings.
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Adjusting the Output with Advanced Options
Overview
Once a report has been created the output can be adjusted by using the
following options:
Filters Filters enable you to refine or limit the rows of data that
will be displayed in the report by setting criteria.
Sort
You are able to set the sort order of your data prior to it being
exported to Excel.
Parameters
Parameters enable you to refine or limit the rows of data, but
unlike filters, the criteria are set at run time.
Aggregate Functions
Aggregate functions enable you to summarise data using one of
a number of functions, for example Sum or Average, prior to the
data being rendered to Excel.
Aggregate filters
Aggregate filters enable you to refine or limit rows of data based
on aggregation criteria. For example, you may only want to view
values of a particular field if they are greater than the average of
the field.

Exercises Overview
The following exercises will show you how to use these options when
creating reports.
Filter Exercise
Parameter Exercise
Aggregate Function Exercise
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Advanced Options - Filter Exercise
Filter Exercise
You have been requested to create a report that reflects the data for all
current year documents. The current year is identified as a positive value
in the Period field. Use the Add and Remove filters help file to assist
you with this task.

Step 1: Create a copy of a report:
Make a copy of the Customer Documents History report and rename it
Customer Documents History - Current Year
Step by Step Solution
1. Right-click on the Customer Documents History report and
click Copy.
2. Right click on the Training folder and click Paste.
3. Right-click on the new report and click Rename. (shortcut key –
F2)
4. Enter the name Customer Documents History - Current Year
in the Rename dialog box and click on OK. The report is
renamed.

Step 2: Set the Filter
Set a filter on the new report with the following details:
Field: Period
Comparison Method: Greater than or Equal To
Value: 1
Step by Step Solution
1. Select the report.
2. Click the Filter tab.
3. Click the Add button on the right of the property window.
4. From the Choose a Filter Field dialog box, click Period then
click OK.
5. From the Choose Comparison Method dialog box, click
Greater than or Equal to then click OK.
6. Enter 1 in the Comparison Value dialog box then click OK. The
filter is displayed in the Filter window.

Step 3: Run the report
Run the report.
Step by Step Solution
1. Click the Run button. The data is exported to Excel.
2. Compare the output to the figure below to ensure that it is
correct.

Step 4: Link the Excel report back to Sage Accpac
Intelligence
Link the Excel report back to Sage Accpac Intelligence .
Step by Step Solution
1. Select the Customer Documents History - Current Year
report in the Report Manager.
2. Click the Create and Link button.
3. Select the Excel workbook containing the rendered data and click
OK. The Replace dialog box is displayed.
Note: As the report is a copy of a previously created report, you
will need to either replace the existing template or create a new
template based on the previous template.
4. Leave the default name unchanged and click OK. The Excel
workbook is converted to a template and linked to the report.
5. Ensure the Report Manager is active for the next exercise.
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Advanced Options - Parameter Exercise
Parameter Exercise
A user has requested reports that fall between specified dates. You are
required to set the report dates when you run the reports. Complete the
following steps to create a report that enables you to set the dates at run
time using two date parameters.

Step 1: Copy the report and remove the filter
Create a copy of the previous report and do the following:
Rename the report: Customer Documents History Parameters
Remove the filter from the report
Step by Step Solution
1. Right-click on the Customer Documents History - Current Year
report and click Copy.
2. Right click on the Training folder and click Paste.
3. Right-click on the new report and click Rename. (shortcut key –
F2)
4. Enter the name Customer Documents History with Parameters in the
Rename dialog box and click on OK. A dialogue box presents template
options as shown in the figure below.

5. Leave the default option selected and click OK. A copy of the
report is created and displayed the training folder.
6. Click the Filter tab on the Property window.
7. Select the Period filter and click Remove.
8. Click OK to confirm the deletion. The filter is removed from the
report.

Step 2: Set the parameters
Set the following parameters for the report:
First Parameter
Filter Field: Date
Operator Name: Greater than or Equal to
Comparator/default option: (blank)
Second parameter
Filter Field: Date
Operator Name: Less than or Equal to
Comparator/default option: (blank)
Step by Step Solution
1. Select the report.
2. Click the Parameter tab.
3. Click the Add button on the right of the property window.
4. From the Choose a Filter Field dialog box, click Date then click
OK.
5. From the Choose Comparison Method dialog box, click
Greater than or Equal to then click OK.
6. Leave the Comparison Value value blank (this value will be set
at run time) then click OK. The parameter is displayed in the
Parameter window.
7. To set the second parameter, click the Add button again on the
right of the property window.
8. From the Choose a Filter Field dialog box, click Date then click
OK.
9. From the Choose Comparison Method dialog box, click Less

than or Equal to then click OK.
10. Leave the Comparison Value value blank (this value will be set
at run time) then click OK. The parameter is displayed in the
Parameter window.

Step 3: Run the report
Run the report setting the parameters to reflect the month of April 2003
(01/04/2003 – 30/04/2003). Check the output result against the diagram
below.
Step-by-Step Solution
1. Click the Run button. The Parameter dialog box prompts you for
the dates.
2. Click the Browse button and Enter the following dates:
Greater than or Equal to: 01/04/2003
Less than or Equal to: 30/04/2003
3. Click OK. The data is exported to Excel.
4. Compare the output to the figure below to ensure that it is correct.
Note:The dates must reflect only transactions between 01/04/2003 and
30/04/2003.

Step 4: Link the Excel report back to Sage Accpac
Intelligence
Link the resulting workbook to the Report Manager as a template.
Step-by-Step Solution
1. Select the Customer Documents History with parameters
report in the Report Manger.
2. Click the Create and Link button.
3. Select the Customer Documents History with parameters1
book and click OK. The Specify a Template name dialog box is
displayed.
4. Leave the default name unchanged and click OK. The Excel
workbook is converted to a template and linked to the report.
5. Ensure the Report Manager is active for the next exercise.
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Advanced Options - Aggregate Function
Exercise
Aggregate Functions
You have been asked to summarize the sales for the company by
Customer per Period for the current year. This will require the use of an
Aggregate function. Complete the following steps to create a report that
enables you to summarize the data prior to it being rendered to Excel.

Step 1: Create a new report
Use the Help File Edit Column Properties. Create a new report with an
aggregate function using the following details:
Folder: Training
Report Name: RKL Sales Summary by Customer
Data Container: Customer Documents
Place the following fields in the report
Customer Code
Customer Name
Period
TotalExcl
Step by Step Solution:
1. Select the Training folder and click the Add Report button on
the toolbar.
2. Enter the name of the report in the Report Name dialog box.
3. Select the Customer Document container from the Select
Container dialog box.
4. Select the fields listed above and click OK. The report is
displayed under the Training folder.
5. Click the Filter tab.
6. Click Add. The Choose Field dialog box is displayed.
7. Select Period and click OK.
8. Select Greater than or equal to and click OK.
9. Enter 1 in the Comparison value dialog box and click OK.

Step 2: Set the Aggregate Filter
Set the following aggregate function to the report:
TotalExcl aggregate function is set as Sum
Step by Step Solution:
1. Ensure that the report is selected.
2. Click the Columns tab.
3. Right-click on the TotalExcl column and select Properties.
4. In the Properties dialog box, click the Aggregate Function
drop-down list and select Sum.
5. Click OK. The Sum aggregate function is displayed to the right of
the TotalExcl field in the Column tab.

Step 3: Run the report
Run the report
1. Run the report. The summarised data is rendered to Excel.
Step by Step Solution
1. Click the Run button. The data is exported to Excel.
2. Compare the output to the figure to ensure that it is correct.

Step 4: Link the Excel report back to Sage Accpac
Intelligence
Link the Excel report back to Sage Accpac Intelligence .
Step by Step Solution
1. Select the RKL Sales Summary by Customer report in the
Report Manager.
2. Click the Create and Link button.
3. Select the Excel workbook that contains the report and click
OK. The Specify a Template name dialog box is displayed.
4. Leave the default name unchanged and click OK. The Excel
workbook is converted to a template and linked to the report.
5. Ensure the Report Manager is active for the next exercise.
This concludes the section on Advanced Settings. The next section takes
you through the process of creating advanced reports.
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Union Reports - Part 1 Create the base reports
Step 1 Create the first base report
Create the first report using the details listed below:
Report Name: RKL Sales (YTD)
Folder: Training
Data Container: Customer Documents
Columns:
Customer Code
Customer Name
Period
TotalExcl
Filter 1:
Column: Period
Comparison function: Greater than or Equal to
Value: 1
Filter 2:
Column: doctype
Comparison function: Is In
Value: CRN, INV
Note: Run the report and ensure that the report is working correctly.
Step-by-Step Solution
1. Right-click on the Training folder and select Add Report.
2. Enter the report name: RKL Sales (YTD) in Name Report dialog
box.

3. Select the Customer Documents container from the Add
Container dialog box and click OK.
4. Add the following columns:
Customer Code
Customer Name
Period
TotalExcl
5. To set the first filter, click the Filter tab.
6. Click the Add button on the right of the property window.
7. From the Choose a Filter Field dialog box, click Period then
click OK.
8. From the Choose Comparison Method dialog box, click
Greater than or Equal to then click OK.
9. Enter 1 in the Comparison Value dialog box then click OK. The
filter is displayed in the Filter window.
10. To set the second filter, click the Add button in the Filter window.
11. From the Choose a Filter Field dialog box, click doctype then
click OK.
12. From the Choose Comparison Method dialog box, click Is In
then click OK.
13. Enter CRN, INV in the Comparison Value dialog box then click
OK. The filter is displayed in the Filter window.
14. Click OK. The report is displayed below the Training folder.
15. Run the report to ensure that it displays the correct data as
shown in the diagram below:

Step 2 Create the second base report
Create the second report using the details listed below:
Report Name: RKL Outstanding Orders (YTD)
Folder: Training
Data Container: Customer Documents
Columns:
Customer Code
Customer Name
Period
TotalExcl
Filter 1:
Column: Period
Comparison function: Greater than or Equal to
Value: 1
Filter 2:
Column: doctype
Comparison function: equal
Value: SO
Note: Run the report and ensure that the report is working correctly.
Step-by-Step Solution
1. Right-click on the Training folder and select Add Report.
2. Enter the report name: RKL Outstanding Orders (YTD) in
Name Report dialog box.
3. Select the Customer Documents container from the Add

Container dialog box and click OK.
4. Add the following columns:
Customer Code
Customer Name
Period
TotalExcl
5. To set the first filter, click the Filter tab.
6. Click the Add button on the right of the property window.
7. From the Choose a Filter Field dialog box, click Period then
click OK.
8. From the Choose Comparison Method dialog box, click
Greater than or Equal to then click OK.
9. Enter 1 in the Comparison Value dialog box then click OK. The
filter is displayed in the Filter window.
10. To set the second filter, click the Add button in the Filter window.
11. From the Choose a Filter Field dialog box, click doctype then
click OK.
12. From the Choose Comparison Method dialog box, click Is
Equal to then click OK.
13. Enter SO in the Comparison Value dialog box then click OK.
The filter is displayed in the Filter window.
14. Click OK. The report is displayed below the Training folder.
15. Run the report to ensure that it displays the correct data as
shown in the diagram below:
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Union Reports - Part 2 Creating the Union
Report
Create the union report using the details listed below:
Report Name: YTD RKL Sales and Outstanding Orders
Reports to be used in the union report:
RKL Sales (YTD)
RKL Outstanding Orders (YTD)
Note: Run the report and ensure that the report is displaying the correct
data. The union report's results displayed must be a combination of the
two base reports created in Part 1 of the exercise.
Step-by-Step Solution
1. Select the Training folder.
2. Right-click the Training folder and select Add Union Report.
3. Enter YTD RKL Sales and Outstanding Orders in the Name
Union Report dialog box.
4. Select RKL Sales (YTD) and RKL Outstanding Orders (YTD)
from the Select Reports dialog box. The union report is
displayed below the Training folder.
5. Double-click on the YTD RKL Sales and Outstanding Orders
report to display Union Sub Report entity.
6. Double-click on the Union Sub Report entity to display Union
Sub Report links.
7. Click RKL Sales (YTD) link and in the property window enter 1 in
the Output Sheet Number (Left to Right) field, then click Apply.
8. Click the RKL Outstanding Orders (YTD) link and in the
property window enter 2 in the Output Sheet Number (Left to
Right) field, then click Apply.

9. Click the YTD RKL Sales and Outstanding Orders report then
click Run. Ensure that it is displaying the correct data as shown
in the diagram below:

Note: The diagram above shows both sheets in a single window to
enable you to view both results simultaneously. In your report, you will
view the results in two separate worksheets.
This concludes the exercises on the advanced reports. The next section
takes you through managing of reports.
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Sub-Query Reports
Sub-Query Reports Scenario
You have been asked to create a report to list all sales invoices,
excluding those where a credit note has been raised, for the six months
from July to December 2003. You want to include the Customer's name.
Creating a sub-query report is a two part process:
Part 1: Create a sub-query report whose output will be used as
the criteria in a subsequent report. In this scenario, a list of order
numbers where the DocType is equal to CRN.
Part 2: Use the sub-query report's results as the basis of a filter
in a new report.
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Part 1: Creating a Sub-Query Report
Step 1: Create the Sub-query report
Use the Sub-Query Reports Help file to assist you with this task. Create
the following sub-query report:
Report Name: Sub-Query - Credit Notes
Source Container: Customer Documents
Display Field: OrderNo
Step-by-Step Solution
1. Right-click the Training folder and select Add Sub Query
Report option.
2. Enter the name: Sub-Query - Credit Notes for the report in the
Enter a Name dialog box and click OK.
3. Select the CustomerDocuments container from the Select a
Data Container dialog box.
4. Select Doctype from the Display Name dialog box. The subquery is displayed under the Training folder.

Step 2: Set the Filter
Set a filter with the following parameters:
Filter:DocType is equal to CRN
Step-by-Step Solution:
1. Select the Sub-Query Report and click the Filter tab.
2. Click the Add button.
3. Select the DOCTYPE field from the Choose a Field Filter dialog
box.
4. Select the Equal to operator from the Comparison Method
dialog box.
5. Enter CRN in the Comparison Value dialog box and click OK.
The filter is displayed in the Filter tab.

Step 3: Run the sub-query report
Run the report to ensure that the results of the sub-query are correct.
Step-by-Step Solution:
1. Select the Sub-Query Report and click the Run button. The report is
run and the results are displayed in Excel.
Ensure the data displayed in the Excel workbook is correct, then close
the workbook without saving any changes.
2. Note: This sub-query report will be used in the next exercise.
<--Back Next-->

Home > Tutorials > Report Manager Tutorial > Creating Advanced Reports > Creating Sub-Query Reports
> Creating advanced reports: Sub query part 2

Part 2: Using the Sub-Query Report as a Filter
Use the Sub-query Report as the basis of a filter in a report.

Step 1: Set the Sub-query Filter
To use the sub-query created in the exercise above, set it as a filter in a
report. Create a new report called Customer Invoice List using the
following details.
Report Name: Customer Invoice List
Container: CustomerDocuments
Columns: CustomerCode, CustomerName, Date, DocNo,
DueDate, OrderNo, TotalExcl
Filter:
DocType Equal to INV and
DocNo Is Not In Sub-Query: Sub Query - Credit Notes
Parameters:
Date Greater than or Equal to 01 July 2003
Date Less than or Equal to 31 December 2003.
Step-by-Step Solution
1. Right click on the Training folder and click Add Report.
2. Enter the name: Customer Invoice List and click OK.
3. Select the data container: CustomerDocuments.
4. Select the columns listed above and click OK. The Report is
displayed below the Training Folder.
5. Select the Filter tab.
6. Click the Add button and add the DocType filter to the report,
using the filter details listed above.
7. Click Add. The Filter field dialog box is displayed.
8. Select the DocNo field as the filter field.

9. Select Is Not In Sub Query from the Comparison Operator
dialog box.A list of sub query reports are displayed.
10. Select Sub Query - Credit Notes from the list displayed. Then
click Ok.
11. Click the Parameter tab.
12. Click Add and complete the parameters using the details listed above
then click OK.
Note:Ensure both parameters are included.

Step 2: Run the Report
Run the report.
Step-by-Step Solution:
1. Select the Customer Invoice List and click the Run button. The
report is run and the results are displayed in Excel as shown in
the figure below:

Step 3: Link the Excel report back to Sage Accpac
Intelligence
Link the Excel report back to Sage Accpac Intelligence .
Step by Step Solution
1. Select the Customer Invoice List report in the Report Manager.
2. Click the Create and Link button.
3. Select the Excel workbook that contains the report and click
OK. The Specify a Template name dialog box is displayed.
4. Leave the default name unchanged and click OK. The Excel
workbook is converted to a template and linked to the report.
5. Ensure the Report Manager is active for the next exercise.
This completes the section on sub-query reports. The next section deals
with union reports.
Next-->

Home > Tutorials > Report Manager Tutorial > Managing Reports > Managing Reports

Managing Reports
Overview
Creating and linking your reports are the core functions of the Report
Manager. Around these core functions are a number of functions to
facilitate managing your reports. This section will familiarize you with
these functions.
The management functions are:
Delete a Report
You are able to delete reports that are no longer needed or have become
obsolete. You have the choice when deleting the report of deleting the
associated template. This should only be done if you are sure that the
template is of no value and is not being used by other reports.
Link and Un-link Templates
You are able to un-link an associated template from a report. This is
necessary if you want to link a different template to the report.
Lock a Report
You are able to lock a completed report. This ensures that there are no
changes made to the structure of the report.
Help File: Locking/Unlocking a report
Export and Importing Reports
You are able to export reports from Sage Accpac Intelligence . These
reports can be imported into other Sage Accpac Intelligence systems.
Help File: Exporting a Report; Importing a Report
Schedule a report run
You are able to schedule a report to run by adding the Sage Accpac
Intelligence schedule command line to a 3rd part Scheduler program.
Help File: Scheduling a Report
Next-->

Home > Tutorials > Report Manager Tutorial > Conclusion

End of the Report Manager Tutorial
Congratulations, you have successfully completed the Report Manager
tutorial. Contact us for enquiries about further training and to provide
feedback.

Modules
Sage Accpac Intelligence can give users an open view of their data
across several platforms and consists of user friendly modules:
The Connector Interface provides the facility to connect to all ODBC
compliant data sources e.g. SQL Server, Oracle, Access, Btrieve
(Pervasive) using a windows explorer look and feel, for simple
administration of all data connections.
The Report Manager Interface which provides access to the data as
defined in the Connector’s tool and empowers the user to customise
their reports for Microsoft Excel.
The Report Viewer: Report layouts in Excel may be changed on the fly
for viewing once reports have been executed, but the source reports
cannot be changed using this license type.
The Security Manager defines security for reports and users.
The License Manager manages module licensing.

Home > Connector > Getting Started > Creating a MetaData Set

Creating a Metadata Set
Sage Accpac Intelligence uses Metadata to describe an organizations
useful data. Metadata is often referred to as Data which describes Data.
Typically a Metadata set will provide a user friendly view onto a set of
technically obscure data. It allows Data to be more easily available to non
technical users or to users who have no knowledge of the underlying
source data system. A good Metadata set should describe a data set in a
manner which is consistent and easy to understand. Where data comes
from different sources, and systems with inconsistent naming
conventions, the MetaData can achieve a consistent facade allowing the
user to be unconcerned with the source and source type of any given
data.
Sage Accpac Intelligence allows a System Administrator to perform a
Metadata mapping exercise once which then benefits all end users. The
Connector is used to perform this mapping exercise. In addition to
mapping the Metadata the exercise should also involve some
configuration to optimize the way in which data is accessed by Sage
Accpac Intelligence.
Creating a MetaData set:
1. Create and Test a Data Connection.
2. Publish Data Containers and Data Expressions giving them
meaningful names.
3. Configure the Data Expressions so that the Data is accessed in a
sensible manner.
Once a good Metadata set is published the users of the Report Manager
Interface will be able to easily access the data.
The Connector allows the System Administrator to rename the technical
expression names normally contained in databases. By renaming the
expressions, the System Administrator creates a metadata set that is
user friendly and which allows the user to clearly identify the relevant
fields for reporting when using the Report Manager Interface.

Home > Connector > Getting Started > What is the Connector Tool ?

What is the Connector Tool ?
The Connector allows an organization's System Administrator to make a
connection to their database so as to access the relevant tables for
reporting purposes. It also allows an organization's System Administrator
to configure the metadata so as to empower the users to create their own
reports. The Connector will typically be used by an organization's System
Administrator or the relevant technically skilled person.

To use the functions of the Connector, you will first need to select an
object (i.e. a Data Connection, Data Container or Data Expression) in the
Object window.
When you have selected an object in the Object window, you can edit the

properties of your chosen object by using the Properties fields provided in
the Properties window.

To save any changes you make to the properties of your chosen object,
you must click the Apply button.
The Connector also includes a standard windows Menu bar and a
Connector Toolbar to simplify the use of the Sage Accpac Intelligence
software functionality.

Home > Connector > Getting Started > The Toolbar

Connector Toolbar
The Connector toolbar has various icons which perform several functions
as follows:
Icon Function

Description

Add

Enables the user to add a Data
Connection, Data Container or a Data
Expression.

Enables the user to delete their
selection.
Properties Displays context specific
Properties
field properties.
Refreshes on screen properties of the
Refresh
selected object.
Copies the selected object to the
Copy
clipboard.
Pastes an object from the clipboard
Paste
into the selected object.
Move To
Moves a connection or a container.
Checks that the selected object will
Check/Test
function correctly.
Takes a 50 row sample from the
Sample
selected Source Data Container and
Data
displays this data on the SAI Data
Screen.
Apply
Applies a supplied Metadata Hot fix or
Metabase
Service Pack.
Update
Import
Enables the import of reports into your
report
system.
Help
Launches the Help Files.
Delete

Home > Connector > Data Connections > Data Connection

Data Connection
A Data Connection holds the relevant connection information to connect
to a supported ODBC or OLEDB compliant Data Source. This Data
Connection object is then used for all connections to this Data Source. By
adding a Data Connection the System Administrator can make data
available from this Data Source.
To display the properties of your Data Connection, select a Data
Connection and on the Toolbar, click the Properties button .
The Data Connection Properties window will appear.

To Hide/Unhide advanced properties check/uncheck the Show Advanced
option
.
Property

Description

Connection A Technical Key Value used to identify the Data

ID

Connection.

Connection Value used to associate the Data Connection
Type ID
with a Connection Type
The Auto Connection System is a system used
to automate a connection to a data source at
report execution time. This system allows the
Use Auto
database connection properties for reports to
Connection
be set at execution time and not to be hard
System
wired into the Connection in the Connector.
See Auto Connection System for further
details.
Connection The name assigned by the Administrator for
Name
the Data Connection
The user ID that will be used to gain a
User ID
connection to the underlying Data Source.
The Password that will be used to gain a
Password
connection to the underlying Data Source
Forces the full Date and Time values to be
passed to the underlying database system. If
this option is not selected the Date Format (to
Use Time
pass to Driver) will be enabled and the format
with Dates specified will be used, otherwise the Date Time
Format (to pass to Driver) will be enabled and
the format specified will used. See Connection
Date Time Formats for further information.
The Date format that the underlying Database
System expects Dates to be presented in. This
is the format that Sage Accpac Intelligence will
convert dates to, before passing them to the
underlying system. This needs to be correctly
configured in order for Filters and Parameters
Date
Format (to to work correctly with dates in the Report
Manager Interface. It is not the Date that a user
pass to
of the Report Manager has to use. For a full list
Driver)
of the expected Date Formats for supported

Connection Types please check Connection
Date Formats for further information. This is
only available when Use Time with Dates is not
selected.

Date Time
Format (to
pass to
Driver)

Date/Time
Delimiter

The Date Time format that the underlying
Database System expects Dates/ Times to be
presented in. This is the format that Sage
Accpac Intelligence will convert dates to before
passing them to the underlying system. This
needs to be correctly configured in order for
Filters and Parameters to work correctly with
dates in the Report Manager Interface. It is not
the Date that a user of the Report Manager has
to use. This is only available when Use Time
with Dates is selected. See Connection Date
Time Formats for further information.
This is the Date Delimiter that the Connection
expects dates to be prefixed and suffixed with.
This needs to be correctly configured in order
for Filters and Parameters to work correctly
with dates in the Report Manager Interface.
Most systems use a single quotation mark (')
for this while some use a hash (#) symbol.

Connection
Sets the type of the Data Connection
Type

Home > Connector > Data Connections > Add a Data Connection

Add a Data Connection
A Data Connection holds the relevant connection information to connect
to a supported ODBC or OLEDB compliant Data Source. This Data
Connection object is then used for all connections to this Data Source. By
Adding a Data Connection the Connector can make data available from
this Data Source.
To add a new Data Connection, double click on and select the relevant
Connection Type (driver) to use for the Connection by clicking on it in the
object window, for example, select .

Add a Data Connection:
1. On the Toolbar, click the Add button

. The Connection Info

dialog box appears

2. In the Connection Name box type the name of your connection.
Note: Depending on the Connection Type of the Connection
being created, certain values will need to be entered to specify
how the data is accessed (some connection types will allow you
to browse for data using the buttons to the right of the text
boxes). Where paths or folder names are required for creating a
Data Connection always use the Universal Naming Convention
as opposed to using drive mappings. For example
\\Servername\c\mydata\ as opposed to X:\mydata where X is a
mapped drive to \\Servername\c\. This will ensure that reports
against this Data Connection can be run from any workstation
regardless of drive mappings.
3. In the Server box, browse to or add your server name.
4. in the Database Name box, enter the name of your SQL
Database.
5. In the User id: box type your User Id: if you have security
settings on the data folder.
6. In the Password box type your password for the above entered

User Id.
7. Click on Add. The new Connection should now appear in the
Object window.
8. To test the Connection, on the Toolbar, click the Check/Test
button.

Home > Connector > Data Connections > Auto Connection System

Using the Auto Connection System
In order for Sage Accpac Intelligence to communicate via ODBC to any
database, these values need to be resolved:
Server Name
Database Name
User ID
Password
The Auto Connection System in Sage Accpac Intelligence is used to
automate a Connection between a data server and data source at report
execution time.
The Auto Connection System takes care of the above values by passing
all these critical values during the company log on process to Sage
Accpac Intelligence. Especially if more than one server (Database Host)
and database exists on the network, this feature proves very helpful to
automate seamless integration to automatically use the relevant logged
in server and company.

Notice the following four field variables values of the Connection
Properties:

Server: @AUTO_CONN_SERVER@
The @ signs indicates that upon report runtime some variable value is
expected to be supplied. In the case of the above string it’s the
appropriate MySQL Server name to access the data.
Therefore the relevant MySQL server PC’s name will be automatically
supplied by the Auto Connection System.
Database Name: @AUTO_CONN_CATALOG@
The above string indicates the expected value to be supplied by the
Auto Connection System upon report runtime of any report is the
relevant Database Folder.
Therefore the specific currently opened company’s equivalent Database
Folder will be supplied by the Auto Connection System.
User ID: @AUTO_CONN_USER@
This string indicates that the MySQL server’s User ID field that is
logged into Sage Accpac Intelligence would be automatically supplied
by the Auto Connection System.
Password: @AUTO_CONN_PASSWORD@
This string indicates the MySQL’s password that Sage Accpac
Intelligence is using that would be automatically supplied by the Auto
Connection System upon report runtime.

Automatic Query and Response Dynamics
All Sage Accpac Intelligence reports that are run, are passed the Auto
Connection Properties (automatic query prompt running in the back
ground) for the 4 mentioned variables to be specified first before data can
be extracted from the database.
In response the relevant 4 variables values are supplied in accordance
with the specific company opened and the relevant MySQL Server PC
name.

Home > Connector > Data Containers > Data Container

Data Container
A Data Container is simply a set of Data which is made available
(published) by the Connector which will allow users access to the data
using the Report Manager Interface. The source of this data can be either
a Database Table, View, Stored Procedure or a custom Join based on
two or more Tables/Views.
To display the properties of your Data Container, select a Data Container
and on the Toolbar click the Properties button .
The Data Container properties window will appear.

Property

Description

Container ID

A Technical Key Value used to identify the Data
Container

Published

The name assigned by the System Administrator for

Container
Name

the Data Container

Description

A description for the Data Container
A Technical Key Field for the Data Connection to
which the Data Container is assigned
The name of the underlying Source Data Structure
(TABLE, VIEW or STORED PROCEDURE) or a
supported SQL JOIN to define a set of Data. Note
that selection for the Source Container Type
property must reflect what is held in this Source
Container property
This is used to specify how the underlying source
data is held. Set this to TABLE if it is simply a single
data structure (most common), to a VIEW if it is a
virtual table based on a query and to a JOIN if it is a
logical combination of data from two ore more tables
defined using a SQL join.
Allows a threshold to be set for the amount of time
that Sage Accpac Intelligence will spend attempting
to query the Data Container.

Connection ID

Source
Container

Source
Container Type

Timeout
Enquiries After
(Seconds)

Set this to 0 for Sage Accpac Intelligence to
wait indefinitely for execution to complete.
Set this to -1 for Sage Accpac Intelligence
to use the defaults settings of the
underlying database system.
Note that this setting may have no effect for certain
underlying Database systems.
For more information on troubleshooting Timeouts
see Timeouts

Container
Licensed To

Sets the Company that has been authorised to
import reports that use this container. If this property
is left blank then anyone can import and use the
Container. See Container Protection for further
information.

Container
Owned By

Sets the Company that is the owner of the original
Container and all those created on import to other
systems. See Container Protection for further
information.

In Addition to these container properties you can also view a list of
reports that have been created from this container. Right Click on the
container and choose Show Dependencies.
The following screen will display, listing the reports that are dependent on
this container.

Home > Connector > Data Containers > GoTo Container

GoTo Container
The Data Container that a report is running from can be viewed from
within the Report Manager module. This makes it easier to identify the
source container to which tables or expressions must be added should
the reports running from this container need updating.
Step by step process:
1. Double click the report.
2. Double click Source container.
3. Right click the report.
4. Click Goto Container in Connector Tool.

5. The following dialog box will appear asking if you would like to
open another instance of the Connector.

6. Click Yes.
7. Your container that the selected report is running from will now be
selected in the Connector.

Home > Connector > Data Containers > Add Data Containers

Add Data Containers
A Data Container is simply a set of data which is made available
(published) by the Connector which will allow users access to the data
using the Report Manager Interface.
The source of this data can be either a Database Table, SQL Join, View,
Graphical Join, Stored Procedure, or a SQL Query. Once you have
configured your new Data Connection you will need to select your data
containers which contain your source data.
Add a Data Container:
1. Open the Connector.
2. Select a Data Connection : Sage Accpac (Auto Connect)

3. On the Toolbar, click

.

4. The Select the Container Type dialogue box appears

.
5. Click OK to accept the default container type, which is Table,
allowing you to add single containers.
6. The Publish Data dialog box appears

.
7. Select the tables that you want to report on and click OK. The
new Data Container(s) should now appear in the Object Window.

8. Note: You can choose Table to add a container and then change
the Container Type afterwards to a Join or a Graphical Join if you
later decide to join this table to other tables. See Joining Tables
for more information.
To check that your chosen Data Containers are working and accessible,
select the Data Container in the Object Window and on the Toolbar, click
the Check/Test
button which checks that the selected object will
function correctly.

Home > Connector > Data Containers > Joining Tables

Joining Tables
Using the Sage Accpac Intelligence Connector, Data is made available
through the addition of Data Containers and relevant Expressions. The
source of the underlying data can be a Table, a View, a Stored Procedure
or a user defined SQL Join or a Graphical Join. To create a Container
based on a SQL Join, the System Administrator should add a data
container, selecting the option “SQL Join” from the Select Container Type
window and providing a name for the container. Then, before adding
Expressions, you would type in the join syntax in the Source Container
(Join) field. The Source should thus be the FROM clause (excluding the
FROM keyword) of a SQL query that would define the join. The syntax of
the Join can be verified by using the Check/Test facility for the Container.
When the SQL join is verified to be correct, the Administrator can choose
to Add Expressions. The expression list will then include all Fields from
all the Tables in the Join. There are two main SQL Join styles that are
used by Database Systems. For some systems either will work while for
others only one of the methods might work. It is recommended where
possible to use Syntax 2 (the newer ANSI style Join).
Join Syntax 1
TABLE1, TABLE2, TABLE3
WHERE TABLE1.KEYFIELD = TABLE2.KEYFIELD
AND TABLE2.KEYFIELD_2 = TABLE3.KEYFIELD

e.g.
timesheet, employee, department
WHERE timesheet.employee_id = employee.id
AND employee.department_id = department.id

Join Syntax 2
TABLE1
[INNER | LEFT | RIGHT] JOIN TABLE2
ON TABLE1.KEYFIELD = TABLE2.KEYFIELD
[INNER | LEFT | RIGHT] JOIN TABLE3
AND TABLE2.KEYFIELD_2 = TABLE3.KEYFIELD

e.g.

timesheet
INNER JOIN employee
ON timesheet.employee_id = employee.id
INNER JOIN department
ON employee.department_id = department.id
INNER JOIN ON

NOTE: Some systems allow tables to have names, which include space
characters. Where this is the case then it is necessary to surround table
names and field names with square brackets.
The matrix below shows which styles of joins are supported by the most
common Database Systems.
Pervasive
ODBC 32
Joins
(Old
WHERE
style)
Joins
(New
ANSI)

Pervasive
ODBC DBASE SQL Access Oracle
Interface

YES

YES

YES

YES

YES

YES

NO

YES

YES

YES

YES

NO

Creating a Graphical Join
To create a Container based on a Graphical Join, the System
Administrator should add a data container, selecting the option “Graphical
Join” from the Select Container Type window and providing a name for
the container. Then, before adding Expressions, the System
Administrator would create the joins between the tables by adding tables
within the Graphical Join tool, then dragging the relevant field from one
table and dropping it onto the appropriate field in the joining table. The
illustration below displays two joins between 3 tables.

An Inner Join is created by default, which can be changed by right
clicking on the join box on either side of the join and selecting Outer join.
The reverse polarity option on the shortcut menu switches the join
between a Left or Right Join.
The SQL syntax for the join can be viewed by selecting the check box
“Show SQL”.
Once the joins have been created they should be verified by using the
Check/Test facility for the Container. On closing of the Graphical Join tool
the join will be displayed as a SQL syntax. When the SQL join is verified
to be correct, the System Administrator can choose to Add Expressions.

Changing from a Join to a Graphical Join
You may change existing joins to a Graphical Joins but on doing so you
will have to recreate the join within the Graphical Join tool.
1. To change the source container type from a Join to a Graphical
Join, select the arrow in the Source container type field and
select Graphical Join.
2. Then click the Apply button. The container properties window will now
display a Graphical Join Tool button.

3. Select the Graphical Join tool button, add the required tables,
create the joins then click the Apply button to accept your
changes.

Home > Connector > Data Containers > Adding a Graphical Join Container

Adding a Graphical Join Container
Sage Accpac Intelligence supports the use of a Graphical Join as the
source for Data Containers.

Adding a Graphical Join Container – Step by Step
1. In the Connector add a new Container to your Connection.
2. When prompted to Select the Container Type choose Graphical
Join.

3. Enter a descriptive name for the container.
4. Press OK to complete adding the container.
5. Select the newly created container and in the right hand side of
the screen select the Graphical Join tool button.
6. Select the tables that you wish to have participate in this
graphical join. Join the tables by dragging primary fields in one
table onto the secondary fields in the next table.
7. Once you have added the tables and joins that you require click
Apply to complete adding the graphical join container.
8. Right click on the new Container and click Add Expressions.
When prompted for the Expression Type to add choose Data
Fields.

9. The list of fields that the View holds will appear. Select those
fields which should be available for reporting on and click OK.
The Container should now be ready to be used in Reports.

Home > Connector > Data Containers > Adding a Table Container

Adding a Table Container
Sage Accpac Intelligence supports the use of a single Table as the
source for Data Containers.
Adding a Table Container – Step by Step
1. In the Connector Tool add a new Container to your Connection. When
prompted to Select the Container Type choose Table.
2. The Container name will default to the Table name.
3. When prompted select the Table that you would like to use as the source
for this Data Container.
4. Press OK to complete adding the container.
5. Right Click on the new Container and choose Add Expressions. When
prompted for the Expression Type to add choose Data Fields.
The list of fields that the Table holds will appear. Select those fields which
should be available for reporting on and click OK. The Container should
now be ready to be used in Reports.

Home > Connector > Data Containers > Adding a View Container

Adding a View Container
Sage Accpac Intelligence supports the use of a View as the source for
Data Containers for certain Database systems.
Adding a View Container – Step by Step
1. In the Connector, add a new Container to your Connection. When
prompted to Select the Container Type choose View.
2. The Container name will default to the View name.
3. When prompted select the View that you would like to use as the
source for this Data Container.
4. Press OK to complete adding the container.
5. Right Click on the new Container and choose > Add Expressions.
When prompted for the Expression Type to add choose Data
Fields.
6. The list of fields that the View holds will appear. Select those
fields which should be available for reporting on and click OK.
The Container should now be ready to be used in Reports.

Home > Connector > Data Containers > Find and Replace

Find and Replace
The Find and Replace feature in the Connector lets you change all
instances of a name change, for example a table name that has
changed.
1. Open the Connector and right click on the affected container.
2. Select Find and Replace
3. Enter the existing table name under Find What and the new name
under Replace With.

4. Tick all expressions you would like to effect and also select what to
include in the replacement by selecting the relevant tick boxes.
5. Select OK
6. Confirm by selecting Yes.
7. The following screen will confirm that the find and replace was
successful.

Home > Connector > Data Containers > Container Protection

Container Protection
Sage Accpac Intelligence uses protection at a Container and Container
Expression Level to protect intellectual property. This means that
advanced data modeling in relational databases and advanced SQL
Expressions can be protected when reports are distributed. To enforce
this protection Sage Accpac Intelligence stores information about who
Container is Owned By (the original Container and all those created on
import to other systems) and who the Container is Licensed To. Such
information can be viewed on the properties screen of a container when
you check the Show Advanced button at the bottom of the properties
screen.

The Owner of a Container is the Company (Sage Accpac Intelligence
licensed company) that created the original Container. The Ownership
and protection options of a Container can only be changed by the Owner
of the Container on Export of the report and using a Solution Developer
license. Unless the Ownership options are changed all Containers
created in destination systems will retain the original Owner on import.
The Container Licensed To property specifies the Company (Sage
Accpac Intelligence licensed company) that has been authorised to
import reports that use this container. Authorisation is performed by the
Owner of the Container on Export. If this property is left blank then
anyone can import and use the Container.
The Owner of a Container can also specify protection options for an
Export File and its Container at Export. See Exporting Reports with
Protection for more information.
The Owner of a Container can also remotely unlock the Container, for a

client using the container, using the "Generate Unlock Pin Codes" facility
supplied (Solution Developer License only). See Unlocking A Container
and Expressions for more detail.
A Container Owner may set up a trust relationship between a report End
User and a Third Party (e.g. outsourced report writer) in order to facilitate
remote modifications to reports. For more information see the topic
Importing a Report licensed to another Company for details on.

Home > Connector > Data Containers > Stored Procedures

Stored Procedures
Sage Accpac Intelligence supports the use of Stored Procedures as the
source for Data Containers for certain Database systems. For a list of the
supported systems please go to Stored Procedure Supported Databases.
Adding a Stored Procedure Container - Step by Step
1. In the Connector add a new Container to your Connection. When
prompted to Select the Container Type select Stored Procedure.
2. Enter a descriptive name for the Container.
3. When prompted to Specify the Stored Procedure details enter the name
of the Stored Procedure and any Input Arguments for the stored
Procedure. In the example below the Stored Procedure is called
sp_sales_by_region and it expects a integer argument for the Year and
a string argument for the Continent.

4. Click OK to complete adding the Container.
5. Right click on the new Container and select Add Expressions.
When prompted for the Expression Type to add select Data
Fields.
6. The list of fields that the Stored Procedure returns will appear.
Select those fields which should be available for reporting on and
click OK. The Container should now be ready to be used in

Reports.
Dynamically Setting Stored Procedures Input Arguments at Report
Run Time - Step by Step:
To dynamically parameterize reports that use a Stored Procedure that
expects input arguments the Container must be used in conjunction with
Pass Through Variable(s). The defined Pass Through Variables must in
turn be defined as Parameters on the report.
1. Add Pass Through Variable(s) to the Container.
2. Add Parameters to the report based on the Container Pass
Through Variable Expressions create in Step 1.
3. Edit the Source Container property of the Container to include the
Pass Through Variable defined codes in the stored procedure
input argument list. For the example above the syntax would be:
@YEAR@, @CONTINENT@

where @YEAR@ and @CONTINENT@ are the Expression
Source (or Variable Code) property values of defined Pass
Through Variables within the Container. Note: When a stored
procedure expects non numeric (e.g. text based inputs) then the
Variable code must be prefixed and suffixed with a single
quotation mark (').

Limitations of Using Stored Procedures as Containers
The following limitations exist when using Stored Procedures as Data
Containers:
Only Expression Fields of types Data Field and Pass Through
Variable can be used in the Container. SQL Expression and Excel
Formula type expressions are not supported.
Reports that use Stored Procedure type containers cannot use
Filters or Aggregate Filters. Filtering can only be achieved with a
combination of Report Parameters, Pass Through Variables and
Stored Procedure Input Arguments.
Stored Procedure must return a single data set only.
Only a single Stored Procedure can be used in a Container.
Stored Procedures cannot be joined.

Home > Connector > Data Expressions > Data Expressions

Data Expression
A Data Expression is a field in a Data Container chosen by the Connector
to be available through the Report Manager Interface.
To display the properties of your Data Expression, select a Data
Expression and on the Toolbar click the Properties button .
The Data Expression properties window will appear.

To Hide/Unhide advanced properties check/uncheck the Show Advanced
button
.
Property

Description

Expression This is a Technical Key Identifier for the Data
ID
Expression
Expression
The Name or Alias for the Data Expression
Name

The Source Data Field Name of the underlying data for
Expression the Data Expression or a SQL Expression or an Excel
Source
Formula depending on the Expression Type (see
below)..
This indicates the type of expression that is being used.
By default it is set to Data Field and in this case will be
referring to a single column in an underlying Data Table.
It can also be set to SQL Expression to allow a raw SQL
expression to be used (including the use of the ODBC
drivers available Functions), or to Excel Formula.
In the last case Excel formulae can be specified in the
Expression Expression source. No equal sign should be used to
prefix the formulae. When Excel formulae are used
Type
here then to reference other Data Expressions in the
formula use their Expression Names. E.G.
CONCATENATE(Category," - ",ProductName).
If the Expression names have spaces or other non
Alpha-numeric characters in them then simply replace
these characters with underscores in your Excel
Formula

Allow
Viewing

Allow
Filtering

Allow
Sorting

Allow users to Report on this Expression. This setting
allows the user to add this expression as a column to a
report. If switched off it does not stop reports
functioning that were created before the setting was
changed
Allow users to filter on this Expression. This setting
allows the user to add this expression as a filter to a
report. If switched off it does not stop reports
functioning that were created before the setting was
changed
Allow users to perform sorting using this Expression.
This setting allows the user to add this expression as a
sort field to a report. If switched off it does not stop
reports functioning that were created before the setting
was changed

Allow
Lookups

Lookup
Type

Data Type

Allow users to perform lookups on this Expression
which will make Parameter Lookup Lists available for
this Expression. This option should only be used on
Data Expressions which are expected to have a fairly
limited set of distinct values. Using Lookups against
large diverse data sets can vastly hinder system
performance
Sets where the Parameter Lookup List dataset is pulled
from. See Defining Parameter Lookups for further
information.
The underlying data type for the Expression. If you
change an Expression to be of Expression Type SQL
Expression then you should pick the correct Data type
that the Expression is expected to return

Home > Connector > Data Expressions > Add Data Expressions

Add Data Expressions
Adding a Data Expression enables the system administrator to choose
the data fields (publish) from the Data Container(s) which are available
through the Report Manager.
Once you have selected your Data Container(s) which contain your
source data you will need to add your Data Expression.
Add a Data Expression:
1. Select a Data Container.

2. On the Toolbar, click the Add

button.

3. The Select the Expression Type to Add dialog box will appear.

4. For Field(s) in a Table choose the Data Field(s) option. If Data
Fields are being added to a Container that uses more than one
Table then you will be prompted for the Tables to add fields from.
Select the Tables. A Choose Publish Fields dialog box which
contains your data container fields will appear.
5. Select the fields that you want to be available in your container
(and will be available for reporting) and click OK.

6. The new Data Expression(s) should now appear in the Object
Window.

Home > Connector > Data Expressions > Edit a Data Expression

Edit a Data Expression
To edit a Data Expression, select the Data Expression which you want to
edit and on the Toolbar click the properties
button. The properties
window will be displayed.
Amend your Data Expression properties and click OK to save your
changes.
Property

Description

Expression
This is a technical key identifier for the expression
ID
Expression
The Name/Alias for the Expression
Name
Expression
The Source Data Field Name
Source
This indicates the type of expression that is being used.
By default it is set to Data Field and in this case will be
referring to a single column in an underlying Data Table.
It can also be set to SQL Expression to allow a raw SQL
expression to be used (including the use of the ODBC
drivers available Functions), or to Excel Formula.
In the last case Excel formulae can be specified in the
Expression
Expression source. No equal sign should be used to
Type
prefix the formulae. When Excel formulae are used here
then to reference other Data Expressions in the formula
use their Expression Names. E.G.
CONCATENATE(Category," - ",ProductName).
If the Expression names have spaces or other non Alphanumeric characters in them then simply replace these
characters with underscores in your Excel Formula.
Allow
Viewing
Allow
Filtering

Make this Expression available for using in a Report
Column
Allow users to filter on this Expression

Allow
Sorting
Allow
Lookups
Lookup
Type
Data Type

Allow users to perform sorting using this Expression
Make Parameter Lookup Lists available for this
Expression
Make Parameter Lookup Lists available for this
Expression
The underlying data type for the Expression. If you
change an Expression to be of Expression Type SQL
Expression then you should pick the correct Data type
that the Expression is expected to return.
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Using Excel Formulae in Data Expressions
There are two ways of using Excel Formulae in Data Expressions. You
can either choose to add an Excel Formula from the add data expression
field or you can add a normal data field and then change its properties to
an Excel Formula.
To add an Excel Formula from the Add Data Expression window:
1. Once you choose Excel Formula you are prompted to type in
name for the expression as shown below:

2. Type in a name then click OK. The following screen displays,
prompting you for the Excel formula:

3. Type in the formula, then click OK.
The other method in creating Excel Expressions is as follows:
1. Add a data expression by using the normal method (see Adding Data
Expressions).
2. On the properties window of the new data expression, change the

Expression Type from a Data Field to an Excel Formula.
3. In the Expression Source field, type in the correct syntax for the
expression type chosen, then click the apply button. An example of
what the properties window should look like is shown below.

Here the standard Excel CONCATENATE function has been used to
combine the contents of the two Data fields ProductName and Category
and with a dash in between them. Note that the formula does not begin
with an Equal sign. Sage Accpac Intelligence allows the names of
Columns to be used in the Excel Formulae through the way it applies
named ranges to the raw data sheet in a report. Where the word
ProductName has been used then the report is resolving this through a
named range for that column. The Data Expressions ProductName and
Category must be included as Display Columns in your report for this
Excel Formula Data Column to work.
For more information on understanding how Sage Accpac Intelligence
applies Named Ranges to its data area see the topic How Data is

Rendered. For further information on the Excel Functions that can be
used refer to your Microsoft Excel Help file.

Home > Connector > Data Expressions > SQL Expressions

Using SQL in functions in Expressions
Expressions can be modified to include SQL functions and operations. To
do this, type in the SQL syntax into the Expression Source property and
change the Expression Type to SQL Expression. The SQL functions
available are specific to the ODBC driver used by the connection type for
the container. For information on the available functions for a connection
type see the Help files or documentation provided for the driver.
As an example you may have a text field in a table called AccountNo
which is a seven digit code. The first three digits may be significant as
they signify a high level Main Account while the last four digits signify a
Sub Account. To strip the Main Account out from the AccountNo you can
create an expression that simply takes the first three characters from the
AccountNo. First add a new expression selecting the AccountNo field.
Select the new field and rename it "Main Account". Then uncheck the
"This is a Base Field" property and modify the Expression Source.
For a SQL Server connection type the syntax would be:
SUBSTRING([table].[field],1,3)

The syntax for this example for some other systems are shown below:
Pervasive:
SUBSTRING("LedgerMaster"."AccountNo",1,3)

Access:
LEFT([LedgerMaster].[AccountNo],3)

SQL Server:
SUBSTRING([LedgerMaster].[AccountNo],1,3)

Some of the most common uses for SQL functions are:
Stripping out parts of a text field ( shown in the above example).
Casting one data type to another (e.g. a Date stored as a text
field could be cast to a real date).
Performing mathematical operations (e.g. Summing two fields).

Returning a certain value based on some logic (e.g. Returning
the text YES whenever a certain boolean field is equal to 1).
Note that you cannot use an expression name within a SQL expression,
you have to use the expression source.

Home > Connector > Data Expressions > Using Pass Through Variables in Data Expressions

Pass Through Variables
Pass Through Variables enable the queries (or SQL statements) that are
sent to the Database Systems during report execution to be affected at
run time. Where ordinary Parameters are used to modify the filtering
element (or WHERE clause) of a query only Pass Through Variables can
be used with Parameters to modify other parts of the query. Pass
Through Variables must be used in conjunction with a reports Parameters
to be effective.
Pass Through Variables are an advanced report writing facility and
require a strong understanding of the Sage Accpac Intelligence
Connector Functions and of basic database query concepts. Pass
Through Variables are a special type of Container Expression and are
defined within containers in the Sage Accpac Intelligence Connector.
Pass Through Variables can also be effectively used to pass common
Parameter Values through a series of Union Child Reports within a Union
Report. In this way a Union Report may be configured to use one pop up
Parameter screen to paramaterise a number of Union Child Reports.

Terminology
Pass Through Variable A special type of Container Expression
used to hold a variable value that can be used within a report.
Pass Through Variable Code The Expression Source property
defined as a unique code prefixed and suffixed with @ symbols.
This code can be used in Report Filters, Report Aggregate Filters
and in other Expression Source properties. Where literal values
are usually placed in filter comparison values the Pass Through
Variable Code may be substituted.
Pass Through Variable Value The value held within a Pass
Through Variable during the execution of a Report. Note that the
value can only be set through a Report Parameter based on the
Pass Through Variable. Note that the lifetime of the Pass
Through Variable Value is from when the value is set during
report parameterization to when the report execution completes.

What can Pass Through Variables be used for?
Pass Through Variables can thus be used to achieve the following:
Dynamically modify the outcome of a Report Column through
Display Fields that are based on Expressions which include
Variables.
To filter data in a report.
Parameterize multiple Union Child Reports in a Report through a
single Parameter selection.
Parameterize multiple Reports in a report batch through a single
Parameter selection.
Apply multiple Filters that use a single Parameter which is based
on a Pass Through Variable.
Create Aggregate Parameters by using Aggregate Filters with
Pass Through Variable based Parameters.
Set Stored Procedure input arguments.

To define a Pass Through Variable - Step by Step
1. Add an expression to a container
2. When prompted for the type of expression choose "Pass Through
Variable".
3. You will be prompted for a descriptive name for the Variable.
Enter a name e.g. Company Name.
4. You will then be prompted for a Code for the Pass Through Variable.
The code is a unique identifier for the Pass Through Variable. The code
must be prefixed and suffixed with @ symbols. e.g. @COMPANY@.
This code that you choose for the Pass Through Variable has no relation
to any existing Expressions in the Container. The Code must however
be unique within the Container and should preferably be unique within
your Sage Accpac Intelligence System to prevent conflicts when using
Pass Through Variables in Union Reports.
Note: having done this you may then use the code @COMPANY@ in
any of the containers Expressions or any Report Filters to dynamically
effect queries at report run time.
5. To set the Pass Through Variable Value you must define a
Parameter on a report that uses the Pass Through Variable. Add
a Parameter to a report in the usual way but specifying the
defined Pass Through Variable as the expression to use for the
Report. When you run the report you will be prompted for a
Parameter which will then set the Pass Through Variable Value
and any occurrences of the variable within the underlying queries
will be replaced with variable value.
To Use a Pass Through Variable Within Another Container
Expressions
1. Modify the Source Property of the Expression to include the Pass
Through Variable Code. See the example below where a SQL
Expression has included a Pass through Variable Code:

2. Add a Parameter to your report and choose the Pass Through
Parameter Expression as the source.
3. Run your report and enter a value for the Parameter "Company".
The value that you enter for the parameter will be placed into the
variable @COMPANY@ and substituted into the expression
"Company & Department".
To Use a Pass Through Variable to Filter Data in a Report
1. Make sure that the Container that is used in your report has Pass
Through Variable(s) defined as explained above.
2. Add a Parameter to your report based on the Pass Through
Variable. Note that running the report and entering a value for the
Pass Through Variable will have no effect on the report output
until the Pass Through Variable Code has been added to a filter
(or aggregate filter) as in step 3.

3. Add a filter to the report that you wish to based on an Expression
that must be filtered in conjunction with the Pass Through
Variable Code. Choose the relevant Comparison Method for the
filter (e.g. Is Equal To) and then enter the code for the pass
through variable (e.g. @COMPANY@).
4. Run the Report. The Parameter prompt will be used to set the
Pass Through Variable value. This value will be substituted for
the Pass Through Variable code (@COMPANY@) in the Filter set
in step 3 and will thus effect the output of the report Query
(through the SQL WHERE clause).
To Use a Pass Through Variable to Filter Aggregated Data in a
Report
Follow the steps as outlined in "To use a Pass Through Variable to Filter
Data in a Report" but in step 3 use an Aggregate Filter instead of a
standard Filter.
To Use a Pass Through Variable Within Multiple Union Sub Reports
When a Union Report runs the individual Union Sub Report queries are
executed and the data placed into a single Excel Workbook. Although the
underlying queries are executed independently and possibly against
different Databases the Pass Through Variables that are populated
become available for the remaining scope of the Union Report execution.
This means that a Pass Through Variable defined in a container for the
first Union Sub Report is set as the first Union Sub Report is executed.
The Variable can then be reused in the subsequent Union Sub Reports.
This can be useful to avoid multiple Parameter popup boxes where the
Union Sub Reports require similar parameterisations. An example is
described below:
The first Union Sub Report needs to pull Ledger Balances for the
Account ACC001 and the second Union Sub Report needs to pull
Transactions for the same account. The first Report is based on the
Container "General Ledger" and the second report is based on the
Container "Ledger Transactions". To create a Union Report that achieves
this but with a single parameter screen you could do the following:
1. Define a Pass Through Variable called Account with code

@ACCOUNTNUM@ in the container "General Ledger".
2. Create a union Report that uses the pre-created reports "Ledger"
(based on General Ledger container) and "Transactions" (based
on Ledger Transactions" container).
3. On the report "General Ledger" add a Parameter based on the
Pass Trough Variable Account created in step 1.
4. On the report "General Ledger" add a Filter based on the
Container Field AccNum with Comparison Method "Is Equal To"
and with Comparison Value as @ACCOUNTNUM@.
5. On the report "Transactions" add a Filter based on the Container
Field AccNum with Comparison Method "Is Equal To" and with
Comparison Value as @ACCOUNTNUM@.
6. Note: Make sure that the order of the Union Sub Reports is
"Transactions" first and then "General Ledger".
The reason for this is that Union Reports use a LIFO (Last In First Out)
technique with Sub Reports and thus the "General Ledger" Sub Report
will execute first and the Pass Through Variable will be set upfront and
thus also be available to the report "Transactions".

Defining Parameter Lookups
When a report has Parameters defined for it a user may use the lookup
facility to pick parameters from a database list (see Running a Report
with Parameters for more details). By default the parameter list is pulled
directly from the Source Container of the report. Often this can be very
time consuming and load heavily on the underlying database and often
there is a more logical place to pull the list from.
An example of this might be where your report is pulling information from
a large transactional table (e.g. Sales) and a parameter is defined on the
report against a Customer Account code. The Customer Account Code
might also be defined in a smaller reference data table (e.g. Customers)
and it would make sense to then define this as the lookup table.
To do this locate the underlying expression for the Parameter in the
Connector and set Lookup Type property to the appropriate lookup type.
Sage Accpac Intelligence supports the following lookup types:
Direct from Container (Default)
This option will cause Lookups to be drawn directly from the Source
Container. Note that this is inefficient if the source container contains
more than one table however it will only bring back entries where they
are contained in the container.
SQL Statement Defined
This option allows you to insert a SQL statement which will be used to
define the Lookup. This is useful where you want maximum control
over the values that are returned in the Lookup. Using this option
requires that you are familiar with SQL and with any SQL specifics of
the Database system being accessed. Once you select this option and
click the Apply button a new property named Lookup SQL SELECT
Statement will appear and you can edit it to customise the lookup.
SQL Statement Defined (Code & Desc Pair)
This option allows you to insert a SQL statement which returns a code
& description pair for each data item to be returned in the Lookup. The
Description is displayed in the Lookup but the Code of the selected
Lookup item is used for the Parameter Value. This is useful where the
parameter value required is not meaningful to the user. An example

would be where Store Code is required as a Parameter Value, however
users only know stores by the Store Name. By using a Code & Desc
Pair Lookup, the Store Names will be displayed in the Lookup list but
the Store Code will be passed through as the parameter value when a
Store Name is selected from the list. Using this option requires that you
are familiar with SQL and with any SQL specifics of the Database
system being accessed. Once you select this option and click the Apply
button a new property named Lookup SQL SELECT Statement will
appear and you can edit it to customise the lookup.
Text File
This option allows you to specify a text file which will be used to define
the Lookup. The text file must contain a single item on each line.
Using Text Files can be useful when the list provided in a parameter
lookup is very specific. Where a normal SQL lookup might bring back
some items which are not relevant to a user then a Text File can be
used to populate with just the relevant items. It should be noted that
the text files that are used for Lookups lie outside of the Containers
and are not bundled with a Report that is exported for redistribution.
The text files would need to be implemented in the target system
manually.

Home > Connector > Testing > Check/Test

Check/Test
The Check/Test feature enables checks to be run on objects selected in
the Object Window to make sure that they will function correctly.
This is especially useful when advanced options are used for an Object.
For example when changing a Data Containers source from a simple
Table to a SQL Join then this function can be used to check the SQL
against the Source Database System, OR when using it against a
Connection Object it will test that the Connection can be established.

Home > Connector > Testing > Sample Data

Sample Data
The Sample Data icon
enables a sample of data to be viewed from a
source container in a Sage Accpac Intelligence Data Screen. The sample
includes 50 Rows with all columns from the underlying source.
Note that the sample brings back all fields regardless of what
expressions have been published for the container.
This feature is useful in the MetaData mapping process and allows a
quick way to view and choose the fields that should be published. It is
also useful when used on individual expressions, especially when using
SQL expressions to ensure that the syntax you have used will achieve
the desired result.
Note that the Sample Data feature cannot be performed on a container or
a container expression where the connection server and database names
are set as pass through variables.

Home > Connector > Maintaining the Connector > Apply Metabase Update

Apply Metabase Update
Occasionally upgrades and fixes become available for the Metadata
structure.
When these are supplied they can be applied through this feature using
the Update Metabase button
available on the Toolbar in the
Connector.

Home > Connector > Maintaining the Connector > Connection Override

Dynamic Connections
For some systems it is useful for Reports to prompt for connection
information at run time. In this way a Report user can specify where data
is coming from at run time. To achieve this, a connection needs to be
modified by the System Administrator to be dynamic. This is an advanced
administrative function. To achieve this the System Administrator
modifies any of the connection properties using free text in a PROMPT
format or a PICKLIST format.
If a PROMPT is used then a user is simply prompted to enter free text for
the information required.
For a PICKLIST the user is supplied with choices for the information.
When the user supplies a given piece of information Sage Accpac
Intelligence offers the facility to cache the information for the remainder of
the session. If the user chooses to cache the information then they will
not be asked for the information again and the cached information will be
assumed for all subsequent references to the connection. The text that
the System Administrator must enter for a PROMPT is of the format:
PROMPT=<Prompt text here>

For example:
In the Server Property of a SQL Server connection enter the following:
PROMPT=Please specify server name

The user will then be prompted at run time with a dialog box with the
prompt "Please specify server name"

The text that the System Administrator must enter to supply the user with
a PICKLIST is of the format:

PICKLIST=<PromptText>;<DESCRIPTION_1>::<TECH_INFO_1>;<DESCRIPTION_2>::<TECH_INF

For example in the Access Database (*.mdb) Property enter:

PICKLIST=Where is Your Data;Office::X:\Data\Filofax2002.mdb;Online::Z:\Data\Fil

The user will then be supplied with a PICKLIST titled "Where is Your
Data" and with the three choices Office, Online and At Home.

Note that a PICKLIST or prompt format cannot be used on a connection if
the Connection is using an "Auto Connection System"

Home > Connector > Maintaining the Connector > Date Formats

Date Formats
Different database systems store and recognise dates in different
formats. Sage Accpac Intelligence attempts to hide this detail from its end
users by translating dates at run time into a recognizable format before
passing the date to the underlying Database System. In order for Sage
Accpac Intelligence to know how the Database System is expecting the
dates, the Data Connection (property Date Format) in the Connector is
pre configured. Additionally, different Database Systems expect dates to
be delimited with different characters. This is also configured on the Data
Connection object as the property Date Delimiter.
For the end user dates in report Parameter boxes can always be picked
using the Sage Accpac Intelligence Calendar thus hiding the common
problems that occur with ambiguous date formats. The list below shows
date formats that are recognized by some of the more common Database
Systems.
Date Format
Pervasive
DBASE
SQL
Server
Access
Oracle

M/DD/YYYY
YYYY/MM/DD
DD-MMMYYYY
M/DD/YYYY
DD-MMMYYYY

Date
Delimiter
'
#
'
#
'

Note: Changing these settings on a Connection or Connection Type
object can cause report execution problems and may cause incorrect
date ranges to be returned. For supported Connection types in the Sage
Accpac Intelligence Connector you should not change the settings for
these fields.

Selecting Dates in Report Parameters
It is preferable to use the Sage Accpac Intelligence Calendar when
selecting Dates in Parameters. If you prefer to key in Date values for a
Report Parameter or Filter it is best to use the format dd mmm yyyy to
avoid ambiguity and Date errors. e.g. 19 January 2008 OR 19 Jan 2008.
In this way Sage Accpac Intelligence can unambiguously translate the
date into the format expected by the underlying Database system. The
Sage Accpac Intelligence Calendar is shown below:

Home > Connector > Maintaining the Connector > Time Formats

Time Formats with Dates
By default when filtering and paramatizing reports, Date and Date Time
fields are treated as Dates only. This is, since commonly information in
Databases is stored by date and the time component is deemed
insignificant.
In certain situations it is necessary to paramatize on the Date and the
Time. To force Sage Accpac Intelligence to pass full Date and Time
values to the underlying database system you must check on the
advanced property Use Time with Dates option on the specific
connection in the Connector. If you do this all Dates will be passed
through to the Database as Date and Time for reports belonging to the
connection. Additionally the Sage Accpac Intelligence Calendar (shown
below) that is used in report parameterization will include a Time
selection option.

Selecting Date Times in Report Parameters
It is preferable to use the Sage Accpac Intelligence Calendar when
selecting Dates Times in Parameters. If you prefer to key in Date Time
values for a Report Parameter or Filter it is best to use the format dd
mmm yyyy hh:mm:ss to avoid ambiguity and Date errors. e.g. 19
January 2008 13:15:00 or 19 Jan 2008 13:15:00.
In this way Sage Accpac Intelligence can unambiguously translate the
date and time into the format expected by the underlying Database
system.

Home > Connector > Maintaining the Connector > Configuring the Rendering Engine

Configuring the Sage Accpac Intelligence
Rendering Engine
The Sage Accpac Intelligence data rendering engine can be configured
to include or omit certain steps in the rendering process.
Note that these changes are global and affect how all your Sage Accpac
Intelligence reports run. The default settings should only be changed if
there is a specific reason for the change. Usually these settings are only
changed when trying to isolate problems for slow running or problematic
reports.
To change configuration settings Launch the Connector. Select the Sage
Accpac Intelligence Enterprise object in the Object Window and on the
Tools menu click Configure Excel Output Engine.
The screen shown below will appear:

Toggle on or off the required settings and then click OK. Each setting
corresponds to a step performed by the Sage Accpac Intelligence
rendering engine. Switching the setting off will stop that step from running
for all reports until such time that the setting is set back on.
An explanation for each option is listed below:
Refresh Add-In Links - Refreshes links in Excel to Add-In libraries.
This option is necessary when functions are used in your workbooks
that are outside of the standard Excel function set (e.g. functions in the
Analysis Toolpak add-in).
Write Book Summary Information - Writes report summary
information to each workbook.
Refresh Pivot Table Data - Refreshes Pivot Table data for all pivot
tables in a report.
Name Ranges and Update Excel Formulae - Applies Sage Accpac
Intelligence standard Name Ranges for data columns and data ranges as
well as updating formulae which might reference Named Ranges. N.B.
Do not switch this option off if any of your reports use Named Ranges
or Sage Accpac Intelligence Excel Formulae type expressions defined in
your Data Containers.
Force Book Recalculation – This option instructs the workbook to
recalculate all formulae after data has been rendered. If you switch this
option off then your reports will have to be manually recalculated by the
user. It is best not to turn this option off.
Allow Running of Add-Ins - This step runs the Sage Accpac
Intelligence Add-in functions defined on reports. Only switch this
option off for debugging purposes.
Allow Running of Template Macros - This step runs the Template
Macros defined on reports. Only switch this option off for debugging
purposes.
Allow Autoformatting of Data Sheet - This step facilitates the
automatic formatting of raw data sheets, e.g. column widths.
Allow Retaining of Run Instances - This step facilitates the saving of

report instances at run time.
Allow Run Instance Auditing - This step facilitates the saving of
report audit instances at run time.
Allow Output File Generation - This option allows reports to be saved
to a specific location.
Take Tight Control of Excel - Allows Sage Accpac Intelligence to take
tight control of Excel while running a report. This is to stop a user from
causing problems with a report while it is running. Switching off this
option could cause your reports to be unreliable and is not
recommended. Use this option for debugging problematic reports only.
Take Tight Control of Workbook - Allows Sage Accpac Intelligence
to take tight control of the Excel Workbook for a report while running a
report. This is to stop a user from causing problems with a report while
it is running. Switching off this option could cause your reports to be
unreliable and is not recommended. Use this option for debugging
problematic reports only.
Allow Book to Close on Completion - This option allows reports to be
closed on completion automatically. This option is generally used for
reports which have been set to run unattended.
Automatically Activate Reports - This option allows Sage Accpac
Intelligence to activate reports on completion, for example, you want to
run a number of reports in sequence on a monthly basis, so set a
command in the properties of the first report to automatically run the
next report as soon as it has run, and so on.
Lock Windows when Locking Workbooks - This option can be used
to select the way you wish Sage Accpac Intelligence to Lock
Workbooks when the "Protect the Output Book" option is used on a
report. Leaving the option on will cause Workbook Windows to be
locked as well as the Workbook Data and structure. Switching it off will
only lock Workbook data and structure and not the actual Workbook
Window.
Forces Reports to Abort if no data returned - This option can be used
to configure the way in which a report that obtains no data during its
"Data In" phase continues. If this option is set on then the report will

abort, saving some time. If the option is set off then the report will
continue to run but with no data.
Allow Render Delays for User Cancel - This option is used to allow a
user the option of canceling a report while it is running data into
Microsoft Excel. This option, although useful, significantly slows down
the data out phase of a report run. Switch this option off to speed report
execution time. If you have problematic reports that need the user
cancel facility then this option should be checked on.
Refresh Excel Formulae in Raw Data - If Excel formulae are used in
a container and then in a report, it can come through uncalculated or
with errors. Selecting this option will force Microsoft Excel to
recalculate these.
Maintain Pivot Cache Cube Connections - For cube reports this
instructs Excel to keep a database connection to the cube open while the
book is open so that each drill down in the pivot table does not need to
reconnect to the cube. If this option is off (the default) then Excel
reconnects to the cube on each Pivot query.
Attempt repair Colorless Charts in Excel 12 - Some templates that
were created in Microsoft Excel 2003 or earlier versions lose their
colors when run out into Microsoft Excel 2007 due to a change between
versions. This option attempts to run out the reports and repairing the
chart colors.
Allow Running of Hook - A workbook generated by the running of a
report, can be customized by an external dll.

Home > Connector > Maintaining the Connector > Compacting MetaData

Compacting MetaData
Compacting your MetaData occasionally can result in improved system
performance. Depending on your usage levels it may be desirable to do
this more often.
1. Select File
2. Then select Compact Metadata

3. A message that Sage Accpac Intelligence must shut down will appear.

4. Select Yes.
5. The Maintenance Utility will then open.

6. Select Compact SVD.
7. A Confirm message box will open.

8. Select Yes
9. The Sage Accpac Intelligence Maintenance Utility window will be
populated with commands as it gets executed.
10. When it has completed, a message will appear, asking you to delete the

backup file after verifying that Sage Accpac Intelligence is working
correctly.

11. Select OK
12. The backup file can either be deleted or kept as an additional backup.

Home > Connector > Direct SQL Query Tool > Direct SQL Query Tool

Direct SQL Query Tool
The Direct SQL Query tool allows direct interrogation via SQL of data
within your Connector defined Data Connections. The query tool allows
only SELECT queries and {call} type queries for stored procedure
execution (if supported). UPDATE, DELETE and INSERT and DDL (Data
Definition Language) queries are not allowed.
Launch the tool from your Connector.
Click on Tools, Direct Query Tool, and then edit and execute SQL
queries.
To execute a Query either choose:
Query > Execute or
Press the F5 key
If a certain part of the Query text has been highlighted then only this
portion of the query will be executed.
Note that the SQL syntax from driver to driver may differ. Consult the
documentation for a each system for more information.
Query results can be displayed in the tools own query results grid or it
can be rendered directly into a new Excel Workbook. To toggle the output
modes choose the menu item:
Query > Results to grid or
Query > Results to Excel
A Direct SQL Query window is shown below.

Query files can be saved and opened from the File menu.

Home > Report Manager > Overview > How Data is Rendered

How Data is Rendered
Sage Accpac Intelligence always outputs the data for a report to the first
(left most sheet) in a workbook. Subsequent worksheets in the workbook
are available for you to create your report output formats.
The expression names for the columns in the report are placed in the first
row of the worksheet as the column headings. Sage Accpac Intelligence
then uses Named Ranges on the data columns and the used data range.
Although these Named Ranges do not have to be used by the rest of the
report they can be useful and provide more clarity in formulae and ranges
that you use in your report formulae and Pivot Tables. Sage Accpac
Intelligence names each column of raw data with the same name as the
Column Heading for the column but replaces any special characters
(which are not allowed in named ranges) with underscore characters.
Note: When you use Excel Formulae in your Sage Accpac Intelligence
Data Containers then you should reference columns in the raw data by
their Named Range headings. For example if you have a Data
Expression called Order Date in your container and you want a Data
Expression that uses an Excel Formula to extract the month from the
Order Date then you could create a Data Expression of type Excel
Formula and then set the source to MONTH(Order_Date). Here we have
used the standard Excel Formula MONTH and referenced the Order Date
expression. Note that an underscore has been used to replace the space
character between the words Order and Date (since special characters
are not allowed in Named Ranges).
If a column in a report has a column heading beginning with a numeric
then the Name Range applied to the column will be prefixed with an
underscore (Since Named Ranges cannot begin with a numeric). You will
also need to bear this in mind if you reference such a field using an Excel
Formula in a Container Data Expression.
Lastly Sage Accpac Intelligence names the range of all the Columns in
the Raw Data range as RawDataCols and the range of the Rows and
Columns used by the Raw Data as RawData. These two named Ranges
can be very useful when Pivot Tables feed off the Raw Data. Rather than

using the column ranges (e.g. Sheet1!$D:$J) for the source of a Pivot
Table use the Named Range RawData (or RawDataCols), e.g.
Sheet1!RawData. In this way if new Display Columns are later appended
to a report then the Range of the Pivot Table(s) will not have to be
extended to include these (since with the Named Range the inclusion will
be automatic).

Home > Report Manager > Overview > Report Manager Interface

Report Manager Interface.
The Report Manager Interface allows users to design and manage their
own reports and to display results in Microsoft Excel.

To use the functions of the Report Manager Interface you will first need to
select an object (i.e. a Folder or Report) in the Object window.
When you have selected an object in the Object window, you can edit the
Properties of your chosen object by using the Property fields provided in
the Properties window.
To save any changes you make to the Properties of your chosen object,
you must click the Apply button.
The Report Manager Interface also includes a standard windows menu
bar and a Report Manager Toolbar to simplify its use.

Home > Report Manager > Overview > Report Manager Toolbar

Report Manager Toolbar
The Report Manager Toolbar has various Icons:
Icon

Name

Description

Add

Add Enables the user to add new folders and
reports.

Delete

Delete Enables the user to delete their selection.

Properties
Refresh

Properties Displays context specific object
properties.
Refresh Refreshes on screen properties of the
selected object

Copy

Copy Copies the selected object to the clipboard

Paste

Paste Pastes an object from the clipboard into
the selected object

Move To

Move To Moves a connection or a container

Check/Test

Check/Test Use this to check that a report
satisfies minimum requirements to function
correctly. Minimum requirements are that at least
one Column is selected and that if a template
has been assigned to the report then that the
template exists.

Run

Runs a report.

Run Sample

Create
template
Un-link
Template

Run Sample Runs a report using just a sample
of the data (sample size is specified by the user).
Useful when designing and testing reports that
are data intensive.
Create Template Enables the user to create a
template for the current report from an open
Excel workbook
Unlink Template Enables the user to unlink a
template from the current report

Design

Design Allows the user to design a report by
opening its template in Excel for modification

Lock

Locks the current report

Unlock

Unlocks the current report

History

Displays a Reports Run History

Help

Display Help Files

Export a
Report

Export a Report Enables the export of reports for
import to other Sage Accpac Intelligence
systems

Generate
Scheduler
Command
Run Report
Batch
Add
Consolidation
report
Unlock Excel
Security
Manager

Generate Scheduler Command Generates the
command to run the report unattended
Run Report Batch Runs all the reports in the
chosen folder from top to bottom
Runs a report that contains macros with the
purpose of consolidating data from various other
workbooks
It is possible that if a report runs into rendering
problems Excel can be left locked. Clicking this
will unlock Excel and allow user interaction
Opens the Security manager

Home > Report Manager > Overview > Using Shortcut Keys

Using Shortcut Keys
You can use various shortcut keys as follows:
Shortcut
Key
CTRL-R
CTRL-N
CTRL-P
CTRL-O
CTRL-C
CTRL-V
DEL

SHIFT

F12
F2
F5

Description
In the Report Manager Tool, this runs the
selected report
Moves to the next object in the Object
Window
Moves to the previous object in the Object
Window
Displays the properties of the selected object
Copies the selected object
Paste an object from the clipboard
Deletes the selected object
In the Connector holding down the Shift key
will toggle the display in the Object Window
to show the Container and Expression
Source property value instead of Object
name. This provides a quick method when
trying to locate specific expressions
Adds a child object to the selected object
Renames the selected object
Refreshes the object list

Home > Report Manager > Working with Reports > Report Folders > Creating a Folder

Creating a Folder
A folder enables the user to manage reports in a logical subject grouping.
For example, a Sales folder will typically contain all sales related reports.
To create a new folder:
1. Select the Sage Accpac Intelligence Home Object in the Object
Window.
2. On the Toolbar click the Add icon

button.

1. The following dialogue box will appear.

2. Enter a name for your folder (e.g. Sales, Inventory)
3. Click OK.
The new folder should now appear in the Object Window.

Home > Report Manager > Working with Reports > Report Folders > Edit Folder Properties

Edit Folder Properties
To edit the properties of a Folder, select the Folder you want to edit and
on the Toolbar click the Properties button . The Properties window will
be displayed.

Enter your amendments and click Apply.

Home > Report Manager > Working with Reports > Editing Reports > Edit Report Properties

Edit Report Properties
To edit the properties of a Report, select the Report you want to edit and
click the Properties button . The Properties window will be displayed.
Enter your amendments and click Apply.
A report property which is not available on this properties screen is the
source container (the container from which this report was created).
To view this information:
1. In the object window, double click on the report.
2. Double click on Source Container.
3. The source container name will then be displayed beneath the
source container line.
4. If you wish to go to this container within the Connector then
proceed as follows:
a. Right click on the source container name (the name which
appeared in step 3).
b. Select Goto Container. (See also Goto Container Topic)
c. Click Yes to continue.
d. The Connector will open displaying the source container.

Home > Report Manager > Working with Reports > Editing Reports > Ways of Working with Filters and
Parameters > Comparison Methods

Comparison Methods
Comparison Methods are used with Filters and Parameters to refine or
limit the rows that are returned to a report. Note that when doing string
comparisons, the comparisons may or may not be case sensitive. This
will depend on the underlying data source. An Example for each
comparison method is shown below:
Comparison
Example
Method
Equal To

South
Africa

Greater
Than

100

Less Than

100

Greater
Than Or
Equal To

100

Less than
Or Equal
To

Is Like

100

%S%3%

Search
Objective
True when the
expression
contains
'South Africa.'
True when the
expression is
greater than
100.
True when the
expression is
less than 100.
True when the
expression is
greater than
or equal to
100.
True when the
expression is
less than or
equal to 100.
True when the
expression is
contains an
'S' and a '3'
(but not
before the

Alpha/Numeric

Both

Both

Both

Both

Both

Alpha

'S').
Not Equal
To

Begins
With

Ends With

Contains

Does Not
Begin With

Does Not
End With

Does Not
Contain

Is Not Null

Ken

True when the
expression is
Both
not equal to
'Ken'.

True when the
expression
Darang
begins with
'Darang.'
True when the
K
expression
ends with 'K'.
True when the
expression
Woodridge contains the
text
'Woodridge'.
True when the
expression
doc
does not
begin with
'doc'.
True when the
expression
s
does not end
with 's'.
True when the
expression
@
does not
contain '@'
symbol.
True when the
expression is
Not Null.
True when the

Alpha

Alpha

Alpha

Alpha

Alpha

Alpha

Both

Is Null

expression is
Null

Is In

1,3,4

Is Not In

1,3,4

Is Not Like

%S%3%

Is In Sub
Query

Is Not In

Report ID

Report ID

Both

True when the
field is equal
to one of the
Both
values in the
comma
separated list.
True when the
field is not
equal to any
Both
of the values
in the comma
separated list.
True when the
expression
does not
container an
Alpha
'S' and a '3'
(but not
before the
'S').
True when the
results from a
field are
contained
within the
results from
the specified
Sub Query
Report.
True when the
results from a
field are not
contained
within the

Sub Query

Is In
Parallel
Query

Is Not In
Parallel
Query

results from
the specified
Sub Query
Report.

Report ID

Report ID

True when the
results from a
field are
contained
within the
results from
the specified
Sub Query
Report.
True when the
results from a
field are not
contained
within the
results from
the specified
Sub Query
Report.

Home > Report Manager > Working with Reports > Editing Reports > Ways of Working with Filters and
Parameters > Like Operator

Like Operator
The Like Operator is used in Filters and Parameters for doing pattern
matching. Combinations of literal characters and wildcard characters can
be used to locate patterns. The two wildcard characters that are
supported by most Data Access Drivers are the _ (underscore)
wildcard; which means any single character, and the % (percent)
wildcard; which means any zero or more characters. For example the
pattern _a_b% would match any words that have an 'a' as the second
character and a 'b' as the fourth character.
Additional symbols for pattern matching are supported by some Data
Access Drivers. These may include:
Symbol(s)

Meaning

[]

Any single character
within the specified
range ([a-f]) or set
([abcdef]).

#

Any single numeric
character.

[^]

Any character not
within the specified
range ([^a-f]) or set
([^abcdef]).

Example
'[A-J]%' is requesting
words having the first
letter between A and
J.
'A#%' is requesting
words beginning with
an A and having a
numeric in the
second position.
'S[^l]%' is requesting
words beginning with
S and not having a 1
in the second
position.

System Variables
System variables can be used with Parameters and Filters to dynamically
determine a comparison Value at report Run Time. An example of this is
where a report is run and expected to return data for the current day. In
this example a Filter could be set on the report for a Date field and the
filter comparison value (or comparator) could be set to the system
Variable @DATE@. When the report is run the system variable
@DATE@ in the filter comparator will be replaced with the current date.
To select a System Variable when adding a Filter or Parameter click the
System Variable button
on the Enter Comparison Value screen.
The Select System Variables screen (shown below) will appear. Select
the required System Variable and click OK.

Custom System Variables
Note that the set of available System Variables defined can be extended
by adding Custom System Variables to the Alchemex.ini file under the
section [GlobalSysVars]. These Custom System Variables are hard
coded values in the Alchemex.ini file and cannot contain script logic.
Each Variable must be added on a separate line under the section and
must also be added to the comma separated list defined in the Active
key under the [GlobalSysVars] section. An example of two Custom
System Variables defined in the Alchemex.ini file is shown below. With
this example the System Variables @FINYEARSTART@ and
@FINYEAREND@ will be available to all reports in the Sage Accpac
Intelligence system.
[GlobalSysVars]
Active=@FINYEARSTART@,@FINYEAREND@
@FINYEARSTART@=01 March 2004
@FINYEAREND@=28 February 2005

System Variable Format
System Variables must always be prefixed and suffixed with a single @
symbol and must contain no other occurrences of an @ symbol. System
Variable names must be unique. System Variables that do not comply to
this format will not be recognized by Sage Accpac Intelligence.

Considerations when using System Variables in Reports
It should be noted that Custom System Variables are defined in the
Alchemex.ini file. Due to this the set of Custom System Variables will vary
from site to site. If Custom System Variables are used on a report
intended for distribution then the same definitions will have to be created
at the destination sites. Ordinary System Variables are available to all
Sage Accpac Intelligence sites without the requirement to create them.
This means that Reports intended for distribution should avoid using
Custom System Variables where possible.

Listing Available System Variables
To obtain a list of all available system variables (Standard and Custom)
select the Sage Accpac Intelligence Home object in the Report Manager
and from the Tools menu choose Show System Variables. A list of all
available System Variables will be displayed.

Home > Report Manager > Working with Reports > Editing Reports > Report Columns > Add or Remove
Columns

Add or Remove Columns
Adding or removing Columns enables the user to manage the data that
will be displayed in the report by identifying what Columns should be
included or removed.

Add Columns to your report:
1. Select the report where you want to add columns
2. In the Object Window, click on the Columns Tab.

3. In the Object Window, click on the Add button
Column Fields dialog box will be displayed.

, the Choose

4. Select the Columns you would like to add to your report and click on
OK.
You have now successfully added Columns to your report.

To Remove Columns
1. In the Properties Window, select the Columns that you would like
to delete.
2. Click the Remove button.

Home > Report Manager > Working with Reports > Editing Reports > Report Columns > Edit Column
Properties

Edit Column Properties
To edit the Properties of a Column, select the Column you want to edit
and on the Toolbar click the Properties button . The Properties
window will be displayed.

Whilst editing columns, you can change the Aggregate Function.
An example where you would use an Aggregate Function is if you want to
sum sales by Customer.
Before using an Aggregate function, the report needs to have an unique
identifier such as an Invoice number. Also ensure the report does not
have too many variables, then the function will not work.
Use the drop down arrow on the Aggregate Function Field to make your
selection as follows:
Aggregate
Function
None

Description
No aggregate function is applied to the Column
and no data grouping occurs.

Average

Count

Maximum

Minimum

Sum

The average value for this Column will be used
and the remainder of the fields which have no
aggregate functions applied will be grouped into
distinct rows.
A count value for this Column will be used and the
remainder of the fields which have no aggregate
functions applied will be grouped into distinct rows.
A Maximum value for this Column will be used and
the remainder of the fields which have no
aggregate functions applied will be grouped into
distinct rows.
A Minimum value for this Column will be used and
the remainder of the fields which have no
aggregate functions applied will be grouped into
distinct rows.
A Sum value for this Column will be used and the
remainder of the fields which have no aggregate
functions applied will be grouped into distinct rows.

When you have made your selection click on OK.
Aggregate functions can be applied to multiple columns at once by
selecting the columns, right click and selecting Apply Aggregate.
Please note only value fields can have an Aggregate function.

Home > Report Manager > Working with Reports > Editing Reports > Report Columns > Change order of
Columns

Change Order of Columns
Changing the order of Columns changes the order of the data Columns in
Excel. To change the order of columns for reporting, select the Column
that you would like to move.

Use the Move Up
or Move Down
buttons to change the
order of your columns. Alternatively drag and drop the columns into
order.

Home > Report Manager > Working with Reports > Editing Reports > Report Filters > Add or Remove
Filters

Add or Remove Filters
Adding or removing Filters enables the user to refine or limit the rows of
data that will be displayed in the report. To add or remove Filters from
your report, select the report where you want to add or remove Filters
and then click on the Filters Tab.
The existing Filters that you have selected will be displayed.

Add Filters:
1. In the Properties Window, click the Add button
Choose Filter Field dialog box will appear.

and the

2. Select the Filter Field you would like to add to your report and click
OK.
3. The Choose Comparison Method dialog box will appear.

4. Choose your comparison method and click OK.
The Enter Comparison Value window will appear.

5. You may now either:
Enter your Comparison Value in the field provided, or
Use the lookup button
Values, and click OK.

to view a selection Comparison

6. Note: The Lookup facility will only be available if it has been enabled
in the Connector for this expression. See Add Data Expressions.
7. Use the Select System Variable button to view a list of System
Variables, and click OK.
Note: For further information about System Variables see System
Variables.
8. The new Filter should now appear on the Filters Tab.
To remove Filters, in the Properties Window, select the Filters that you
would like to delete and click the Remove button.

Home > Report Manager > Working with Reports > Editing Reports > Report Filters > Edit Filter
Properties

Edit Filter Properties
To edit the properties of a Filter, select the Filter you want to edit and on
the Toolbar click the Properties button . The Properties window will be
displayed.

Enter your amendments in the active fields provided. For more help see
using Comparison Operators.
Select the check box options according to your requirements as follows:
Check Box Option

Description
By default when multiple filters
are used on a report they are
applied using Boolean AND
logic. So for data to satisfy
filters with AND logic all the
filters must evaluate to true.
When OR logic is used only
one of the filters needs to

evaluate to true.
Where complex Boolean Logic
is needed for combing filters
that use combinations of AND
and OR logic then logic
breakers can be used to group
filters together. Use this setting
to prefix the filter with a logic
breaker.
Where complex Boolean Logic
is needed for combing filters
that use combinations of AND
and OR logic then logic
breakers can be used to group
filters together. Use this setting
to suffix the filter with a logic
breaker.
When you have entered your selections click on OK.

Column to Column Filtering
To filter data based on a comparison between two expressions, follow the
steps below.
1. First add a normal filter as in Adding a Filter Topic choosing one
of the Container fields that should participate in the Column to
Column filter.
2. Then select the newly added filter (or Aggregate Filter) on the
reports Filters Tab.
3. Press the Properties button on the Toolbar.
4. Scroll down on the properties window to the property Filter Type.
Change the Filter type from Normal Filter to Column to Column
Filter and click Apply.
5. The Property screen will update and the Comparator property will
now be a drop down box of the available columns to Compare
with.
6. Choose the column to compare with and apply the changes.
For a Column to Column filter the property window should look like this:

Note that should you wish to export a report that uses a Column to
Column filter, then on import thereof you have to reset the column to
column filter . This is due to the fact that the expression ID on the column
before export will not be the same as the expression ID on that same
column after import.

Home > Report Manager > Working with Reports > Editing Reports > Report Filters > Change order of
Filters

Change Order of Filters
Changing the order of Filters enables the user to pre determine the order
in which the Filters are applied when running the report. To change the
order of Filters for reporting, select the Filter that you would like to move.

Use the Move Up
or Move Down
buttons to change the
order of your filters. Alternatively Drag and Drop the Filters into order.

Using Variables in Other Report Properties
Variables (System and Pass Through) variables can also be used in
certain properties on a report to dynamically effect them when a report is
run. Some scenarios where this might be useful are listed below:
Example 1
You are specifying an output file in the “Generate Output File” property on
a report and you want the file name to not be totally hard coded but to be
effected by the System Variable such as the today’s date (@DATE@).
In the “Generate Output File” property specify a file name such as
C:\MyReports\Sales_@DATE@.xls
Whenever the report is then run a copy will be saved with the name
“Sales_” plus the date.
Example 2
You are specifying an output file in the “Generate Output File” property on
a report and you want the file name to not be totally hard coded but to be
effected by a Pass Through Parameter on the report named
@REGION@
In the “Generate Output File” property specify a file name such as
C:\MyReports\Sales_@REGION@.xls
Whenever the report is then run a copy will be saved with the name
“Sales_” plus the Parameter specified for the @REGION@ pass through
variable.

Example 3
You are using the PublishSheet Add-In on a report to publish to an HTML
output file using the “Run Add-Ins” property on the report. You want the
HTML file name to be effected by a Pass Through Parameter on the
report named @REGION@
In the “Run Add-Ins-” property specify something similar to this :
PLPLUGA.C.PublishSheet(Pivot,\\myserver\intranet\reports\Sales_@REGION@.htm
Whenever the report is then run a copy will be published with the name
“Sales_” plus the Parameter specified for the @REGION@ pass through
variable.

Example 4
You are using the EmialSMTP Add-In on a report to email the report
using the “Run Add-Ins” property on the report. You want the Email
address to be dynamic based on a Pass Through Variable that is entered
at run time. The pass through variable is named @EMAILTO@
In the “Run Add-Ins-” property specify something similar to this:
PLPLUGA.E.MailSMTP(MySMTPServ13,@EMAILTO@,me@myservo.qq,Your
Sales Report,Please see attached file.,1,Report.xls)
Whenever the report is then run a copy will emailed to the email address
specified in the parameter for the pass through variable @EMAILTO@
Example 5
You have written a macro into your reports template file in Excel that
requires a Sales Rep to be passed in at Run time. The Macro is called
AnalyseSalesRep and takes one parameter for the Sales Rep Code. You
have defined a Pass Through Variable in the container and on the report
called @SALESREP@ that you wish to pass in to the Macro so it can
perform some specific logic.
In the “Run Macros” property specify something similar to this:
AnalyseSalesRep(@SALESREP@)
Whenever the report is then the Macro will receive the selected Sales
Rep code and execute.

Home > Report Manager > Working with Reports > Editing Reports > Report Parameters > Add or Remove
Parameters

Add or Remove Parameters
Adding or removing Parameters enables the user to refine or limit the
rows of data that will be displayed in the report based on Run Time user
selections.
Add or remove a Parameter from your report:
1. Select the report where you want to add or remove Parameters and click
the Parameters Tab.
2. The existing Parameters that you have selected will be displayed.

3. To add a Parameter, click on the Add button
Filter Field dialog box will appear.

, the Choose

4. Select the Filter Field you would like to add as your Parameter and click
OK.
5. The Choose Comparison Method dialog box will appear.

6. Choose your comparison method and click OK.
The Enter an Optional Default for the Parameter dialog box will
appear.

7. You may now either:
Enter your Optional Default value in the field provided, or
Use the lookup button
Value, and click OK.

to search for an Optional Default

8. Note: The Lookup facility will only be available if it has been enabled
in the Connector for this expression. See Add Data Expressions.
Use the Select System Variable button to view a list of System
Variables, and click OK.

Note For further information about System Variables see System
Variables.
9. The new Parameter should now appear on the Parameters tab.
To remove Parameters, select the Parameters that you would like to
delete and click on the Remove button.

Home > Report Manager > Working with Reports > Editing Reports > Report Parameters > Edit Parameter
Properties

Edit Parameter Properties
To edit the properties of a Parameter, select the Filter you want to edit
and click on the properties icon . The Properties window will be
displayed.

Enter your amendments in the active fields provided. Click here for help
on using Comparison Operators.
Check Box Option

Description
By default when multiple filters
are used on a report they are
applied using Boolean AND
logic. So for data to satisfy
filters with AND logic all the
filters must evaluate to true.
When OR logic is used only
one of the filters needs to
evaluate to true.

Where complex Boolean Logic
is needed for combing filters
that use combinations of AND
and OR logic then logic
breakers can be used to group
filters together. Use this setting
to prefix the filter with a logic
breaker.
Where complex Boolean Logic
is needed for combing filters
that use combinations of AND
and OR logic then logic
breakers can be used to group
filters together. Use this setting
to suffix the filter with a logic
breaker.
When you have entered your selections click on OK.

Home > Report Manager > Working with Reports > Editing Reports > Report Parameters > Change order
of Parameters

Change Order of Parameters
Changing the order of Parameters enables the user to pre determine the
order in which the Parameters are prompted for when running the report
and also the order in which they are logically applied to limit the reports
rows. To change the order of Parameters for your report, select the
Parameter that you would like to move.

Use the Move Up
or Move Down
buttons to change the
order of your Parameters. Alternatively Drag and Drop the Parameters
into order.

Home > Report Manager > Working with Reports > Editing Reports > Sorting > Add or Remove Sort
Fields

Add or Remove Sort Fields
Sorting fields enables the user to pre determine the order of the data
rows in the report.
Add or remove Sort Fields:
1. Select the report where you want to add or remove sort fields and click
the Sort Fields Tab.
2. The Sort Fields that you have selected will be displayed.

3. To add a Sort Field, click the Add button
Fields dialog box will appear.

, the Choose Sort

4. Select the Sort Field you would like to add and click OK.

You have now successfully added a sort field to your report.
To remove a sort field, in the Properties Window, click the Sort Field you
would like to delete and click the Remove
button.

Home > Report Manager > Working with Reports > Editing Reports > Sorting > Change order of Sort
Fields

Change Order of Sort Fields
Changing the order of Sort Fields enables the user to change the
precedence of the Sort Fields in the report. The Sort Field which has the
highest precedence is applied first and then all subsequent Sort Fields
are applied as a sub-sort within the preceding sort operation.
For example choosing two Sort Fields, the first being Surname and the
second being First Name will sort rows by Surname and then by First
Name. To change the order/precedence of Sort Fields for your report,
select the Sort Field that you would like to move.

Use the Move Up
or Move Down
buttons to change the
order of your Sort Fields. Alternatively Drag and Drop the Sort Fields into
order.

Home > Report Manager > Working with Reports > Editing Reports > Sorting > Change Sort Field
Ascending

Change Sort Field Ascending/Descending Order
Changing the Sort Field ascending/descending order changes the Sort
Order of the Sort (e.g. descending on text would sort alphabetically from
Z to A). To change the order of your Sort Field from Ascending to
Descending or vice versa, select the Sort Field you would like to amend
(Note: An arrow pointing upwards indicates an ascending sort order)

Click the Asc/Desc button
to toggle between Ascending and
Descending sort order.
(Note: The arrow will point downwards when the sort order is changed to
descending.)
You have now successfully changed the Sort Order of your Sort Fields.

Home > Report Manager > Working with Reports > Editing Reports > Aggregate Filters > Add or Remove
Aggregate Filters

Add or Remove Aggregate Filters
Adding or removing Aggregate Filters enables the user to refine or limit
the rows of data that will be displayed in the report based on aggregation
criteria (equivalent to a HAVING clause in SQL).
To add or remove Aggregate Filters from your report, select the report
where you want to add or remove Aggregate Filters and then click the
Aggregate Filters Tab.
Add filters:
1. Click on the Add button
The Choose Filter Field dialog box will appear.

2. Select the Filter Field you would like to add to your report and click
OK.
3. The Choose Comparison Method dialogue box will appear.

4. Choose your comparison method and click OK.
The Enter Comparison Value dialog box will appear.

5. You may now either:
Enter your Comparison Value in the field provided, or
Use the lookup button
Values, and click OK.

to view a selection Comparison

Note: The Lookup facility will only be available if it has been enabled
in the Connector for this expression. See Add Data Expressions.
6. Use the Select System Variable button
Variables

to view a list of System

Note: For further information about System Variables see System
Variables.
7. The new Aggregate Filter should now appear on the Aggregate Filters
Tab with a default Aggregate Function of Count. To change the

Aggregate Function select the Aggregate Filter and on the Toolbar
select the Properties button. Select the Aggregate Function and click
Apply.
To remove filters, in the Properties Window, select the Filters that you
would like to remove and click the Remove button.

Home > Report Manager > Working with Reports > Run a Report > The Process Monitor

The Process Monitor
The Process Monitor window will be displayed at the base of your screen
and will show all running report processes. Each report that is run
executes as a new process.
For problematic reports that are taking too long to run and that cannot be
cancelled use the process monitor to cancel (or kill) the report process.
Using the Cancel facility on the process monitor should be a last resort to
end a report.

The Process Monitor is only visible when running reports from the Report
Manager.

Home > Report Manager > Working with Reports > Run a Report > Running a Report with Parameters

Running a Report with Parameters
To run your report with Parameters, click on the Run Icon
which will
activate your report. The parameter prompt window will automatically be
displayed.

You may now either:
Enter your selection in the field provided or
Use the lookup
(where available) to search for a selection, and click
on OK.
Note: The Lookup facility will only be available if it has been enabled
by the System Administrator for this expression. See Add Data
Expressions.
Also refer to Defining Parameter Lookups for more information on the
lookup facility.
Once your data has been retrieved, Sage Accpac Intelligence will
automatically open an Excel workbook to display your data.

Home > Report Manager > Working with Reports > Run a Report > Editing a Report Template

Design
The Design feature allows you to format an Excel template that is
attached to a report without having to run the report with all the data
coming though . It is only active for reports that have an attached
template.
1. In the Report Manager Module, Select the report you would like to
make design changes to, and right click on the report and select Design
or, Select the Design Icon

from the Toolbar.

2. The following message box will open:

Select Yes. Your Template will then open

3. Make your desired changes and save the workbook/template.
For example, add company logos, change font, color etc. You can
then create and link your newly designed template. These changes
will then be included in your template when you next run this report.

Home > Report Manager > Working with Reports > Run a Report > Advanced Options

Advanced Options
Using advanced options enables a user to apply advanced settings to a
report.
To enable the Advanced Options Menu on the Report Manager Interface
you must check the Show Advanced
check box.

To enable the advanced features for your report you will need to check
the box alongside the advanced option you wish to enable. The
Advanced Options features and their respective functions are as follows:
Advanced
Option

Description

Parameters on
Second Sheet

Report Locked

An option to place the report runtime
parameters on Sheet2 of the exported
Microsoft Excel report. This could be very
useful when Microsoft Excel formulas as per
the actual report design depend on certain
critical variables on Sheet2.
An option box to lock all Report Manager
property fields of the selected report. Once it
and the Apply button is selected, the user will
be prompted to enter a case sensitive unlock
password (entered twice to confirm).
All tabs of the report (Properties, Filters,
Columns etc.) will then be unavailable and no
changes are further allowed.
When changes need to made, the following
need to be done:
In the Report Manager, right click on
the relevant report and click Unlock.
Enter the correct password and click
OK.
All property tabs and their fields will
now be available again.

Show Distinct
Rows
Top Rows
(Leave blank
for All Rows)

Automatically
Format First
Sheet

An Option Box to ensure that no duplicate
records are exported.
Enter a numerical value of how many records
(rows not including the heading row) should be
exported, in accordance with the current report
sort options.
Ensures that, among others, any previous
column row height or width changes made on
Sheet1 of the relevant Microsoft Excel
Template file are disregarded when the report
is exported to the relevant Microsoft Excel

Template file.

Hide the
Source Data in
Report

An option box to ensure that the first
worksheet of the exported Microsoft Excel file
is automatically hidden.
If no other security restrictions are in place,
then it may still be possible to right click on any
worksheet tab at the bottom of the exported
Microsoft Excel file and select Unhide to open
the Unhide screen to unhide any specific
automatically hidden worksheets from the list.

An Option Box to ensure that the exported
Microsoft Excel file is read-only and not
editable by unauthorized persons.
This is disabled by default for performance
Retain All Run
reasons. Saves report run instances for audit
Instances
purposes.
This is disabled by default for performance
Keep Original
reasons. This saves a runtime snap shot of a
Instance Audit
report for audit purposes.
Insert the name of a Microsoft Excel macro
that is linked to the selected report’s linked
template file. The moment the report has been
Run Macros On
exported successfully to Microsoft Excel, the
Completion
specified macro will also execute on it. If there
is more than one macro that needs to be run
then separates their names with semi-colons.
Use the browse button on the right to select
relevant add-ins to link to the selected report.
Reports can be exported to numerous other
mediums besides Microsoft Excel, and the
Run Add-ins
ability to execute a number of actions upon
report runtime is available. These are all
referred to as Add-ins and in detail discuss
later in the manual.
Use the browse button on the right to specify
Protect the
Output Book

Generate
Output File

Close book on
Completion
Clear
Additional
Ranges on
Create and
Link
Clear Ranges
on Export

the location and Microsoft Excel file name that
need to be created alternatively to the normal
Microsoft Excel exported file, when the
selected report is run. Having a value here will
therefore not export the report in the name
format: TEMPLATE1, but instead in the
specified file name.
E.g. If you don’t have a Generated Output File
value upon report runtime, then, if the selected
report’s template file is called XYZ then the
exported file name will be called XYZ1.xls.
Else with the Generate Output File value in
place then the specified file name will be
created.
An option box to ensure that the Microsoft
Excel Workbook is closed after running a
report.
Data in all the Raw Data sheets get cleared
when an Excel book is linked to a report. If any
additional ranges need to be cleared, name
these ranges in this property.
Ranges are cleared when the report is
exported.
An Option Box to hide the selected report from
the Report Folder. When this option and the
Apply button have been selected, the report
will suddenly disappear from the Report
Manager interface.
To show hidden reports again, do the
following:
1. Right click the Home object.
2. Select the option: Show Hidden
Reports.

Report Hidden

3. Double click on the relevant Report
Folder to refresh it and the hidden
report will re-appear, although its hide
property setting is still selected.
4. You can now either deselect the
Report Hidden option on the Property
tab to make it permanently available
again, or decide to hide it any ways
again by right clicking on the Home
Object and selecting the Do Not Show
Hidden Reports option. Double click
then on the Home object or relevant
report folder to refresh the views.

Make Available
in Menus
Unlock Report
on copy
Requires
Report
Designer

An Option Box to make the selected report
available from the front end of Sage Accpac
Intelligence.
Unlocks the report when the report is copied,
thus keeping the original intact.
Indicates that this report has the functionality
built into it to take advantage of the Excel
Report Designer plug-in to auto generate
report layouts.

To hide the Advanced Option menu simply uncheck the Show Advanced
check box
.

Home > Report Manager > Working with Reports > Run a Report > Clear additional ranges

Clear Additional Ranges
When an Excel book is linked back to a report (via Create and Link
function), Sage Accpac Intelligence clears out the data for all the Raw
Data Sheets (for a standard report this is always the first sheet, for Union
Reports it is the sheets specified for each Union Child report).
If there are any other ranges that you would like cleared whenever the
Create and Link function is used then you can name these ranges in this
property and the ranges will be cleared each time the book is linked.

Home > Report Manager > Working with Reports > Run a Report > Report Viewer

Report Viewer
Users who have been given access to Report Viewer can run various
reports using this tool.

In the Report Manager, when a report is selected as Make Available via
Report Viewer it is available for selection via the Report Viewer.

The description as added in the Report Manager is therefore very
important as this description will be displayed in the Report Viewer:

Home > Report Manager > Working with Reports > Advanced Importing and Exporting

Importing and Exporting Reports
Sage Accpac Intelligence facilitates the easy transfer of information using
simple yet powerful import and export procedures which enable the user
to easily share information across installations. Using this facility, Reports
can be created in one Sage Accpac Intelligence system and distributed to
other Sage Accpac Intelligence systems.
Note that reports can be exported in a compressed file format, which in
this case creates a .AL_ file.
To export Reports see Exporting a Report.
To import Reports see Importing a Report.

Home > Report Manager > Working with Reports > Advanced Importing and Exporting > Bulk import

Bulk Import
This operation allows for the bulk importation of new reports that are
obtained either from newer versions of Sage Accpac Intelligence or from
existing reports.
When doing a bulk import of new reports, current reports and
settings are not deleted. The intention of bulk imports is to import
new reports into the current metadata repository only and not
modify current versions of reports and settings that were created
and saved prior to the bulk import.
To run the bulk import :
1. Open your Report Manager.
2. Click Bulk Import/Update Reports either on the Tools menu or
by right clicking on the Home icon in the Object window.

3. You will need to place any .al_ files that will be bulk
imported/updated into their relevant subfolders as per the
instructions that appear within the ‘Bulk Import/Update Reports’
dialog form, if not a new folder will automatically be created in the
Report Manager for the new imported reports.

4. Once the files are in the correct location, click YES to proceed.
5. The new reports will be imported alongside any existing reports, if
desired old reports may now be removed via the report manager.

Home > Report Manager > Working with Reports > Advanced Importing and Exporting > Exporting
Reports with Protection

Exporting Reports with Protection
If you are running a Solution Developer License of Sage Accpac
Intelligence, then it is possible to protect your packaged export files for
redistribution. This allows you to protect your intellectual property from
others while still allowing you to distribute and deliver your reports to
other Sage Accpac Intelligence installations.
Protection happens at the Container and Container Expression level.
Containers can be protected with a number of options. The Export
Options screen for the Solution Developer is shown below. This screen
only appears if you are the creator of the container (Container Owned by)
used in a report that is being exported.

The export protection options are explained below.

Export File Usage Options
The concept of Container Usage exists so that report writers can restrict
who can import their reports.
See the options available for Usage below:
1. Allow anyone to import and export for re-distribution Selecting this option will allow the export file to be imported by
anyone. Use this option when you are not concerned about the
file being shared.
2. Allow anyone to import and export but not export for redistribution - This option will create an export file that can be
imported by any company. On import though the container
created will be stamped for usage just by the company that is
importing it. Any reports connected to the container that are later
exported by the company can only be re-imported by that same
company. This option is best suited for export files that will be
made available on the Community.
3. Allow only this named Company to import the file - This
option provides the most secure way to re-distribute your reports
however it does require that you export a report every time you
need to send it to a company.

Container Ownership in Destination System Options
The concept of Container Ownership exists so that report writers can
protect their intellectual property, most commonly for re-sale of reusable
reports. The Company which has Ownership should not be confused
with the Company that is licensed for Usage. Only under special
circumstances should you change Ownership of your Containers.
See the options below for Ownership:
1. Retain Existing Ownership - This is the default option and
should be left as this to keep ownership of your Container
intellectual property in all Sage Accpac Intelligence systems
which receive your reports.
2. Remove Creator Ownership from Container - Use this option
when do not wish the created Container in destination systems to
have an owner.
3. Allow destination system to take over Ownership - Use this
option only when you wish to transfer the ownership of your
intellectual property to the receiving company. Note that all
companies that receive the export file will assume ownership of
the container on import.
4. Change Owner to named company at Import - This option
allows you to explicitly name the Company that will assume
Container Ownership at import. This option should be used when
you wish to transfer ownership of your Container intellectual
property to a named company.

Protection within Destination System Options
Sage Accpac Intelligence allows the intellectual property that exists in
Containers to be protected. Protected containers can be used in
destination systems but the details of the Container are not accessible.
Where a large amount of IP is contained in a container (e.g. complex
SQL Joins and SQL Expressions) then these details can be hidden by
using these protection options.
The protection options available are:
1. Lock Container in destination system(s) - This will hide the
Source properties of the Container in the destination system and
not allow it to be edited. Only protecting at this level will mean
that Expressions can still be added, edited and deleted.
2. Lock Expressions in destination system(s) - This will hide all
the properties of all the Expressions in the Container in the
destination system. Expressions cannot be added, edited or
deleted in the Container when this option is selected.
For maximum protection of your Container IP select both of these options
on export.
Note that it is possible to perform an unlock of a Container and its
Expressions in a system with the assistance and authorisation of the
Container Owner. See the topic Unlocking a Container and its
Expressions for more details.

Home > Report Manager > Working with Reports > Advanced Importing and Exporting > Importing a
Report licensed to another Company

Importing a Report That is Licensed to Another
Company
Sage Accpac Intelligence Report Developers that have protected their
Intellectual Property through the Sage Accpac Intelligence Container
Protection paradigm can authorise a third party to be able to import a
report that has been licensed to a different End User Company.
This is useful where the company that is licensed to use the Report
outsources changes to that report to a third party. In this case the third
party would need to obtain a unique Handshake Pin Code from the
Report Developer (Container Owner). This pin code is a unique code
that allows the third party to import any reports created by the Report
Developer but licensed to the End User. This mechanism allows reports
to be sent to a third party, changes to be made and then sent back to the
licensed End User.
A Report Developer uses the Authorise Remote Report Import menu
option on the Sage Accpac Intelligence Enterprise object in the
Connector to generate unique Handshake Pin Codes. After entering the
Licensed User (Sage Accpac Intelligence Registered Company Name)
and the receiving Third Party (Sage Accpac Intelligence Registered
Company Name) a unique Handshake Pin Code is supplied.
Since the authorisation must come from the Report Developer (Container
Owner) the relationship is a trusted one and prevents abuse of the
Report Developers intellectual property.
When a third party that tries to import a report that is licensed for use by
a different Company they will receive an Import Authorisation screen.
To continue with the import at this point a valid Handshake Pin Code
must be entered. This Handshake Pin Code must be obtained from the
Report Developer. The Import Authorisation screen is shown below.

Report Scoping
Sage Accpac Intelligence uses a metadata repository to store all its
metadata, including connection, container and report information.
Since a site may have more than one set of company data (e.g. a holding
company that has 5 separate companies) it may be necessary to have
some reports that are specifically for one, for multiple or for all of the
companies. In this scenario it may be useful to make certain reports
visible only when logged in to a given company. For this Sage Accpac
Intelligence provides the concept of Scoping, where a report can be
‘scoped’ or made available only when logged in to certain companies. A
report that deemed useful across all companies should be Scoped
Globally (this is the default for each report).
The most common scenario where a report would be Scoped is probably
where Financial Reports are customized. Since customizing these
reports usually involves keeping a set of account numbers in a report’s
excel template, these customized reports become only useful to the
company they have been customized for.
In this scenario best practice to customize one of the standard
shipped Financial Reports would be to:
1. Make a copy of the Standard Report.
2. Name the report accordingly (e.g. “Financials for Company ABC”
where the company is ABC).
3. Open the Scope Manager by clicking on the Home Object and then
from the Tools Menu bar, select Manage Object Scope and specify the
scope of the report to the relevant company (e.g. company ABC or
Systems of America).
4. Customize the report using Excel and Report Manager as per usual
processes for Financial Reports.

Home > Report Manager > Working with Reports > Advanced Reports > SubQuery Reports

Sub Query Reports
A Sub Query report is used to generate a list of items that is then used in
a filter of an outer parent report.
An example might be where a Sub Query report is first used to generate
a unique list of customer codes whose purchases to date sum to a value
larger than $1000. The outer report might then want to pull out
information on what cars these same customers drive from a different
container but specifically for the Customer subset generated by the Sub
Query report. A Sub Query report always only has one Display field so
that a parent Report can reference it in a filter.
The logic for the above example in English might read:
Give me the Cars that my Customers drive, and only show me the this
information for those customers that have spent more than $1000 to
date.
In the Structured Query Language (SQL) this would read something
like this:
SELECT Customer.Name, Customer.Car FROM Customer
WHERE Customer.Code IN
(SELECT Sales.CustomerCode FROM Sales
GROUP BY Sales.CustomerCode
HAVING SUM(Sales.Amount) > 1000)

In Sage Accpac Intelligence to achieve this same effect you could:
1. First create a Sub Query Report (right click on a folder > Add Sub
Query Report) called Big Spenders using the container Sales,
with the Display Field CustomerCode, and an Aggregate Filter
on Amount with Comparison Operator Greater Than,
Comparator 1000 and Aggregate function SUM.
2. Then create an ordinary report using the container Customer
with Display Fields Name and Car and specify a filter using the
expression Code, Comparison Operator Is In SubQuery and
SubQuery Big Spenders.

Home > Report Manager > Working with Reports > Advanced Reports > Union Reports

Union Reports
A Union Report is used to merge rows of data from disparate sources
into a single a report. The Union Report has pointers to other normal
Reports and it simply runs out the raw data from the specified Reports
(referred to as Union Sub Reports when referenced in a Union Report)
sequentially into a single Workbook. The Union Report can have its own
template file specified and the template files of the Union Sub Reports
are not used.
To create a Union Report:
1. Right click on a Folder and choose Add Report. Choose Union
Report.

2. You will be prompted for the reports to include as Union Sub
Reports in the Union Report.
3. Choose one or more existing reports.
To add subsequent Union Sub Reports to the union report:
1. Double click on the Union Report.
2. Select the object Union Sub Reports.
3. Right click and select Add Union Sub Reports.
It should be noted that a Union Report will simply pull the raw data from
all Union Sub Reports and sequentially output the data sets into the
Output Book. All properties set on the source reports are ineffective when
they are run as Union Sub Reports in a Union Report. All filtering and

sorting logic is applied to each Union Sub Report before it is output into
the Union Report Template and the logic between Union Sub Reports is
unrelated.
Note: By default the data from the Union Sub Reports will be output into
the same worksheet. This behavior can be overridden though by setting
the Output Sheet property for the individual Union Sub Reports.
To do this:
1. Open up the Union Report in the Object window (by double
clicking).
2. Open the Union Reports object so that the individual Union Sub
Reports become visible.
3. Select each Union Sub Report and then set the Output Sheet property to
the number of the Sheet to output the data to (e.g. 1 for the left most
sheet in the book).

Note that the specified output sheet must exist in the Union Reports
output template.

If the data is configured (or defaulted) to the same sheet for the Sub
Reports then it makes sense that the data is comparable. Although you
could specify any reports to be the Sub Reports for the Union Report, it
only makes sense to specify Union Sub Reports that have comparable
data and with the corresponding Display Fields laid out in the same order
in all the Sub Reports to go to the same Output Sheet, so that in the final
Workbook there is like data in each column. If the data is not similar then
it should be output to different sheets.

Home > Report Manager > Working with Reports > Advanced Reports > Financial Reports

Financial Reports Pack
The Financial Reports is one of the many standard reports that ship with
Sage Accpac Intelligence but probably the most complex due to its wide
functionality scope.
Simply put, the Financial Reports embodies a collection of different
formatted Balance Sheet and Income Statement reports as run for at a
specific period in addition to multiple period trial balances.
There are many standard types of Financial reports:

Accessing the Financial Report
By default the Financial report can be found in the Report Manager in the
Financials folder, Financial Reports .
Note: You can create as many different layouts as required to complete
your report set within this workbook.

Selecting a reporting date: (Change Month)
A reporting date is the date which controls the display of values on any
layouts you have generated within the workbook. Example: If it is now the
month of September, and you wish to have the Income statement display
values to the end of August, then by selecting the reporting date as
August, you would achieve this.
To select a reporting date:
Excel 2003:
a. Click on the Change Month button located on the toolbar
at the top left of your Excel screen, above the name box.
b. Click the downward arrow and select the month to view.
Excel 2007:
a. Click on Add-Ins on the menu bar, then click on Change
Month on the Custom Toolbar.
b. Click the downward arrow and select the month to view.
NOTE: The reporting date is totally separate to the period range chosen
at run time. The period range chosen at runtime, only has an effect on
the transactions that are displayed when using the Drill Down Account
Feature and has no effect on the display of values on generated layouts.
See "Using the Drill Down Account Feature".
Cannot find the toolbar to change the month:
1. Excel 2003: Press Alt-F8 (or Select, Tools, Macro, Macros, from the
menu bar).
Excel 2007: Press Alt-F8 (or Select Developer, then Macro from the
menu bar).
2. Select the macro named Build FA toolbar.
3. Click the Run button to run the macro.
4. The toolbar should now be visible again.

Adding New Accounts to your existing report layouts
If you have added new accounts into your general ledger within your
accounting system, then the next time you run this report Sage Accpac
Intelligence will synchronise the new list of accounts it extracts from your
accounting system with the chart of accounts already listed on the
Lookup sheet within this workbook. If it finds any difference between
them, then Sage Accpac Intelligence will prompt you as follows:
1. To add the new accounts it has detected to the Lookup sheet - in
which case you select YES.
2. To highlight any accounts it finds that no longer exist within your
accounting system by shading the account number in red - say
YES.
Once this has been done you will then need to link these new accounts to
the required report layouts you have included in the workbook. The new
accounts will be placed below the last account displayed on the Lookup
sheet.
The instructions below will assist you with this process:
1. You may leave the new accounts (green shaded account
numbers) exactly where they appear on the Lookup sheet.
2. Select the sheet that contains the layout to which you wish to Add
the New Account.
3. Select the row where the first New Account should be inserted.
4. From the Menu Bar:
Excel 2003: Choose Report Tools > Add Accounts. A list
of accounts that are not in the layout should appear.
Excel 2007: Choose Add-Ins > Report Tools > Add
Accounts. A list of accounts that are not in the layout
should appear.
5. Use the Type drop down to filter by Account Type (for example
Income Statement/Balance Sheet) and the other filter text boxes
to help locate the specific accounts.

6. Select the accounts that you wish to insert at the specified row
(Note: you can select a different row in Excel while the Add
Accounts form is active).
7. Click the Insert button. The accounts will be inserted at the
specified row and the formulae for the rest of the row added.
8. Click the Cancel button once all accounts have been inserted.
Note: The Add Accounts function has to have a row to copy formulae
from. By default it assumes the row above the row that is being copied
into. If this row does not contain the formulae that references back to the
Lookup Sheet then the insert will not pick up the formulae. It is important
to note that if the row above the Insert At Row does not contain the
correct formulae then you must press the previous button to navigate to
the Copy From Row dialog and select the row that contains the correct
formulae.
Deleted Accounts:
The accounts highlighted with red shading on the lookup sheet represent
the accounts which have now been deleted from your accounting system.
If you leave these accounts on the Lookup sheet then each time you run
the report, Sage Accpac Intelligence will detect these accounts and
prompt you once again to highlight them. If they are already highlighted
then you can ignore the prompt by selecting NO.
To prevent this prompt on these accounts each time you run the report,
you will need to remove them from the Lookup sheet.
Remove the deleted accounts as follows: On the Lookup sheet, it is best
to delete only the account number, then delete the blank row which will
appear on the report layouts where this row is linked.
Using the Drill-Down Report Tool:
This report has been setup with a pre-defined Drill Down definition
enabling you to drill down to a selected general ledger account.
To drill down to the General Ledger Transactions you would require
access to the Sage Accpac Intelligence report named "GL Transactions
by Account". Ensure that this report is available in the Report Manager.
1. To use this pre-defined Drill Down Definition, click on any cell in a

row that has an account no present in column A, on any Income
Statement or Balance sheet within the workbook.
2. From the Excel Menu bar:
Excel 2003: select Report Tools.
Excel 2007: select Add-Ins > Report Tools.
3. Then select Drill Down.
The Select Drill Down window will display, showing the pre-defined
definition which contains the definition code of GL_001. Ensure that
this pre-defined definition is highlight in blue (click anywhere on the
line if not highlighted).
Click the Execute button.
The GL Transactions by Account report will run and display in its own
window for you to view.
4. This pre-defined Drill Down Definition will always drill down to
one period, being the period relating to the month currently
selected in the workbook. To drill down to a different period, use
the Change month button first to select a different month, then
execute the drill down definition.
Note: The Drill Down Report Tool is only available in Excel if Sage
Accpac Intelligence is installed on the PC.

Home > Report Manager > Maintaining Reports > Locking Unlocking a Report

Locking/Unlocking a Report
Locking freezes the properties of a report so that it cannot be modified.
Users can then only run the report. To lock a report, select the report that
you want to lock.

1. Click the Lock button
to lock your report. You will be promoted for
an unlock password and the report properties will immediately be
unavailable
2. Click the Unlock button
to unlock your report, the report properties
will immediately be available upon entering the unlock password set in
step 1.

Home > Report Manager > Maintaining Reports > Close Book on Completion and Generate Output File

Close Book on Completion and Generate Output
File
Sage Accpac Intelligence allows you to automatically close your Excel
workbook on completion of your report and to save the report to a fixed
file in a designated folder. This is useful when a report needs to be run to
a centralised location on a regular basis or when the report is being run
as part of a report batch.
To do this, enable the Advanced Options Menu on the Report Manager
Interface by checking the Show Advanced
check box.
Use the browse
button on your Generate Output File property filed to
browse to a folder and name the output file. Type the name of your file
and click on the Save button. When you refresh your report, your Output
file will be displayed in the Generate Output File property field.

To automatically close your work book on completion of your report,
ensure that you place a check in the
check
box.

Home > Report Manager > Maintaining Reports > Using Add-In Functions in a Report

Using Add-In Functions in a Report
Sage Accpac Intelligence supplies Add-In’s that further enhance Excel’s
reporting capabilities. These Add-Ins are designed to tackle common
problems that come up during reporting. The list of available Add-In
Functions is regularly updated so for the most comprehensive list of
functions update your software on a regular basis.
To use an Add-In function on a report do the following:
1. Select your report.
2. Place a check in the Show Advanced option checkbox.
3. Press the lookup button next to the Run Add-Ins field.
4. An Add-In function selection screen will appear. Once selections have
been made, the screen appears as shown below:

5. Start by selecting the Add-In Library.
6. A list of Modules for the selected library will then become
available in the Select Add-In Library Module drop down box.
7. Select a Module.

8. A list of Add-In functions will then be displayed in the Select AddIn list.
9. To see a description for a Function you can select the function
and view the description on the right hand side.
10. Once you have chosen your Add-In function click OK.
11. A screen will appear for specifying the relevant Function Parameters, as
shown below:

12. Specify your Function Parameters and click OK.
13. The Add-In function should now appear in the reports Run AddIns property field.
Whenever this report is run the Add-In will now be executed. To edit the
parameters of an Add-In function that has been specified already simply
click the Add-In Function Builder button next to the Run Add-Ins box on
your report properties and select the Function that you wish to edit, then
follow the same steps as above.

Add-Ins placed in the "Run Add-Ins" property field will always run
before any macros placed in the "Run Macros on Completion"
property field.
Should you wish to have an Add-In run after a macro, then either
place the Add-In in the "Run Macros on Completion" property
field after the macro name or, place the macro name in the "Run
Add-Ins" property field before the Add-In.

Home > Report Manager > Maintaining Reports > Running Macros

Run Macros
If a report template that you have created contains macros that you wish
to use each time the report is run, then type the names of the macros you
wish to run in the "Run Macros on Completion" property of your report.
To do this, enable the Advanced Options Menu on the Report Manager
Interface by checking the Show Advanced
check box.
Type the name of your Macros in the "Run Macros On Completion"
property field and click on the Apply button.
The Macros in your report template that have been specified will now be
run every time that the report is run.
If there is more than one macro that needs to be run then separate their
names with semi-colons.
If a Macro takes parameters then place these in brackets after the macro
name in a comma separated list.

Macros will always run after any Add-Ins should you have any Add-Ins
placed in the "Run Add-Ins" property.
Combine macro names and Add-Ins in the same property to ensure the
correct order thereof when running the report. Example: To have a
macro run before an Add-In, place the macro name in the "Run AddIns" property before the Add-In.

Creating new Macros from Excel
1. Open your Report Manager.
2. Select the report that you want the macro to run in, run the report or
open the Excel template.
3. Create the macro you want to run automatically, ensuring that in your
macro you specify which sheet you need the macro to work in. (This
will help by forcing the macro to select the correct sheet even after you
Create and Link the workbook with a different active sheet)

4. Once you have created and tested your macro, save the template back or
create and link the workbook back to the report.
5. Highlight the report in which you have created the macro, under the
Properties tab, tick the Show Advanced option at the bottom of the
screen.
6. In the advanced options list that is now available, locate the Run
Macros on Completion option.

In the text box type the name of the macro you created.

Home > Report Manager > Maintaining Reports > Add Dataless Report

Add Dataless Report
Sage Accpac Intelligence allows a user to Add a Dataless Report for the
purpose of consolidating data from various sources. The Dataless report
does not access any database but rather activates an Excel workbook
that contains Macros designed to consolidate information from
workbooks that you have stored previously in other reports. The Dataless
report will usually contain some advanced bespoke Macros which will
perform a consolidation or reconciliation of some type. The Dataless
Report is not to be confused with the Picklist Functionality. Picklists allow
you to consolidate data from same and disparate databases.
Typically you will link your Dataless report to an Excel workbook that
contains macros that references other workbooks that store your
information.
To create a Dataless report:
1. Right click on the Report folder.

2. Select Add Dataless Report.
3. Enter a name for the Dataless report in the dialog box and select OK.
4. Notice the Report button

, indicating that it is a Dataless Report.

5. You will then need to link the Dataless report to an Excel book that
contains the functional macros.
To do this: Open the Excel workbook, then from the Report Manager,
use the create and link template function to link the workbook as a
template file.

Home > Report Manager > Maintaining Reports > Run All Reports In Folder

Run All Reports in Folder
The Run Report Batch facility allows users to run a sequence of reports
one after the other from top to bottom.
The option Run Report Batch aborts the batch of reports if any of the
reports return no data. The second option Run Report Batch (Mode 2)
will run all reports regardless of there being no data for any of the reports.
Note: The run sequence will always be top to bottom so it is important to
name your reports in a way that will ensure that the report you want run
first is at the top of the batch.
For example: if you have an existing group of reports in a folder which will
not run in the sequence that you would like, then rename your reports
numerically viz:
Report Name = 1. (First Report)
Report Name = 2. (Second Report)
Report Name = 3. (Third Report) and so on until you have the
reports running in the sequence that you would like.
Once you have named your reports in sequential order, select the folder
that contains your reports, right click and select Run Report Batch or
Run Report Batch (Mode 2).
Sage Accpac Intelligence will automatically run each report in sequence.
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Scheduling a Report
Sage Accpac Intelligence reports can be run unattended, from Operating
System batch files or under the control of external scheduling
software(such as the Microsoft Windows Scheduler or the Microsoft SQL
Server Agent). This can be useful when you have certain reports that you
need to run on a regular basis.
When reports are run unattended they are automatically closed on
completion. Scheduled reports must use the Generate Output File in
the Advanced report or the Retain All Run Instances option to be
useful. See Advanced Report Properties for more information.
Typically reports that are scheduled will have the Generate Output File
property set so that the unattended reports are saved to a specific
location. Set this property under the Advanced options on the Report
Properties tab. Click here for more details.
To generate the command to schedule a report run:
1. Open the Report Manager.
2. Select the report you wish to generate a schedule command for.
3. Click on the Schedule Icon
4. If the report expects parameters then you will be prompted to
enter these. Enter any necessary parameters and click OK.
5. A message box will then appear that will display the syntax for
the running the report. Additionally this text will be placed on the
windows clipboard so that it can be pasted into the application or
batch file that will be controlling it. An example is shown below.

When reports are run unattended the information that is usually sent to
the Process Monitor window is redirected to a log file. You should review
this log file to make sure that your reports are running as expected. The
log file is named BICoreUnattend.log and can be found in the Intelligence
folder which is a sub folder of the Sage Accpac Intelligence Installation
folder.
You can view this log file in a text editor application such as Notepad.
The file can also be opened directly from the Connector. To do this open
the Connector and choose the Menu item Tools > Open Log File.
The application returns a process exit code for the scheduled report to
indicate Success (0) or Failure (1) allowing the calling process to check
the result of a shelled report.
To view an example of how to schedule a report using the Windows
Scheduler click here.

Home > Report Manager > Maintaining Reports > Windows Scheduler Example

Scheduling a Report using the Windows
Scheduler
1. Select the report that you wish to schedule in the Report
Manager.
2. Click on the Schedule Icon on the toolbar or right click on the
report and choose Generate Scheduler Command.
3. If the report expects parameters then you will be prompted to
enter these.
4. A message box will then appear that will display the syntax for
running the report.
5. Additionally this text will be placed on the windows clipboard so
that it can be pasted into the scheduled task command field.
Reports that are Scheduled are closed on completion and therefore must
use the Generate Output Advanced report or the Retain Run Instances
option to be useful. See Advance Report Properties for more information.
1. Open the Windows Control panel and then open the
Administrative Tools, Task Scheduler item.
2. From the menu choose Action, Create Task.
3. The Create Task window will appear.

4. Give the task a meaningful name.
5. Click on the Actions tab..
6. Click New.
7. Under Program/script, paste the command from the clipboard.
8. Click OK,
9. Confirm the arguments specified by clicking Yes.
This Task pane is shown below:

10. In the When running the task, use the following user account
box enter the user name that should be used to run the report
under (for domain user accounts use the format
domain_name\user_name) . The user name must be a valid
account on the domain or local machine with sufficient privileges
to run Sage Accpac Intelligence.
11. To set the Schedule for the Task click on the Triggers Tab.
12. Click the New button.

13. When you have set the schedule options click the OK button.
It is important to understand that the user account that is used for the
scheduled report must have sufficient permissions to access all the
necessary resources to run the Sage Accpac Intelligence report. It is
best to log on to the machine that will be running the scheduled report as
that user and test that the report can be run interactively under the user
account before using the account for scheduled reports.
For more information about how Sage Accpac Intelligence reports are
scheduled and checking log file information please click here. For more
detailed information on the windows scheduling options see the Windows
Help files.

Home > Report Manager > Maintaining Reports > Report History

Report History
Note that History Logging is turned off by default. Should you wish to
store report history then you can turn this feature on by setting History
Logging to 1 in the configuration file found in the default installation
folder.
The Report History window lets a user view the details of previous report
runs. A report that has been run is referred to as an Instance. By
selecting an Instance from within the Report History window details of the
instance can be viewed through its properties.

A definition of the report history properties can be found below.
Property

Definition

Instance ID Technical Key Identifier for the Instance
The name of the Instance. This is the name of
the report with a date-time stamp in the
Instance
format: [REPORT
NAME]_YYYYMMDD_HH_MM_SS_NNNN.xls
Location

The file path of the instance if it was retained
(Retaining Instances is an advanced Report

setting).
Parent
Report ID
Run by ID
Parameters
Supplied
Run on
Server
Launch
Time
(@Server)
Completion
Time
(@Server)
Process
Exit Code
Process
Error
Process
Time
(seconds)

The Technical Key Identifier of the Instances
Parent Report
Not Currently Supported
The Parameters supplied to the report at Run
Time
The Workstation on which the Report was
initiated
The time at which the Report was initiated

The time at which the Report completed/failed
The Technical Exit Process Code of the
Report Run Process
Errors raised by the Report Run
The amount of time in seconds for the Run to
complete.
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Creating an MS Excel 2007 template
To change a xlt (Excel 2003) template to a xltx (Excel 2007) template
the following steps need to be followed:
1. Run your existing Excel 2003 report out as normal in Excel 2007.
2. Minimise Excel 2007
3. Go back to Report Manager and unlink the xlt template from the
report by selecting the Unlink Template
button on the Toolbar.
4. Confirm that you would like to unlink the template.
5. Notice that there is now no Template linked to your report:
6. While your report is still selected, select the Create and Link
button on the Toolbar.
7. Select the Workbook to link as Template (the Excel workbook
you’ve minimized) and click OK.
8. Confirm that you would like the Parameters on the Second
Worksheet by clicking Yes.
9. You will now be given the option to select the Template File Format.
Select the Excel 2007 Template (*.xltx) and click OK.
10. Click OK.
The new template is now successfully linked to the report.

Home > Report Manager > Maintaining Reports > Add-In Modules

Add-In Modules
Sage Accpac Intelligence supplies Add-In modules which are constantly
being upgraded. These modules extend the functionality of Sage Accpac
Intelligence with Excel. These Add-In modules are supplied as is and are
used at your own risk.
To use the Add-In wizard click the Add-In Function Builder button next
to the Run Add-Ins property of a report. To make sure that you always
have the latest set of Add-In functions available keep your Sage Accpac
Intelligence software up to date.
The Add-in functions available are self documenting. For a description of
a given function select the function and view the Function Description
in the Choose Add-In Function dialog box.

Once you have selected an Add-In function you will need to enter
parameters for the function. Click the Fill in Example button to fill in an
example of the parameters required for this function.
An example of this screen is shown below.
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Add-In Modules: General Excel Extensions
The following Add-in Functions are available:
Function

Description

Use When

Use when you
Extends
wish to apply
formulae in a
ExtendFormulaeToUsedRows
formulae to a
range to the
dynamic row
specified area.
range.
Use when a
calculated
Place the
field is
formula in the
required
specified start
alongside a
FormulaToDateColumn
cell and copies
set of source
it to the used
data whose
row range
number of
specified.
rows is
unknown.
Use when you
wish to break
the links in a
Replaces any range so that
formulas in the the range
specified
becomes an
ReplaceFormulasWithValues
range with
independent
their resultant range
values.
containing
values only
and no
formulae.
Draws data
Use when you
from a set of
wish to
named files in consolidate
a specified
data from 2

Union

UnionValuesOnly

UnZeroPivot

Zeroingll

RemovePivotBlanks

directory and
unions it into
the specified
destination
sheet.
Draws data
from a set of
named files in
a specified
directory and
unions it into
the specified
destination
sheet. Only
data is
unioned (ie no
formatting.)
Hides pivot
items in a
pivot field
based on a
specified value
in a specified
column.
Hides or
remove rows
based on a
specified
columns
value.
Removes all
the blank row
items from the
first Row Field
in Pivot
Table(s) on

different
sources but
containing
comparable
information.
Use when you
wish to
consolidate
data from 2
different
sources but
containing
comparable
information.
Use when you
wish to
conditionally
exclude pivot
items based
on an amount
field.
Use when you
wish to
discard or
hide
insignificant
rows of data.
Use when you
do not wish
blank values
to display in
the rows of
data in your

specified
worksheet(s).

HidePivotDataFieldCols

ExcludePivotBlanks

Pivot Tables.

Use when you
wish to hide
Hides columns certain
in a worksheet columns in a
with Pivot
worksheet
Tables based
based on the
on the Pivot
SourceNames
DataField
of the
SourceNames. DataFields in
the Pivot
Table.
Filters out
Use when you
(blank) Pivot
want your
Items in the
Pivot Table to
specified
not be
PivotFields of
showing blank
a specified
entries.
Pivot Table.
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Add-In Modules: Accounting Trial Balance
Module
The following Add-in Functions are available:
Function

Description

Customized
addin routine
designed
specifically to
work hand in
hand with
supplied Pivot to
Lookup solution
used for
TBSync2
Financial
Templates. This
version
(TBSync2) is
required for the
Financial
Analysis solution
supplied with
Version 3.1 or
greater.
This customized
add-in routine is
designed
specifically to
work hand in
hand with
RegionalisePack supplied
Management
Pack Templates.
The add-in is not
useful for other

Use When

Use when you
want to automate
the
synchronisation of
a Pivot Table ->
Lookup table
combination.

Use with supplied
Management Pack
solutions.

reports.
This customized
add-in routine is
designed
specifically to
work hand in
hand with
SelectLastPeriod supplied
Financial Report
Pack Templates
to Select the
Last Active
period in the
report.

Use with supplied
Financial Pack
solutions.

Home > Report Manager > Maintaining Reports > Add-In Modules: Intranet Internet

Add-In Modules: Intranet/Internet Integration
Module
The following Add-in Function is available:
Function

Description

Facilitates the
publishing of a
PublishSheet sheet in the report
to html and to a
specified location.

Use When
Use when you wish
to generate static
reports for an
Intranet or Internet.

1. Select the report you want to publish to a website.
2. Check Show Advanced option on the properties tab.
3. Select Run Add Ins.

4. Select an Add-In Function
5. From the Choose an Add-in Function box
6. Select an Add-in Library
7. Select an Add-in Library module
8. Select an Add-in function (Publish sheet). Select OK

9. Specify function parameters.
10. Name, the name of the sheet to publish (Pivot)
11. Fully qualified path, (with filename & extension) for the HTML file.
Example: \\myserver\intranet\reports\ThisReport.htm

The Add-In function should now appear in the reports Run Add-Ins
property field.

Whenever this report is run, the Add-In will now be executed.
To edit the parameters of an Add-In function that has been specified
already, simply press the Add-In Function Builder button next to the
Run Add-Ins box on your report properties and select the function that
you wish to edit, then follow the same steps as above.
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Add-In Modules: Operating System Functions
The following Add-in Functions are available:
Function

Description

DeleteFiles

Deletes a list of
specified files

SaveBook

Saves the Report
Output Book to a
specified location

NetSend

Sends a network
message to

CmdExec

Runs any
Operating System
Command or
Executable
Program

Use When
You wish to delete
temporary files that
have been created by
macros or by other
reports in a report
batch.
You wish to save the
reports output book to
a specified location.
You want a network
message to be sent to
someone whenever
the report runs.
You want your report
to launch an
Operating System
Command or
Executable Program.
Note that your report
will continue to run
asynchronously and
the new process
created will run on its
own. For safety
reasons this option will
require that the user
confirms execution of
the command each
time the report is run.
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Add-In Modules: E-mailing functions
The following Add-in Functions are available:
Function

Description

Emails a file via
MailSMTP
SMTP.

Use When
Use when you want
to email a report on
completion.

1. Open your Report Manager.

2. Select the report that you want to setup for e-mailing automatically once
it has been run.
3. Select the check box to Show Advanced Properties of a report – it is at
the bottom of the properties tab window.

4. Select the button to Run Add-ins - this will be listed in the properties
window of the report.

5. Select the option to Specify a New Add-in Function and select OK.

6. A box will appear as follows

7. Select the Add-In Library, and Add-in Library Module as shown above.
Select the Add in Function, click OK.
8. A box will pop up asking you to enter all the relevant details for
emailing – see below

This will include details about your mail SMTP server which you
must get from your Mail administrator, as well as the ‘from’ and
‘to’ addresses. To send to multiple e-mail addresses, use a colon
in between addresses. Ensure that when you give the report a
name that you include the “.xls” extension as well. Scroll down
on this window to see more available options.
9. When you have entered your details, select OK and you will see that a
string has been added into the Add-Ins box in the properties window of
your report.

10. Execute the report, and it will automatically be e-mailed to the selected
recipients.
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Timeouts
There are various types of Timeouts that can occur during data extraction
phase of a report execution. The three most common that can affect the
execution of a report and troubleshooting options are described below:
Connection Timeout - This occurs when Sage Accpac
Intelligence cannot connect to the Database System in good
time. By default Sage Accpac Intelligence will try to connect for
30 seconds. If there is no response from the Database System
then a connection timeout error will occur. To increase this
threshold add (or modify) the Key SQLConnectTimeout to the
[Publisher] section of the ALCHEMEX.INI file, e.g. to increase it
to 60 seconds add this key to the Publisher Section:
SQLConnectTimeout=60.

NOTE: Setting this value affects all Sage Accpac Intelligence
Connections. Setting this value to 0 (zero) will cause Sage
Accpac Intelligence to wait indefinitely for Connections to be
established.
Query Execution Timeout - This occurs when Sage Accpac
Intelligence cannot execute a SQL statement against the Database
System in good time. For some database systems this Execution
Timeout is configured within the Database System. It is sometimes
referred to as a Query Governor Limit and is usually configured to
prevent long running queries from monopolizing the Database System.
Either of the following techniques can be used to address the problem :
Configure a Timeout threshold at the Container level in
the Connector. You will need to do this for all Containers
that are being used in Reports that are experiencing
Execution Timeouts. See the advanced property Timeout
Enquiries After (Seconds) of the container. For more
details click here.
If a Query Governor Limit (or equivalent configuration
option) is available in your Database System then arrange
with your Database Administrator (DBA) to configure this

value.
Wait Lock Timeout - These timeouts occur when a query is
waiting for another process to release a locked record in a table.
Records usually get locked when they are being updated (or
edited) in a system. These timeouts cannot usually be avoided by
the Database System you are using may provide setting for
minimizing occurrences of Wait Lock Timeouts.
NOTE: The underlying Database System Configuration may override the
available Sage Accpac Intelligence Timeout Settings. If this is the case
and you continue to experience Timeout problems then please refer the
problem to your DBA.
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Common Report Execution Errors
Sage Accpac Intelligence uses ODBC and OLEDB technologies for
accessing data. Each ODBC driver or OLEDB provider has slight
differences and limitations. This means that certain Sage Accpac
Intelligence features may have problems or not work for certain Database
Systems.
If you are receiving errors when running a report use this reference to try
and identify if the problem is due to one of these limitations.
[Pervasive Software][ODBC Interface][Pervasive Software SQL
Engine]The position you specified in the ORDER BY clause is invalid.
[Pervasive Software][ODBC Interface][Pervasive Software SQL
Engine]The position you specified in the ORDER BY clause is invalid.
[Pervasive Software][ODBC Interface][Pervasive Software SQL Engine]
You cannot use the AVG or SUM functions on STRING, DATE, TIME, or
TIMESTAMP data types.
[Pervasive Software][ODBC Interface][Pervasive Software SQL
Engine]The data type is invalid for the expression.
[Pervasive Software][ODBC Interface][Pervasive Software SQL
Engine]The column does not exist in the dictionary.
[Pervasive Software][ODBC Interface][Pervasive Software SQL Engine]A
character in the numeric data is invalid.
[Microsoft][ODBC dBase Driver]ORDER BY clause ([TABLE].FIELD)
conflicts with distinct.
[Microsoft][ODBC dBase Driver]You tried to execute a query that does
not include the specified expression '[TABLENAME].[FIELDNAME]' as
part of an aggregate function.
[Microsoft][ODBC dBase Driver] Data type mismatch in criteria
expression.
[Microsoft][ODBC dBase Driver] Syntax error in query expression
'([TABLENAME].[FIELDNAME] Like %<VALUE>)'.
[Microsoft][ODBC dBase Driver] Syntax error in date in query expression
'([TABLENAME].[FIELDNAME] Like #<VALUE>%#)'.
[Microsoft][ODBC Microsoft Access Driver] Data type mismatch in criteria
expression.

[Microsoft][ODBC Microsoft Access Driver]ORDER BY clause
([TABLE].FIELD) conflicts with distinct.
[Microsoft][ODBC Microsoft Access Driver] You tried to execute a query
that does not include the specified expression
'[TABLENAME].FIELDNAME' as part of an aggregate function.
[Microsoft][ODBC Microsoft Access Driver] Syntax error in date in query
expression '([TABLENAME].FIELDNAME Like <VALUE>%)'.
ORA-00932: inconsistent datatypes
ORA-00911: invalid character
ORA-00979: not a GROUP BY expression
ORA-01791: not a SELECTed expression
[Microsoft][ODBC SQL Server Driver]ORDER BY items must appear in
the select list if SELECT DISTINCT is specified.
Operation cannot be performed while executing asynchronously

Home > Report Manager > Troubleshooting the Report Manager > Incompatible Operator for Data Type

Incompatible Operator for Data Type
Cause: Sage Accpac Intelligence offers a number of different
Operators that can be used in Filters and Parameters and Aggregate
Functions that can be used with Display Columns. Certain of these
Operators and Aggregate Functions will not work with certain Data
Types. This may simply be because the Operator or Aggregate Function
and the Data Type combination is nonsensical or that there is a limitation
with the Data Access Driver.
Since Sage Accpac Intelligence has been designed with an open data
access architecture it would be impossible to cater for or publish every
incompatible combination of Data Type and Operator or Aggregate
Function. For the most common combinations with the most common
Data Source types check the Comparator and Aggregate Function
Compatibility Matrix.

Home > Report Manager > Troubleshooting the Report Manager > Debugging Reports

Debugging Reports
The Report Manager has two tools for assisting in Debugging reports. To
switch the Report Manager into one of the debugging modes right click
Home and click Switch Output Mode.
The following dialog box will appear.

The available options are:
Excel
This is the Sage Accpac Intelligence default mode and is the mode in
which Sage Accpac Intelligence reports are run out to Microsoft Excel.
Screen
This mode runs the Data extraction stage of a report and then simply
outputs it to screen. All of the usual Excel data rendering functions are
ignored (i.e. no template is used and no macros are run).
Screen (SQL Debug)
Like the Screen mode above this mode runs the Data extraction stage of
a report and then simply outputs it to screen. Additionally when running
a report the SQL query that is generated by the report for the Data
extraction stage is intercepted by a SQL Debug window. This window
allows the raw SQL statement to be viewed and tested.

1. If you choose the Screen (Sql Debug) option, the SQL Debug window
will pop up with the SQL code that gets passed to the ODBC driver.

You can go through the SQL code to try find the problem,
and then make the relevant changes to the container
(Connector) of the report (Table joins, Field expressions . . .)
or to the Report (Report Manager) itself (Filters, Aggregate
Functions . . .)
NOTE: You will not be able the edit the SQL code in the
Debug mode, you have to correct / make changes to the
Container or Report directly.
From the SQL Debug window you can
Test SQL – Test the SQL code to see if it runs out
successfully or not
Continue – To see what the raw data will look like in a
Data output window
2. If you choose the Screen option, the raw data window will pop up with

the raw data before it is passed to excel.

You can now easily go through the raw data, sorting fields by clicking
on the field headings.
Things to Keep in Mind
When you open the Report Manager it defaults the Output mode to
Excel every time, regardless of the state you closed the Report Manager
in.
In a networked environment of Sage Accpac Intelligence, the Output
mode you select will only be affective on the PC it was set on.

Home > Report Manager > Troubleshooting the Report Manager > Report Problems with Excel

Problems with Excel when Running Reports
Excel Frozen
When Sage Accpac Intelligence runs a report out to Excel it takes control
of Excel and prevents user interaction with Excel. If a report runs into
rendering problems it is possible that Excel can be left locked.
To release Excel:
1. In the Report Manager Module, select the Home object
2. Right click and select Unlock Excel or click the

key on the toolbar.

Excel will now be unlocked and user interaction will be allowed again.

Home > Report Manager > Troubleshooting the Report Manager > Trapping Errors in Macros

Trapping Errors in Macros
When an error occurs in an Excel Macro with no error traps the VBA
(Visual Basic for Applications) Editor automatically goes into Debug
Mode and awaits a response from the user. If the Macro is being called
from a Sage Accpac Intelligence Report it may not be convenient for this
interaction to take place. In particular if a report is running unattended
(e.g. from a scheduler) then the report will freeze at the debug point and
Excel will hang. To prevent this from happening include an error trap in
your Macro that passes the Error description back to Sage Accpac
Intelligence. Sage Accpac Intelligence will then handle the error. To do
this perform the following steps:
1. Open your template with the Macro in it.
2. Change the Sub Keyword to Function (this allows the Macro to
return a value).
3. Turn Error Trapping on in the Routine with the "On Error Goto
[TrapName]" VBA syntax, e.g.
On Error GoTo MyErrorTrap

4. As the last lines in the Routine include the Error Trap. The error trap
should return the error from the Macro as a string so that Sage Accpac
Intelligence can catch the error and handle it. The error trap should be
of the following structure:
Exit Function
MyErrorTrap:
MyMacro = Err.Description

An Example of the full structure of a Macro with an error trap is shown
below:
Function MyMacro()
On Error GoTo MyErrorTrap
'---------------------------------------------------------'[Included here should be the functional code of the Macro]
'---------------------------------------------------------Exit Function
MyErrorTrap:

MyMacro = Err.Description
End Function

Note: Using this method to trap Errors and pass them back to Sage
Accpac Intelligence will allow errors to be rendered in Sage Accpac
Intelligence and stop the errors being Debugged by the VBA debugger
within Excel. Sage Accpac Intelligence will not take any action on the
errors. For intelligent error trapping for bespoke Macros, more intelligent
error handlers will have to be implemented within your macros and will
require a good working knowledge of VBA.
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Unlocking a Container and Expressions
If a Container and/or its Expressions have been locked using Sage
Accpac Intelligence's intellectual property (IP) protection facilities then it
can be unlocked by the Owner of the Container if necessary. There are
two scenarios that could occur.
The owner of the Container needs to Unlock in their system
In this scenario, where the Container Owner (see the Property "Container
Owned by" of the Container) is the same as the Sage Accpac Intelligence
registered Company in the License Manager, then the Unlock operation
is simple. Right click on the Container and select Unlock Container or
Unlock Container Expressions to perform the required Unlock
operation. The unlock will occur without any authorisation required.
A Company licensed for usage of the Container but not the
Container Owner needs to Unlock in their system
In this scenario the unlock operation needs to authorised by the Owner of
the Container. Note that once this is done the IP will no longer be hidden
from the user of the container.
The Owner of the Company will need to supply Pin Codes to the Usage
Company to perform the unlock. These Pin Codes are unique to the
Container and the Usage Company and cannot be re-used by other
companies to perform an unlock. One Pin Code is required for unlocking
the Container and one is required for unlocking a Containers
Expressions.
For the Container Owner to generate these Pin Codes:
1. Select the Container, right click and choose Generate Unlock
Pin Codes.
2. The screen shown below will display.

3. Enter the Usage Company that you wish to supply the Pin Codes to.
(Note that the Company name must be identical to the Company Name
in the License Manager of the destination system.) This name is Case
Sensitive.
4. Press OK and you will receive a Pin Code message as shown below.
Note the Pin Codes and supply these to the destination company (ABC
Company in this example).

5. ABC Company should select the Container in their Sage Accpac
Intelligence system.
6. Right click choosing Unlock Container or Unlock Container
Expressions.
7. A prompt will appear for each unlock operation requiring the
supplied Unlock Pin Code. On entering a valid Pin Code the
unlock operation will occur.

Home > Custom Add-In for Excel > Excel Add-In

Sage Accpac Intelligence Excel Add-In
The Sage Accpac Intelligence Excel Add-In is provided to offer extra
functionality within your Sage Accpac Intelligence Reports directly from
within Excel. The Excel Add-In currently supports the following Functions:
Drill-Down Tool
Hide Zero Rows Tool
Quick Pivot
Format Pivot
Add Accounts
About Report Tools
Note: If Excel has been re-installed then the Sage Accpac Intelligence
Excel Add-In may not be available in Excel.
To rectify this make sure that Excel is closed and run the PLMAINT.EXE
tool in your Sage Accpac Intelligence [Metadata Server] folder on each
Sage Accpac Intelligence client workstation.
From the Tools Menu choose Register Sage Accpac Intelligence AddIns. This will register the Add-In with Excel and the menu will become
available in Excel at next run. Should you register the add-in and find that
the Report Tools menu is still not available on the Excel menu bar, then
using PLMAINT.EXE again, register the COM Server as well.

Home > Custom Add-In for Excel > Drill-Down

Drill-Down
The Drill-Down tool allows Sage Accpac Intelligence to interrogate data
directly from within your Excel reports. A common scenario might be,
where one high level Sage Accpac Intelligence report needs to drill down
to line level transactional Data in other reports. As a fast interrogation
method the Drill-Down tool allows individual Sage Accpac Intelligence
reports to be executed with parameters based on Excel Cell values.
These reports render their data directly to a fast grid style window rather
than to a new Excel Report. From this screen the user may then choose
to dump the data into Excel via the data screen menu. In this form a
Sage Accpac Intelligence report definition is being used as the source for
an Ad-Hoc data enquiry.
1. To use the Drill-Down tool locate the Report Tools menu on your
standard Excel Menu Bar. Select the Drill-Down Menu. Menu is shown
below:

The Drill-Down tool will appear. To Execute a pre-configured DrillDown simply Double Click on it or select it then click the Execute
Button.

2. To configure a Drill-Down select the Drill-Down and click Edit.
The Configure Drill-Down window will appear. This window is
shown below.
3. To Add a Drill Down click the Add button and follow the same process
outlined below.
Note: A Drill Down definition set is contained within an Excel Book or
Template. If you change or add a Drill Down definition in a Report you
should link it back to your Report in the Report Manager to keep the
changes.

The Properties of a Drill-Down Definition are listed below:
Drill Down Defined Code: A unique code for the DrillDown within the Excel Book
Drill Down Descriptive Name: A meaningful name used
to identify the Drill Down

Report ID/Code: The Sage Accpac Intelligence Report ID
to use for interrogation. The Report ID of a report is listed
on the property window of a report in the Report Manager.
Source Sheet: The Source Sheet used to interrogate
from. This is the sheet that has the parameters for the
report. This must be the Excel Worksheet name OR the
word ActiveSheet for the drill down to work from any
sheet in the Workbook.
Report Parameter Columns: A semi-colon delimited list
of the column numbers or names used to define where to
obtain the report parameters from.
As an interrogation tool the data will most likely not be needed in your
Excel report and once viewed the window can be closed.
If you wish to analyse the data in Excel however, then use the Data to
Report Workbook provided to transfer the data into Excel. A number of
options are provided for this.

Home > Custom Add-In for Excel > Hide Zero Rows

Hide Zero Rows
The Hide Zero Rows tool is an add-in which can aid in the analysis of
data. Specifically the tool allows rows within a selection to be hidden
based on a zero value in a specified column. This can be particularly
useful when viewing financial type reports.
1. To use the tool select the Hide Zero Rows option from the Report
Tools menu within Excel.

2. Choose the Range to perform the operation on, and the Column that
contains the value to check for zeros. Then click OK. See the window
below.

The Rows within the Row Range that have a Zero value in the Column
specified in the Column with Values box will be hidden.
Note: If the function is reused on an overlapping range with hidden
rows already then the rows are unhidden before performing the
operation.
3. To unhide hidden rows in a range use Excels standard Unhide function.
To do this select the row range that includes the hidden rows to unhide
then Right Click and choose Unhide.

Tip: Should you wish to hide zero value rows but only when based on a
certain condition, then using a normal excel formula, create another
column containing the formula based on the condition which will result
in specific rows being zero, then configure that column as the Column
with Values in the Enter Ranges for Hiding Zeros screen.
Example: To hide a Year to date column of values but only if there was
no movement in the other monthly columns. In this case using the Year
to Date column as the Column with values would not work.

Home > Custom Add-In for Excel > Quick Pivot

Quick Pivot
The user is able to create pivot tables from within existing reports as and
when needed. The user is able to customize pivot tables without leaving
an existing report pack.
Within the applicable Excel report generated from the Report Manager,
access the Quick Pivot option from the Report Tools menu on the Excel
Menu bar.

Options Tab
Source Sheet
Source Data

Defines the sheet where the
data is stored on.
Defines the data source
name
The field names that are
available for the user to
report on

Target Location for Specifies the location where
Pivot Table
the new sheet will be sent to
Defines the name of the new
Pivot Table Name
pivot report
Dimensions that will be
Row Fields
reported horizontally
Dimensions that will be
Column Fields
reported vertically
Dimensions reported on a
Page Fields
global level
Aggregated measures
Data Fields
reported within the content
of the report.
Click OK. The report will be created as a new sheet within the specified
workbook.

Format Tab

Defines colours used
within the pivot report.
To access additional
colour pallets, click the
colour box.
Restores original
default colours.

Sum by Default

No Gridlines on Sheet
Free Window Pane for
Data
Zoom Sheet to __ %
Apply Number Format
Hide Blanks
Grand Total Columns
Grand Total Rows
Sub Total Row Fields
Auto Sort Fields

Uses the Sum
Aggregation as default
within the report
content. If unchecked,
the count aggregation
is used.
Removes the grid lines
from the sheet
Freezes the report
headings
Zooms the sheet to the
percentage specified
Changes the number
format to what has
been specified
Hide all Blanks
Includes Grand Total
for all the Columns
Includes Grand Total
for all the Rows
Gives a Sub Total for
the Row fields
Automatically Sorts the
Fields

Home > Custom Add-In for Excel > Format Pivot

Format Pivot
The user is able to change the format of pivot tables from within existing
reports as and when needed. This can be done without leaving an
existing report pack.
1. Within the applicable Excel report generated from the Report Manager,
access the Format Pivot option from the Report Tools menu on the
Excel Menu bar.

2. Select Format Pivot. The Pivot Table Format Wizard will open.

3. Select the Pivot you wish to format.
4. Select the Format Tab.

5. Make the required changes (See Quick Pivot).
6. Select OK.

Home > Custom Add-In for Excel > Add Accounts

Add Accounts
If new accounts have been added into the General ledger within the
accounting system, these will be added to the lookup sheet and
highlighted in green. But still need to be added to your Financial Report
Layout.
(Please note: This function is intended for use with the shipped Financial
reports and customized versions of these.)
1. The Add Accounts functionality can be accessed from the Report
Tools menu on the Excel Menu bar.

2. Select the Accounts to Insert box will open.

A list of accounts that are not in the layout will appear.

3. Use the Type drop down arrow as well as the other filter
textboxes to locate the specific accounts.
4. Select the account that you wish to insert at the specified row.
You can select a different row in Excel while the Select the
Accounts to Insert form is active.
5. Select the Insert button to add the accounts.
6. Select the Close button once all the accounts have been
inserted.

Home > Custom Add-In for Excel > About Report Tools

About Report Tools
The About Report Tools displays which version of Sage Accpac
Intelligence is currently installed.
The About Report Tools functionality can be accessed from the Report
Tools menu on the Excel Menu bar.

Home > Analysis Module > Introduction

Introduction
Sage Accpac Intelligence is a business intelligence reporting tool that
incorporates a number of modules including many innovative features.
Sage Accpac Intelligence enables you to connect to any supported
ODBC compliant database and extract the data into Microsoft Excel
where the data can be summarized and analyzed using Microsoft Excel’s
extensive data analysis tools. The Microsoft Excel workbook and its
workings are then linked to Sage Accpac Intelligence to create a
permanently linked Excel template. This enables you to extract the data
to a Microsoft Excel workbook in the way you want it to be presented.
The Analysis Module (OLAP) works with, and is dependent on, the
Connector, Report Manager and Microsoft Excel being licensed to a
user’s machine.

On-Line Analytical Processing (OLAP)
OLAP is more than an acronym that means Online Analytical Processing.
OLAP is a category of software tools that provides analysis of data stored
in a database. With OLAP, analysts, managers, and executives can gain
insight into data through fast, consistent, interactive access to a wide
variety of possible views. Stated another way, OLAP is a category of
applications and technologies for collecting, managing, processing, and
presenting multidimensional data for analysis and management
purposes. A widely adopted definition for OLAP used today in five key
words is: Fast Analysis of Shared Multidimensional Information (FASMI).

Fast refers to the speed that an OLAP system is able to deliver most
responses to the end user.
Analysis refers to the ability of an OLAP system to manage any
business logic and statistical analysis relevant for the application and
user. In addition, the system must allow users to define new ad hoc
calculations as part of the analysis and report without having to program
them.
Shared refers to the ability of an OLAP system being able to implement
all security requirements necessary for confidentiality and the
concurrent update locking at an appropriate level when multiple write
access is required.
Multidimensional refers to a concept that is the primary requirement to
OLAP. An OLAP system must provide a multidimensional view of
data. This includes supporting hierarchies and multiple hierarchies.
Information refers to all of the data and derived data needed, wherever
the data resides and however much of the data is relevant for the
application.

Home > Analysis Module > Types of Reporting

Types of Reporting
Organizations generally require two types of information. One is fixed
format reporting (Sage Accpac Intelligence Standard Report
Templates), and the other is analysis (Analysis Module). The former
requires information to be presented neatly, formatted and presentable.
This is applicable for financial reporting, board packs, management
dashboards, or similar fixed format intelligence. The latter is less
presentable, but contains rich information that can be analyzed in various
ways to establish trends and statistics which may not become instantly
apparent in the fixed format reporting.

As the diagram above illustrates, the best approach for BI for SMME’s
lies somewhere between OLAP and Reporting. OLAP should most
commonly deal with greater volumes of data than a fixed format report.
An OLAP tool should be able to trump its closely related fixed format
reporting cousin in its ability to deliver multi-dimensional (as opposed to a
single “flat sheet” dimension), analysis graphing, charting and more.

Home > Analysis Module > What is OLAP ?

What is OLAP ?
OLAP stands for On Line Analytical Processing, and supports multidimensional analysis of information. It is the process of extracting
information from a data source (this could be a transactional system, or a
data warehouse), and compressing it into a format that is optimized for
multi-dimensional analysis.
An OLAP database allows business decision makers to analyse data that
has been sorted into hierarchical structures. The data is static so all
mathematical aggregations can be built into the database query, thereby
providing a more efficient and resource friendly means of reporting. This
data warehouse can then be pulled into a pivot table within Excel, where
the user is able to drill down into the report, using the hierarchical
dimensions built into the query.
The Analysis Module allows the user to define the dimensions and
measures required and then create the .cub file, which will then become
a data source for reporting within the Sage Accpac Intelligence Report
Manager. As the data remains static, the .cub file should be rebuilt daily,
to ensure that the data remains relevant.
OLAP Cubes
OLAP cubes can be considered an extension to the two-dimensional
array of an Excel spreadsheet. A company might wish to analyze
some financial data by product, by time-period, by city, by type of
revenue and cost, and by comparing actual data with a budget.
These additional methods of analyzing the data are known as
dimensions and an OLAP cube allows for the presence of be more
than three dimensions for more powerful information analysis.
Functionality
An OLAP cube consists of numeric facts called Cube Measures (or
measures) which are categorized hierarchically by Cube Dimensions
(or dimensions).
OLAP Views
A business owner may want to view or "pivot" the data in various

ways, such as displaying all the cities down the page and all the
products across a page. This could be for a specified period, version
and type of expenditure. Having seen the data in this particular way
the business owner may then wish to view the data in another way.
The view could effectively be re-oriented so that the data displayed
now has periods across the page and type of cost down the page.
OLAP allows users to pivot data very fast and very efficiently.
OLAP Hierarchy
Each of the elements of a dimension could be summarized using a
hierarchy. The hierarchy is a series of parent-child relationships,
typically where a parent member represents the consolidation of the
members which are its children. Parent members can be further
aggregated as the children of another parent.
For example May 2005 could be summarized into Second Quarter
2005 which in turn would be summarized in the Year 2005. Similarly,
cities could be summarized into regions, countries and then global
regions; products could be summarized into larger categories; and
cost headings could be grouped into types of expenditure.
OLAP Terminology
The user driven process of creating different views, is sometimes
called "slice and dice". Common OLAP functions include slice and
dice, drill down, roll up, and pivot.
Slice: A slice is a subset of a multi-dimensional array
corresponding to a single value for one or more members of the
dimensions not in the subset.
Dice: The dice operation is a slice on more than two dimensions of
a data cube (or more than two consecutive slices).
Drill Down/Up: Drilling down or up is a specific analytical
technique whereby the user navigates among levels of data ranging
from the most summarized (up) to the most detailed (down).
Roll-up: A roll-up involves computing all of the data relationships
for one or more dimensions. To do this, a computational

relationship or formula might be defined.
Pivot: This operation is also called rotate operation that rotates the
data in order to provide an alternative presentation of data.

Home > Analysis Module > When would you use it ?

When would you use the Analysis Module ?
You would use it :
If you wanted to analyze transactional data to establish trends over
a period of time.
The data in your database is not stored in a suitable format to
achieve the type of analysis that you require.
You are being challenged by the row limitations presented by
Excel as a reporting front end.
You want to be able to view the same information in a variety of
ways.
Analysis is a priority over fixed format reporting.

Home > Analysis Module > Modules > Modules

Modules
Sage Accpac Intelligence has several modules available but it is
important to understand the relationship between the following three
Sage Accpac Intelligence modules to understand how the Analysis
Module functions in being able to deliver analysis on your data:
The Connector
The Analysis Module (OLAP)
The Report Manager

Home > Analysis Module > Modules > The Connector Module

The Connector
Main Functionalities
This module provides a skilled IT user with a powerful and cost effective
report writing solution, capable of delivering Microsoft Excel reports from
any ODBC compliant data source:
Create links to databases
Create containers (tables) and expressions (fields) for reporting
Is the gateway to databases to create relevant meta data for all reports

Key Components
Connect to various available data sources using the existing ODBC
connections
Create and maintain Containers
Create additional Expressions using either MSSQL or Microsoft Excel
as the Expression source
Access the Report Download Community to download additional preformatted reports

Home > Analysis Module > Modules > The Analysis Module

The Analysis Module
An OLAP (On Line Analytical Processing) database allows business
decision makers to analyze data that has been sorted into hierarchical
structures. The data is static so all mathematical aggregations can be
built into the database query, thereby providing a more efficient and
resource friendly means of reporting. This data can then be pulled into a
pivot table within Excel, where the user is able to drill down into the
report, using the hierarchical dimensions built into the query.

Main Functionalities
The Analysis Module allows the user to define the dimensions and
measures required and then create the .cub file, which will then become
a data source within the Report Manager, as the data remains static, the
.cub file should be rebuilt daily, to ensure that the data remains relevant.
Define date Dimension Table
Define dimensions and measures

Key Components
Creates a .cub file
Data remains static

Home > Analysis Module > Modules > The Report Manager

The Sage Accpac Intelligence Report Manager
This module provides you with a pre-formatted, intelligent Microsoft Excel
reporting tool for your data. You can use the base of reports to create
new reports or even write your own reports in Microsoft Excel.

Main Functionalities
Selections of pre-formatted standard Sage Accpac Intelligence reports
are provided. In addition to these reports the following main
functionalities are also available:
Creating new reports using existing Containers
Customisation of existing pre-formatted reports

Key Components
Organise your reports into folders
Create new reports
Select additional reporting Fields
Add Filters, Parameters or Aggregates to your report
Manage report templates

Home > Analysis Module > How to set up a report

How to Set up a report in the Analysis Module ?
1. Open the Connector.
2. Right Click and Add Connection. (Connects to the data you wish to
interrogate).

3. Add the connection details.

4. Add Data Container/s. (Published through your Data Connection
describing what information you are going to have access to, when
building your cube)

5. A Data Expression/s – the fields within your data container. NOTE: In
many instances, particularly where Sage Accpac Intelligence ships
solution sets for specific install bases, the first steps would already be
in place. If this is the case, then start here at the next step.
6. Generate the Cube report you have created in your Analysis Module
and this will create a new instance (or refresh an existing instance) of
your .cub file

7. Using the Sage Accpac Intelligence Report Manager, create a new Cube
Report and use the cube you created in your Analysis Module as the
data source for the report.

8. Select Cube report.

9. Enter a name for the cube report

10. Once the report is set up you would run this report which would render
the data for your cube into Excel just as a standard Sage Accpac
Intelligence report would be run.

11. Finally, using Excel as your cube browser allows you to use a Pivot
Table to drag and drop the fields defined in your cube to view the same
data in various ways. If you get to a point where a specific layout that
you have created serves a specific need in your business and you want
to keep this layout, you can do this by creating and linking your Excel
layout with the report in the Sage Accpac Intelligence Report Manager.
Each time you run this report after doing a create and link process,
your most recent layout will automatically be displayed when you rerun the report.

Home > Analysis Module > Analysis Module Defined

The Analysis Module Defined
A cube is a data structure that aggregates data by the levels and
hierarchies of each of the dimensions that you wish to analyse. Cubes
combine several dimensions, such as time, geography, and product lines
with summarised data, such as sales or inventory figures.
Cubes are not “cubes” in the strictly mathematical sense because they do
not necessarily have equal sides.
The Analysis Module is an additional module that functions between the
Sage Accpac Intelligence Connector Module and the Sage Accpac
Intelligence Report Manager module. The purpose of the Analysis
Module is to use an existing connection to a database provided by the
Sage Accpac Intelligence Connector to access data and create an offline
.cub file. This .cub file is then in turn used by the Sage Accpac
Intelligence Report Manager module to create reports and finally
Microsoft Excel is used to browse this cube data and create an output
that can be linked to Sage Accpac Intelligence and refreshed as and
when required.
In short, the use of the Sage Accpac Intelligence modules for data
analysis purposes is summarised in sequential order as follows:

Sage
Accpac
Intelligence
Connector
Module
Analysis
Module
Sage
Accpac
Intelligence
Report
Manager
Module
Microsoft
Excel
Create and
Link
Template

Connects to the underlying database and publishes
metadata from source data

Creates a .cub file off the metadata made available by the
Sage Accpac Connector Module

Creates a report of the .cub file established by the
Analysis Module

Used as the browser interface to analyse the data in the
report created by the Analysis Module.
When a final layout is concluded the normal “Create and
link” function within Sage Accpac Intelligence Report
Manager is used to create a template of the final analysis
output in Microsoft Excel.

Home > Analysis Module > Cube Components > Cube Components

Cube Components
The Analysis Module uses already created data connections, containers
and expressions from the Sage Accpac Intelligence Connector. When
creating the .cub file you are required to specify the following:

1. Database Date Dimension Table (using the Date Dimension Tool)
The Date Dimension tool allows you to specify the dates that are
applicable to your dataset. You specify your financial year start date as
well as the number of years of data that you have in your dataset. The
date dimension table should go back as far as is required to analyze
prior year’s data. The Date Dimension Tool then generates a “date
dimension table” for you to use when creating reports. This table
includes the following fields:
Date
Financial Year
Financial Quarter
Financial Period
The Date Dimension tool allows you to set fiscal year parameters,
account for specific holidays and non-working days that are
applicable to your dataset.
You can launch the Date Dimension tool from the Sage Accpac
Intelligence Connector or the Analysis Module .

2. Cube Dimensions
A dimension is a set of one or more organised hierarchies of levels in a
cube that the user understands and uses for data analysis purposes.
These dimensions facilitate the drill down functionality. Dimensions
represent the variables by which measurement is performed, such as
date, location, product code, etc. Dimensions can be arranged in
hierarchies, allowing users to drill down through the data.
For example, a “service date” dimension which could contain the
hierarchy of YEARS drilling down to QUARTERS, and then to
MONTHS.
Another example would be a “region” dimension which could
contain the hierarchy of COUNTRY, drilling down to STATE, and
then to CITY.
Careful design of the hierarchy in a dimension facilitates drill-down
reporting by designing the hierarchies to be intuitive and to follow the
thought process of the analyst.
3. Cube Measures
Measures are a set of values in a cube that are based on a column in the
cubes dimensions. Measures include a variety of key performance
indicators, and may include "simple" measures (amounts paid to
suppliers, stock days, etc.) as well as computed measures or ratios, such
as cost per member per month. Measures can be presented at various
levels of summarization or drilldown, depending on how the dimensions
of the analysis are displayed. The numbers in the OLAP spreadsheet are
called measures. When setting up OLAP cubes, these values are also
often called facts. Typical measures or facts would be:
Sales Dollars
Sales Count
Profit
Hours of Work

4. The location of the .cub file

When the OLAP cube is generated it is generated to a file with the
.cub extension, you need to specify the location of this file. This local
cube file (.cub file) is stored in a single, portable file that can be
stored on both server and non-server environments. End users can
browse local cubes without the need for a connection to a Microsoft
Analysis server. Local cubes are the only variety of cube that
provides this capability. After a local cube is created, if its source
data changes, the local cube can be refreshed to incorporate the
new version of the source data.

Home > Analysis Module > Cube Components > More on OLAP Cubes

More on OLAP Cubes
The OLAP cube provides the multidimensional way to look at the data.
The cube is comparable to a table in a relational database.
The specific design of an OLAP cube ensures report optimization. The
design of many databases is for online transaction processing and
efficiency in data storage, whereas OLAP cube design is for efficiency in
data retrieval. In other words, the storage of OLAP cube data is in such a
way as to make easy and efficient reporting. A traditional relational
database treats all the data in a similar manner. However, OLAP cubes
have categories of data called dimensions and measures.
In the figure below; time, product and location represent the dimensions
of the cube, while 80 represents the measure. Note: A dimension is a
category of data and a measure is a fact or value.

Dimensions
Dimensions are broad groupings of descriptive data about a major aspect
of a business, such as dates, markets and products. Each dimension
includes different levels of categories.
For example, you OLAP cube could have a time dimension. This time
dimension could be further categorized into year, quarter, and month.
These levels of categories, (hierarchies) are what provide the ability to
drill-up or drill-down on data in an OLAP cube.

Measures
Measures are actual data values that occupy the cells as defined by the
dimensions. Measures are typically stored as numerical fields. For
example you are a manufacturer of calculators. The question you want
answered is how many of ABC model calculators (product dimension) a
particular plant (location dimension) produce did during the month of April
2009 (time dimension). Using the Analysis Module, you find out that a
plant produced 4500 ABC cell phones in April 2009. The measure on this
example is the 4500.

Home > Analysis Module > Cube Components > The Date Dimension Tool

The Date Dimension Tool
The Date Dimension tool allows you to specify the dates that are
applicable to your dataset. You specify your financial year start date as
well as the number of years of data that you have in your dataset. The
Date Dimension Tool then generates a “date dimension table” for you to
use when creating reports.
This table includes the following fields:
Date
Financial Year
Financial Quarter
Financial Period
The Date Dimension tool also allows you to specify holidays and non
working days that are applicable to your dataset.
Method
1. Select Date Dimension Creation Tool.

2. Select the database that you would like to create the dimensions for :

3. Enter your Financial information on the first screen and select generate
to create the date dimension table

4. If you have already created the Date Dimension table and would like to
recreate it, you can select the tick box Drop and Recreate Dimension
Table to overwrite the previously created dates
5. Select the Set Holidays tab to enter any applicable holidays or non
working days

6. You can edit your Dates on the Edit Date Dimension Table tab

Home > Analysis Module > Layout of the Analysis Module Interface > Layout > Layout of the Interface

Layout of the Interface
To effectively use the Analysis Module , you need an understanding of
the Sage Accpac Intelligence interface and how to perform actions.
The software layout is divided into 2 main areas:
The Object Window
The Properties Window

1. Object Window:
You are able to select objects using your mouse from the object window
in order to either view the objects' properties or perform a task with the
object. For example, you are able to select an object in the object
window and rename the object just as you would rename a file in
Windows Explorer
Method: From the Object window, double click on the
desired object to expand to show details or collapse the
Objects

2. Properties Window:
You are able to view and update the properties of a selected object
using the properties window. For example, you are able to add your
own custom description of the object in the object's properties
window
Method: From the Object window, select the desired Object, then
From the Properties window, view the desired Properties

Home > Analysis Module > Layout of the Analysis Module Interface > Layout > Show Advanced

Show Advanced
Method : By clicking the check box next to Show Advanced,
additional options will become available in the Properties window.

Default Cube File Path: The file location of the saved cube file.
The file has the extension .cub
Cube File Name: The name of the cube file
Last Refreshed: Shows the time and date that the cube was
rebuilt
Cube Definition Locked: Lock the cube definition so that it
cannot be edited

Home > Analysis Module > Layout of the Analysis Module Interface > Functionality Navigation >
Functionality Navigation

Functionality Navigation
In addition to using the Object and Properties windows you can also use
the Menu Bar, Toolbar and Shortcut menu to navigate around the
Analysis Module .
Most functionality is generally shared between the Analysis Module’s
Menu Bar, Toolbar and Shortcut menu. However, this section focuses on
the Toolbar and Shortcut menu functionality options as most options on
the Menu Bar items are also included in them.
Option availability is dependent on where the current focus is.

MENU Commands
There are three ways to access menu commands within the Analysis
Module interface:
1. Using the Menu bar - Use your Mouse or Keyboard shortcut to select a
task from the menu bar.
2. Using the Toolbar - Use your Mouse to select a task from the toolbar.
3. Using the Shortcut menu - Right-click an object in the object window
and you will be able to select a command from the shortcut menu.

To view an object's associated elements, double click on the object. This
action is called drilling down. To drill down is to show additional
information. To hide an object's associated elements, double click an
open object again. This action is called drilling up, thereby hiding the
additional information.

Home > Analysis Module > Layout of the Analysis Module Interface > Functionality Navigation > Toolbar
Menu

Toolbar Menu
All of the Toolbar icons below have their own Tool Tip that is displayed
when you hold your mouse over:
Add
Delete
Properties
Refresh
Copy
Paste
Move to
Check /
Test
Run
Create
PR0 file
History
Help
Export
Cube
Definition
Generate
Scheduler
Command

Enables the user to add a Data Connection, Data
Container or a Data Expression
Enables the user to delete their selection
Displays context specific field properties
Refreshes on screen properties of the selected object
Copies the selected object to the clipboard
Paste an object from the clipboard into the selected object
Moves a connection or a container
Checks that the object will function correctly
This is the play or generate button, it generates the .cub
file as well as runs the reports into Excel
Creates a report viewer instance go be run off the
computer desktop
This keeps track of the run instance history
Launches the Sage Accpac Intelligence Help file
This allows you to generate cube definition file
This allows the generation of the cube file to be linked to
a scheduler command

Home > Analysis Module > The Standard Report Creation Process

Sage Accpac Intelligence Standard Report
Creation Structure
The following diagram provides a step-by-step explanation of the
standard report creation process i.e. creating a report that extracts
directly from the source database and renders directly to a pre-configured
Excel Template. The component steps include:
Database Connection
Creation of a Container based on database Tables and Fields
Creation of BI reports
Saving the report output into Excel Templates

Home > Analysis Module > Standard Reports available

Standard Reports available
The following standard analysis reports are available when purchasing
the Sage Accpac Intelligence Analysis Module:
Financial Analysis Cube
This report allows you to analyze G/L accounts by Account Group and
segment over multiple fiscal years.

Financial Analysis Cube Trend

Inventory Analysis Cube
This report allows you to analyze year-to-date stock-on-hand quantities,
purchase and sales order quantities, and actual stock values by inventory
group.

Inventory Analysis Cube Trend

Sales Analysis Cube
This report allows you to analyze sales quantities, gross profits, and
amounts by customer, product, and salesperson over multiple
fiscal/calendar years.

Sales Analysis Cube Trend

Home > Analysis Module > The Analysis Module Report Creation Structure

Analysis Module Report Creation Structure
The following diagram provides a step-by-step explanation of the
Analysis Module report creation i.e. creating a report that extracts from a
local cube (.cub file) as opposed to directly from the source database and
renders directly to a pre-configured Excel Template. The component
steps include:
Database Connection
Creation of a Container based on database Tables and Fields
Create a Date Dimension table
Creation of Dimensions and Measures
Creation of the .cub file
Creation of BI reports
Saving the report output into Excel Templates

Home > Analysis Module > Using a PivotTable in Excel to browse an OLAP cube

Using a PivotTable in Excel to browse an
Analysis Module cube
Use Microsoft Excel to create a link to your Analysis Module cube report,
by using an Excel Pivot Table to browse the cube and define the layout
as you would like to see it in an Excel pivot table.
The dimensions and measures that you used to create your .cub file are
available on the Pivot table field list when you have run your report into
Excel.
Using Excel as your cube browser allows you to drag and drop the fields
defined in your cube to view the same data in various ways. If you get to
a point where a specific layout that you have created serves a specific
need in your business and you want to keep this layout, you can do this
by creating and linking your Excel layout with the cube report you created
in the Sage Accpac Intelligence Report Manager. Consequently, each
subsequent time you run your cube report after doing a create and link
process, your most recent Excel layout will automatically be displayed.

You are now able to perform data analysis on the data in the .cub file.

Home > Analysis Module > How does the Analysis Module fit in > How does Sage Accpac Intelligence
Analysis Module fit in ?

How does Sage Accpac Intelligence Analysis
Module fit in with other OLAP solutions?
Microsoft Analysis Services cubes may have already been created. Sage
Accpac Intelligence allows you to connect to these cubes so you can use
the rest of the Sage Accpac Intelligence interface to create a report off
this cube, and browse it using Excel. The advantage of this is that you
now have one common interface for all your organizations reporting,
whether it is fixed format reporting or analysis.

The Advantages of Sage Accpac Intelligence
Analysis Module over other OLAP solutions?
Business Intelligence tools like Sage Accpac Intelligence transform data
into knowledge. It is worth considering what local cube technology offers
an organization as an extension to Microsoft Analysis Services as an
OLAP tool. Sage Accpac Intelligence Analysis Module offers functionality
to build and maintain Local cubes.
So why would an organization want to do this?
A local cube file can be loaded on a laptop, so that a user can browse
multidimensional data while disconnected from the network
A local cube can be e-mailed to a remote user who does not have access
to the Analysis Server
Local cubes can be downloaded from web sites, so that remote users
can be given access to multidimensional data
Different local cubes can be created and distributed to different users,
with each cube containing only the information the person is authorized
to see
Local cubes can be created that have a subset of the Analysis Server
cube's data. This can greatly increase convenience and browsing speed
for the user
When a cube only contains the subset of information that the user wants
to use, they can browse more quickly and more efficiently

Home > Analysis Module > How does the Analysis Module fit in > OLAP Browser Options

OLAP Browser Options
Microsoft Excel is one of the many cube browsers that exist. Sage
Accpac Intelligence supports this strategy because most data users in
the world use Excel every day to present and share information, so it
makes sense to use this as not only a browsing platform for cubes, but
also for delivery of fixed format reporting.
Pivot table and chart functionality is the basis for cube browsing using
Excel. It is a very powerful facility, and many users don’t get the
opportunity to really understand it. Sage Accpac Intelligence supports
better and smarter use of Excel to create operational efficiencies within
organizations.

Home > Analysis Module > Terms and Definitions

Terms and Definitions

OLAP

DSN

Connector

Report
Manager

Analysis
Module

Data

OLAP stands for On Line Analytical Processing, and
supports multi-dimensional analysis of information. It is
the process of extracting information from a data source
(this could be a transactional system, or a data
warehouse), and compressing it into a format that is
optimized for multi-dimensional analysis
File used by various database client programs to
connect to a database; describes properties, such as the
data source name and directory, the connection driver,
the server address, user ID, and a password; used by
ODBC drivers to connect to a specified database, such
as a SQL Server or Microsoft Access database.
The Connector provides the facility to connect to all
ODBC compliant data sources e.g., SQL Server, Oracle,
Access, and Pervasive using a windows explorer look
and feel for simple administration of all data connections.
All data containers are created in the Sage Accpac
Intelligence Connector.
The Report Manager provides access to the data as
defined in the Sage Accpac Intelligence Connector, and
empowers the user to customize their reports for
Microsoft Excel. Filters, Parameters and Aggregates
can be added to your report, new reports can be created
and reports can be organised in folders.
The Analysis Module allows the user to define
dimensions and measures required and then create the
.cub files, which will then become a data source within
the Report Manager. As the data remains static, the
.cub file should be rebuilt daily to ensure that the data
remains relevant.
A Data Connection holds the relevant connection
information to connect to a supported ODBC or OLEDB
compliant Data Source. This Data Connection object is

Connection then used for all connections to this Data Source. By
Adding a Data Connection the Administrator can make
data available from this Data Source.
A Data Container is a set of data which is made available
(published) by the Connector and allows users access to
the data using the Report Manager. The source of this
Data
data can be a Database Table, View or Stored
Container
Procedure, or a custom Join based on two or more
Tables/Views. Once you have configured data
connections you will need to select your data containers
which contain your source data.
A Data Expression the administrator to choose the data
Data
fields (publish) from the Data Container(s) which are
Expression
available through the Report Manager.
An OLAP cube is a data structure that allows fast
OLAP Cube analysis of data providing the capability of manipulating
and analyzing data from multiple perspectives.
The organized hierarchy of categories, known as levels,
Cube
that is used to define the structure of a cube or data
Dimensions
warehouse.
The raw data summarized and totaled. For example: On
Cube
our Sales cube we would like to show the total sales
Measures
value for our chosen dimension Sales.
Local Cubes (.cub file) A local cube is stored in a single,
portable file that can be stored on both server and nonserver computers. End users can browse local cubes
.cub File
without a connection to an Analysis server. Local cubes
are the only variety of cube that provides this
functionality
A Cube Browser is any application that allows users to
Cube
query an OLAP cube. Sage Accpac Intelligence uses
Browser
Microsoft Excel as its cube browser.

Home > Analysis Module > Tutorials > Creating a New Cube Definition > Creating a New Cube Definition

Creating a New Cube Definition
Method :
1. Open the Analysis Module .
2. Right Click on Home and select Add Folder
3. Create a Demonstration Folder
4. Right Click on the Demonstration Folder and select Add Cube
Definition
5. Name this Cube Sales Demo Cube

6. Select the Sales Details 2.0 Container on the RKL Parent Connection

7. Enter a name for your new Cube Dimension and click OK. eg, customer
8. You will be prompted to Drag and Drop your chosen Source
expressions (highlighted below on the left) to your Dimension

Levels (highlighted below on the right).
What is a Cube Dimension?
A cube dimension is a set of one or more organized hierarchies of levels
in a cube that a user understands and uses as the base for data analysis.
By using this drag and drop option to create your source expressions as
dimension levels you are building a logical drill down data set.
A dimension can also be understood as the columns and rows of a Pivot
Table.
Examples:
A Geography dimension might include hierarchical levels for:
Country/Region, State/Province and City.
A Time dimension might include hierarchical levels for:
Year, Quarter, Month and Day.
1. On this Customer Dimension, you wish to aggregate sales up to
Customer Category Level but still are able to drill down to individual
customer's accounts.
Drag the following Source Expressions to the Dimension Levels in
the following hierarchical order:
CustomerCategory
CustomerName

2. Click Apply.
3. You will be prompted to select your Cube Measures (or measure fields)
What is a Cube Measure?
A Measure is a set of values in a cube based on a column in
the Cube’s Dimensions.
A Measure allows you to select the data you would like to be
available for analysis.
A Measure can also be understood as the data area of a
pivot table

4. On this Customer Dimension, you wish to use Total Sales as your
measure.

5. Select the field TotalSale and click on OK.
6. You will be prompted to select a Function to perform on your Measure.
This allows you to select which aggregate function you would like
applied to your data. On this Customer Dimension, you wish to Sum
the Total Sales measure. Select the Sum option.
7.

Click on OK

.

Proceed to Adding a Dimension.

Home > Analysis Module > Tutorials > Creating a New Cube Definition > Adding a Dimension

Adding a Dimension
1. Add a dimension called Date (not to be confused with the Date
Dimension Tool)
It will add value to a cube report on customer sales to be able to
show on which days sales were made. To provide the relevant date
information we need to add another dimension to the cube. By
creating a date dimension we will be able to summarise YTD
figures while still retaining drill down functionality to the lowest
level, daily sales.

2. On the Sales Demo Cube in your Demonstration Folder, select the
Dimensions Tab
3. Click on the Add Button

4. Enter a name for the Cube Definition and click on OK

5. Add the Date Source Expression to create a Date Dimension Level
Note: Once you have selected the Date field, the Analysis Module will
automatically recognizes it as a date field and displays various
predefined date levels. Select the date levels you will wish to display in
your report.
6. Select date levels as Year, Quarter, Month, Week and Day and then
click on Apply.

Proceed to Generate the New Cube

Home > Analysis Module > Tutorials > Generate the New Cube

Generate the New Cube
You have now created the new Cube Definition including Cube
Dimensions and Cube Measures that will populate the Cube (.cub file).
1. In your Analysis Module, Select the OLAP Sales Cube in the
Demonstration folder
2. Right click and select Generate Cube
A connection to your cube will automatically be created in the Sage
Accpac Intelligence Connector module once you have loaded your
data into a cube (.cub file).
Note 1: If a cube already exists you will be prompted with a message
to overwrite the old cube.
Note 2: If you have used scheduling to refresh your cube, the cube
will be generated and will automatically override this message and
refresh the cube.
Note 3: If you are using a scheduling routine for a Cube Report in the
Sage Accpac Intelligence Report Manager Module in conjunction
with a separate scheduling routine for the underlying Cube in the
Analysis Module , you must ensure there is sufficient time lag in the
scheduling of the Report Manager to allow for the Cube to be
refreshed in the Analysis Module.
Proceed to Create a New Cube Report

Home > Analysis Module > Tutorials > Create a New Cube Report

Create a New Cube Report
Using the Sage Accpac Intelligence Report Manager module, create a
new Cube Report by linking it to your own .cub file which you have just
created.
1. Within the Sage Accpac Intelligence Report Manager right click on the
folder chosen to hold your cube reports, select Add Report.

2. You will be prompted to select a type of report, select Cube Report.

3. Click on OK.
4. Enter a name of the report and then click OK

5. You will be prompted to select a data Container (Cube) for your report,
select the container named Sales Demo Cube which you created earlier
and click on OK
6. You will notice the Customer Report is now created in your OLAP
Cube Reports folder and you will also see new tabs in the Report
Manager referring to the properties of your Cube Reports.

The tabs on properties window in the Sage Accpac Intelligence Report
Manager are different for Cube Reports as opposed to Standard Reports
or Union reports. You will notice that Page, Row, Column and
Measure tabs replace the original columns, filters and parameter tabs.
7. Select the Cube Page tab. Click Add on the right hand side of the
screen.

8. The Customer dimension defined within the Analysis Module will now
be available for selection.
9. Click on OK
10. Select the Cube Row tab.
11. Click Add on the right hand side of the screen. This will define the
information shown horizontally.
12. The Date Dimension defined within the Analysis Module will now be
available for selection
13. Click on OK.
14. Select the Cube Column tab. Click Add on the right hand side of the
screen. This will define what information will be shown vertically. For
this example we have no data as we are totalling the sales values within
the report. Click OK
15. Select the Cube Measure tab. Click Add on the right hand side of the
screen. This will define which measures to report on based on the
measures set up within the Analysis Module.

16. The TotalSale measure defined within the Analysis Module will now be
available for selection.
17. Click on OK..
18. Right click on the report name click on the Run button , or right click
and select Run.

19. The user is able to drill down to interrogate the data by double clicking
the year fields. A specific customer can also be selected by using the
drop down menu at the top of the report.

Home > Troubleshooting

Troubleshooting
Data Connection Troubleshooting
The following are common reasons that a Data Connection is not
functioning.
The server storing the data is down - check connectivity can be
established to the server.
Network problems are occurring - check that the network is
functioning normally.
Network security is preventing the data from being accessed check with your System Administrator that you have the
necessary privileges on the network.
Connection Timeouts are occurring - click here for more details
on dealing with connection Timeouts.

Data Container Troubleshooting
The following are common reasons that a Data Container is not
functioning.
The Data Containers parent Data Connection is not functioning.
See Data Connection Troubleshooting.
The Data Container is based on a SQL Join and the syntax for the join is
incorrect. Valid join syntax is usually of the form : [TABLE_A],
[TABLE_B] WHERE [TABLE_A].[KEYFIELD_1] = [TABLE_B].
[KEYFIELD_1] AND [TABLE_A].[KEYFIELD_2] = [TABLE_B].
[KEYFIELD_2]
Note: this may vary depending on the SQL standards of the underlying
data System). For more information on using joins see Joining Tables.
The Data Container is based on a SQL Join but the Container
Type property is set to TABLE or VIEW. You will need to set the
Data Container Type to JOIN.

Report Troubleshooting
The following are common reasons that a Report is not functioning.
The underlying Data Source is unavailable or inaccessible.
Check with your System Administrator.
The Report is using a Template which is conflicting with the way
in which Sage Accpac Intelligence works. Sage Accpac
Intelligence always expects the first sheet in a workbook to be the
sheet that is available for the report data to be placed in. If the
Report has the option "Parameters on Second Sheet" set, then
Sage Accpac Intelligence expects that the second sheet of the
workbook is available for these too.
Report returns no data. This may not be a problem but may just
reflect that the combination of filters and parameters that are
being used result in no data being returned.

Home > Glossary of Terms

Glossary of Terms
Term
Aggregate
Function

Description

Functions (often mathematical) that can be
used across sets of data
The Expressions selected to be displayed
Columns
in a report
The operator used by a Filter or Parameter
Comparison
for comparison e.g. Equal To, Greater
Method
Than, Like
A value that is used by a Filter or
Comparison
Parameter to refine the rows of data
Value
returned to a report
A set of information sufficient for
Data
establishing database connectivity to a
Connection
chosen data source
A published Table, View, Stored Procedure
Data
or Dataset (based on a join) that can be
Container
used to source data for a report
Data
A Field or Expression (derived from one or
Expressions more fields) in a Data container
End User Query and Reporting, a niche
EUQR
category of the Business Intelligence
market
Static criteria used to limit the data that is
Filters
returned by a report
The Expression on which a Filter is
Filter Field
defined
A way of relating the data in one or more
Join
tables so that the data can be viewed as a
single set
A set of data that describes another
Metadata
underlying set of data for the purpose of
Set
simplifying access to the underlying data

Object
Window
ODBC
Optional
Defaults
Parameter
Data
Screen
Process
Monitor
Progress
Status
Source
Container
Type
Table
View
Stored
Procedure

The explorer style interface used to access
Sage Accpac Intelligence Objects
Open Database Connectivity. A universal
standard for database access
Used as default parameter values at actual
report runtime
User specified (at runtime) criteria used to
limit the data that is returned by a report
A screen that provides a read only view on
sample data
Tool that displays all running reports and
that allows reports to be cancelled
Window that shows the running state of a
report
The source of the data needed to generate
reports
A structure for storing data
A view is a virtual table whose contents
are defined by a query
A pre-compiled selection of SQL
statements and optional control-of-flow
statements stored under a name and
processed as a unit

Home > Getting Support

Getting Support
The Sage Accpac Intelligence Help Files have been written to provide
maximum information and assistance to all Sage Accpac Intelligence
users. Every effort has been made to make Sage Accpac Intelligence
easy to understand and use. The comprehensive help files can be
accessed by pressing the F1 button in your Sage Accpac Intelligence
software. For further assistance, please contact:

General
Information
Phone

604-207-9480

Address

13888 Wireless Way, Suite 120,
Richmond, BC V6V 0A3

Sales
Phone
Sales e-mail
General
Information
form
Product
Information
form
Technical
Support
Phone
International
Technical
Support
Phone

800 945 8007
sales.accpac@sage.com
http://www.sageaccpac.com/generalinfo

http://www.sageaccpac.com/productinfo

800 253 1372

+1 604 207 3601

Home > TbSync2 Add In

TbSync Add In
The TbSync2 function was specifically written for the Financial Pack
design but can be used in other scenarios.
It Synchronizes a column (Source Column Range Name) of values in one
sheet (Source sheet) with a column (Target Column Name Range) in
another sheet (Target Sheet) and will bring formulas down with the
synchronised column based on a range that is specified to be copied
down (Formula Range to Extend). The target sheet synchronisation
needs to be told what row to start synchronizing from (Target Sheet Start
Row).
Optional Parameters:
Run interactive: Set to 1 for the TBSync box showing new accounts to
show. Set to 0 for synchronisation to happen without prompts.
Only Handle Numerics: Set to 1 to ignore non numeric values.
Support for Stored Procedures - The Sage Accpac Intelligence
Application has been extended to allow developers to use Sage Accpac
Intelligence to access data returned by database Stored Procedures.
System Variables - System Variables have been introduced for use with
filtering and Parameterization.
Pass Through Variables - Pass Through Variables increase the options
available for and power of report Parameterization.

Home > Distinct Sort Conflict

Distinct Sort Conflict
Cause: You are using the Show Distinct Rows option on the Report and
you have chosen a Sort Field which is not selected as a display Column.
It is possible to have Sort Fields which are not also Display columns but
most Data Access Drivers will not support this if the Show Distinct
Rows option is being used.
Resolution: There are three options here to resolve the problem:
Do not use the Show Distinct Rows option
Remove the offending Sort Fields (i.e. Sort fields which are not
also selected as Display Columns)
Add Display Columns to correspond with all selected Sort Fields.

Home > Distinct Sort Conflict

Distinct Sort Conflict
Cause: You are using an Aggregate Function on one or more display
Columns and there is a Sort Field which is not selected as a display
Column. It is possible to have Sort Fields which are not also Display
columns but some Data Access Drivers will not support this if the an
Aggregate Function is being used.
Resolution: Remove the offending Sort Fields (i.e. Sort fields which are
not also selected as Display Columns).

Home > Average or Sum on Invalid Data Type

Average or Sum on Invalid Data Type
Cause: You are using a Sum or Average Aggregate Function on a
Display Column which is of a data type that cannot be Averaged or
Summed. Usually this will be when attempting to use the aggregate
against a Character or Date data type.
Resolution: Do not use the Aggregate function against the data type in
your chosen Display Column.

Home > Aggregate Asynchronous Conflict

Aggregate Asynchronous Conflict
Cause: You are using an Aggregate Function in a report and the
underlying Connection Type for the report has been configured in the
Connector to perform queries asynchronously (property Supports
Asynchronous Execution has been checked).
Resolution: Either do not use the Aggregate Function or configure the
Connection Type in the Connector to not perform queries asynchronously
(uncheck the property Supports Asynchronous Execution).

Home > Comparator and Aggregate Function Compatability Matrix

Comparator and Aggregate Function
Compatibility Matrix
Matrix Legend
Supported

Not
Supported
Pervasive

Problematic

DBase

Not
Relevant
SQL Server

Access

Char Num Date Char Num Date Char Num Date Char Num
Equal To
Greater
Than
Greater
Than or
Equal To
Less
Than
Less
Than or
Equal To
Is Like
Not
Equal To
Begins
With
Ends
With
Contains
Does Not
Begin
With
Does Not
End With

Does Not
Contain
Is Null
Is Not
Null
Is Not
Like
Like [AB]%
Like A%
Like
%Z%
Like _a%
Like
[SZ]%
LIKE [^AW]%
Minimum
Maximum
Average
Count
Sum

